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Kata 

PENGANTAR 
 

 

Di tengah perkembangan kemajuan di bidang 

teknologi, terdapat banyak alat yang dapat digunakan untuk 

membantu dalam melakukan pengolahan data. Salah satu 

alat yang sangat populer digunakan adalah Microsoft Excel 

dan SPSS. SPSS merupakan salah perangkat lunak yang 

ditujukan khusus untuk membantu berbagai kalangan dalam 

melakukan pengolahan data secara statistika 

Buku ini diharapkan berguna bagi siapa saja yang 

tertarik dengan pengolahan data kuantitatif, terutama 

mahasiswa yang sedang belajar atau melakukan penelitian 

metode kuantitatif. Semoga buku ini dapat menjawab 

kebutuhan Anda. 

Serang, November 2023 
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PENGANTAR PEMBACA 

 

 

1.1. Peran Statistika dalam Penelitian 

Meneliti merupakan salah satu aktivitas yang harus 

dilakukan oleh mahasiswa dan menjadi bagian dari salah 

satu tugas akhir mahasiswa secara akademik. Dalam 

meneliti, mahasiswa memilih metode yang sesuai dengan 

kebutuhan dan tujuan penelitian. Salah satu metode 

penelitian yang biasa digunakan oleh mahasiswa adalah 

kuantitatif. Metode penelitian kuantitatif menuntut 

keterampilan mahasiswa dalam melakukan perhitungan 

dalam pengolahan data guna menarik simpulan berdasarkan 

rumusan masalah yang diajukan. 

Namun, melakukan penelitian dengan menggunakan 

metodologi kuantitatif menurut sebagian besar mahasiswa 

memiliki tahapan yang agak membingungkan dan panjang. 

Salah satu tahapan yang mengambil perhatian yang cukup 

besar dan memiliki peran yang sangat besar dalam 
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penyelesaian penelitian adalah proses pengolahan dan 

penarikan simpulan berdasarkan hasil analisis data 

penelitian. 

Pada saat ini, pelaksanaan tahap pengolahan dan 

penarikan simpulan dapat dilakukan dengan berbagai cara, 

khususnya secara manual dan otomatis. Pengolahan data 

manual membutuhkan waktu, tenaga, dan pikiran secara 

maksimal. Setelah mendapatkan data (dengan 

menggunakan instrumen yang tepat), peneliti kemudian 

menuangkan angka-angka yang diperoleh ke dalam bentuk 

tabel-tabel atau ditampilkan dalam bentuk data mentah. Data 

ini lalu dimasukkan ke dalam rumus-rumus statistik sesuai 

dengan alat analisis yang dipilih. Semakin banyak data yang 

diperoleh, semakin banyak pula angka yang dimasukkan dan 

tentunya membutuhkan waktu dan tenaga yang juga akan 

semakin banyak. 

Prosedur pengolahan data statistik terkadang juga 

membutuhkan beberapa tahap pengerjaan sebelum pada 

tahap penggunaan alat analisis. Ada tahap yang dikenal 

dengan nama uji prasyarat yang harus dilakukan terhadap 

semua data yang digunakan. Sebagai contoh, apabila 

mahasiswa melibatkan 4 (empat) buah variabel, maka 

mahasiswa perlu melakukan uji prasyarat terhadap keempat 

variabel ini satu per satu. Karena proses pengerjaannya 
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bertahap, hasil analisis satu tahap akan bergantung pada 

hasil analisis tahap sebelumnya. Sehingga, jika terjadi 

kesalahan pada hasil analisis satu tahap mengakibatkan 

kesalahan lain pada tahap-tahap selanjutnya. Oleh karena 

itu, pengolahan data secara manual membutuhkan tingkat 

ketelitian yang tinggi. 

Sebagai mahasiswa pendidikan, sedianya tidak perlu 

menghabiskan waktu terlalu lama untuk melakukan 

penghitungan secara manual (Panjaitan & Firmansyah, 

2018). Di tengah perkembangan kemajuan di bidang 

teknologi, terdapat banyak alat yang dapat digunakan untuk 

membantu mahasiswa dalam melakukan pengolahan data. 

Salah satu alat yang sangat populer digunakan untuk 

mengolah data adalah Microsoft Excel dan SPSS. 

SPSS atau Statistical Product for Service Solutions 

merupakan salah satu alat berupa software (perangkat lunak) 

yang ditujukan khusus untuk membantu berbagai kalangan 

dalam melakukan pengolahan data secara statistika. Secara 

spesifik, SPSS memiliki kemampuan membantu kita dalam 

hal: 1) memasukkan data penelitian mengikuti struktur 

kuesioner penelitian; 2) mengharmonisasi data penelitian 

sesuai kaidah statistika; dan 3) menganalisis data penelitian 

sesuai kebutuhan penelitian. Sejalan dengan ketiga inti pokok 

dari program SPSS tadi, maka diperlukan pedoman berupa 
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buku yang fokus kepada tiga inti pokok dari program SPSS 

dimaksud. Buku ini diharapkan dapat berguna bagi siapa 

saja yang tertarik dengan pengolahan data kuantitatif, 

terutama bagi para mahasiswa yang sedang belajar atau 

melakukan penelitian metode kuantitatif. 

 

11.2. Aplikasi SPSS 

SPSS (sebelumnya Statistical Package for Social 

Sciences) merupakan salah satu aplikasi komputer yang 

mampu mengolah data dengan cepat dan tepat. SPSS 

merupakan perangkat lunak yang diharapkan dapat 

melakukan pemeriksaan informasi dan estimasi terukur, baik 

parametrik maupun non parametrik. Selain memberikan 

kenyamanan, SPSS juga mempunyai kapasitas pemeriksaan 

terukur yang sangat tinggi karena mampu membedah 

informasi mencakup banyak faktor dengan berbagai jenis 

data. 

SPSS menjadi sangat terkenal karena mempunyai 

bentuk representasi yang baik (seperti diagram dan tabel), 

bersifat dinamis (mudah mengubah informasi dan 

memperbarui pemeriksaan) dan memiliki kompatibilitas 

dengan aplikasi lain seperti mengambil atau mengirim 

informasi dari dan ke Microsoft Excel (Fauziah & Karhab, 

2019). 



Praktik Statistika Pendidikan menggunakan Microsoft Excel dan SPSS

5 

11.3. Statistika 

Kata ‘statistik’ berasal dari kata latin ‘status’ yang 

berarti negara atau hal-hal yang berhubungan dengan 

organisasi negara. Sejalan dengan itu, Havis Aima (2006) 

mengungkapkan bahwa pada mulanya kata statistik diartikan 

sebagai kebutuhan yang mungkin timbul dari negara dan 

berharga bagi negara. Perlahan-lahan kata ini mulai 

diartikan sebagai data kuantitatif dan subjektif, baik yang 

tidak teratur maupun yang disusun dalam tabel. Sering kali 

tabel tersebut disertai dengan gambar-gambar yang biasa 

disebut bagan atau diagram agar lebih mudah memahami 

permasalahan yang sedang diteliti. 

Statistika adalah studi tentang bagaimana 

mengumpulkan, mengorganisasikan, mengarakterisasi, 

memecah dan melacak data penting dari informasi sebagai 

angka. Dalam statistika, data kuantitatif sering digunakan, 

khususnya data berupa angka yang diperoleh dari 

penghitungan. Penelitian kuantitatif menghasilkan hasil 

berupa angka-angka terukur baik dalam penjelasan maupun 

inferensi informasi. Teknik analisis kuantitatif digunakan oleh 

para ahli untuk menganalisis suatu tema dengan mengambil 

estimasi. 

Pemanfaatan statistika saat ini dapat dikatakan telah 

menjangkau seluruh bidang ilmu pengetahuan, mulai dari 
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ilmu perbintangan hingga fonetik. Bidang keuangan, sains 

dan cabang terapannya, serta penelitian otak sangat 

dipengaruhi oleh statistika dalam pengolahannya. Oleh 

karena itu, disusunlah ilmu-ilmu gabungan, seperti 

ekonometrik, biometrik atau biostatistik dan psikometri. Dari 

konsekuensi persepsi atau seringnya disebutkan atau 

diinginkannya klarifikasi atau keputusan tentang masalah 

yang sedang dipertimbangkan. 

  

1.4. Analisis Data 

Analisis data merupakan siklus paling krusial dalam 

penelitian (Hasyim & Listiawan, 2014). Kemampuan analisis 

data dimaksudkan agar memberikan arti, makna penting dan 

nilai yang terkandung dalam informasi tersebut (Kasiram, 

2006, p. 274). Analisis statistik dapat diselesaikan dengan 

menggunakan proses perhitungan manual atau dapat pula 

menggunakan aplikasi atau software. Saat ini, pengolahan 

data menjadi lebih sederhana dengan hadirnya 

pemrograman (Zein et al., 2019). 

Salah satu aplikasi yang dapat dimanfaatkan untuk 

menganalisis data dan mengambil informasi adalah SPSS. 

SPSS adalah program luar biasa yang paling terkenal dan 

paling umum digunakan untuk penanganan informasi faktual 

di seluruh dunia. Hasil penelitian Nurhayati dan Novianti 
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menyebutkan hasil belajar siswa yang menunjukkan 

penggunaan SPSS lebih baik dibandingkan hasil belajar yang 

ditunjukkan dengan pembelajaran reguler (Nurhayati & 

Novianti, 2020). Oleh karena itu, dapat dikatakan bahwa 

pemanfaatan pembelajaran SPSS sangat mempengaruhi 

kemampuan mahasiswa dalam mengolah data. 

SPSS adalah aplikasi yang digunakan untuk melakukan 

analisis statistika tingkat lanjut, analisis data dengan 

perhitungan AI, pemeriksaan untaian, dan penyelidikan 

informasi besar-besaran yang dapat digabungkan untuk 

membuat tahap penyelidikan informasi. Mengingat 

kemampuannya, SPSS digunakan dalam menangani dan 

mengkaji informasi kuantitatif, karena saling berhubungan 

dan termasuk dalam lingkup statistika. 

 

11.5. Bagaimana Buku ini Digunakan? 

Jenis perkuliahan ini berbentuk praktikum di 

laboratorium komputer sehingga metodologi pembelajaran 

di dalam buku ini menggunakan pendekatan tutorial berupa 

panduan analisis data dengan SPSS langkah demi langkah 

yang dimulai dari perumusan hipotesis, pengujian, dan 

penarikan simpulan yang dilengkapi dengan latihan studi 

kasus dan penugasan pada setiap praktikumnya. 
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Sumber data yang digunakan berupa data simulasi, 

contoh data hasil penelitian yang dipublikasikan (dapat 

diunduh), atau data lain yang relevan. Data tersebut 

digunakan sebagai bahan untuk latihan/tutorial dan 

penugasan. 

Perspektif yang digunakan adalah praktikum dengan 

pembelajaran jarak jauh atau pembelajaran mandiri 

sehingga mahasiswa dapat menggunakan buku secara 

mandiri atau bersama-sama dengan dosen mengikuti 

kegiatan praktikum di laboratorium komputer. 

Selain itu, buku ini juga dilengkapi dengan pemaparan 

konsep dasar secara singkat yang digunakan sehingga 

mahasiswa memiliki pemahaman yang utuh mengenai 

langkah-langkah analisis data yang dilakukan dan dapat 

melakukan replikasi/pengulangan prosedur dengan 

mengikuti langkah-langkah yang telah dipelajari saat 

praktikum di laboratorium komputer. 

Setiap teks menu atau perintah yang tertulis atau 

dituliskan di atau ke dalam perangkat lunak ditulis dengan 

jenis huruf Consolas dan ukuran 10 point. Contoh 

 

Buat data baru dengan cara mengeklik menu File lalu pilih 
New Data. 
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Sementara istilah asing yang berkaitan dengan dunia 

teknologi informasi dituliskan dalam bentuk padanan yang 

ada. Daftar padanan lengkap dapat dilihat pada tautan 

berikut: 

 

https://pasti.kemdikbud.go.id/ranah_list.php?id=28 

 

Perangkat lunak yang digunakan dalam buku ini 

adalah IBM SPSS Statistics versi 20 dan Microsoft Excel bagian 

dari Microsoft Office Home and Student 2019 versi 2310 for 

Windows x64 bit. Sehingga apabila ada perbedaan, pembaca 

dapat menyesuaikan dengan versi SPSS maupun Excel yang 

Anda gunakan. Kedua perangkat lunak tersebut berjalan 

pada perangkat keras berupa laptop dengan spesifikasi: 

 

Bentuk  : Laptop 
Merk  : Lenovo 
Tipe  : Yoga Slim 7i Carbon 
Layar  : 13.3’ 
pemroses : Intel i7-1165G7 
RAM  : 16 GB DDR3 
Penyimpan : SSD Nvme 1 TB 

 

Pada laptop tersebut terpasang Sistem Operasi 

Microsoft Windows 11 Home Single Language x64 bit. 
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Spesifikasi perangkat laptop Anda mungkin jauh lebih tinggi 

sehingga sangat dimungkinkan akan ada perbedaan waktu 

yang dibutuhkan oleh perangkat untuk menyelesaikan satu 

pekerjaan tertentu. 
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STATISTIKA DESKRIPTIF #1 
 

 

Statistik deskriptif adalah statistik yang berfungsi untuk 

mendeskripsikan atau memberikan gambaran terhadap 

objek yang diteliti melalui data atau sampel atau populasi 

sebagaimana adanya, tanpa melakukan analisis dan 

membuat simpulan yang berlaku (Sugiyono, 2017). 

Dengan demikian, pada statistik deskriptif kita 

menggunakan statistik sebagai alat untuk memberikan 

gambaran sebuah data akan tetapi tidak mengambil 

simpulan yang diberlakukan lebih umum (general) 

menggunakan data tersebut. 

Bab ini merupakan bagian pertama statistika deskriptif 

dan berisi penjelasan langkah-langkah untuk menampilkan 

statistika deskriptif dari sebuah data yang diperoleh secara 

acak menggunakan fungsi rand() pada Microsoft Excel. 

Langkah pertama adalah mengubah data tunggal menjadi 

bentuk tabel. Langkah selanjutnya adalah menyajikan grafik 

dan mengubahnya ke dalam distribusi frekuensi kumulatif. 
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22.1 Bilangan Acak untuk Simulasi 

Kita membutuhkan angka-angka untuk melakukan 

simulasi sebuah proses sebagai data. Akan tetapi, terkadang 

kita tidak memiliki data tersebut. Untuk itu kita membutuhkan 

bilangan acak (random numbers). Bilangan acak digunakan 

untuk mendapatkan angka-angka sembarang yang dijadikan 

sebagai data dalam simulasi. Sebagai contoh, untuk 

melakukan simulasi sistem antrean, kita membutuhkan data 

waktu antar-kedatangan pelanggan secara acak. Data waktu 

yang digunakan untuk menyimulasikan suatu sistem antrean 

dan mengukur efektivitas sistem tersebut. Ukuran yang 

digunakan biasanya adalah waktu tunggu dan waktu 

dilayani. Contoh lain adalah simulasi sistem inventory 

penjualan barang di mana kita membutuhkan informasi 

mengenai jumlah barang yang datang, disimpan di gudang, 

dan keluar gudang untuk pengiriman. Kita membutuhkan 

data tersebut secara acak untuk menyimulasikan berapa 

biaya yang dibutuhkan. 

Di dalam Excel, kita bisa menghasilkan bilangan acak 

dengan menggunakan fungsi rand(). Adapun sintak fungsi ini 

sebagai berikut: 

 

=RAND() 
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Fungsi rand() berguna untuk menghasilkan bilangan 

acak antara 0 sampai dengan 1. Sehingga Anda mungkin 

akan mendapatkan bilangan yang beda setiap kali Anda me-

refresh lembar kerja. Untuk menghasilkan bilangan yang 

lebih besar, Anda dapat memodifikasi fungsi di atas. Untuk 

menghasilkan bilangan acak antara a sampai dengan b, 

Anda dapat menggunakan rumus berikut: 

 

=RAND() * (b – a) + a 

 
Untuk menghasilkan bilangan acak, lakukan langkah-

langkah sebagai berikut: 

1. Buka Microsoft Excel lalu pilih New → Blank Workbook. 

2. Pada layar yang ditampilkan, tuliskan pada kolom A1, 

dan B1 dengan informasi: No dan X. 

 

 
Gambar 2.1  Menyiapkan tabel. 
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Sebagai contoh, kita ingin menghasilkan bilangan acak 

antara 70 sampai dengan 90. Tuliskan rumus berikut 

pada sel B2. 

 

 
Gambar 2.2  Fungsi untuk menghasilkan bilangan acak dari

70 sampai 90. 
 

3. Tekan tombol ENTER. Lihat angka yang muncul pada sel 

B2. 

 

 
Gambar 2.3  Fungsi untuk menghasilkan bilangan acak dari

70 sampai 90. 
 

4. Seperti yang Anda lihat, bilangan acak yang dihasilkan 

berupa bilangan nyata. Apabila Anda ingin 
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menghasilkan bilangan acak berupa bilangan bulat, 

gunakan fungsi berikut: 

 

=RANDBETWEEN(70; 90) 

 

Fungsi di atas kita gunakan untuk menghasilkan 

bilangan bulat antara 70 sampai 90. 

5. Selanjutnya, kita akan menggunakan fungsi 

RANDBETWEEN untuk menghasilkan bilangan acak bulat. 

 

 
Gambar 2.4  Fungsi untuk menghasilkan bilangan acak bulat

dari 70 sampai 90. 
 

 

Perhatikan fungsi di atas, pada buku ini digunakan 

pemisah antar-angka (antara bottom dan top) berupa 

semicolon (;), bukan koma (,). Sistem komputer Anda 

mungkin berbeda dengan tampilan di atas. Untuk 

meyakinkan, biasanya Excel akan menampilkan sebuah 

teks yang disebut tool tips. Pada tool tips terlihat tanda 

pemisah yang digunakan (lihat Gambar 2.4). 
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6. Selanjutnya, kita salin angka yang dihasilkan dan 

tempel pada baris di bawahnya sebanyak yang Anda 

inginkan. Sebagai contoh, kita ingin menghasilkan 30 

angka acak. Untuk itu, pada sel B2 tekan tombol 

CTRL+C. Lalu blok sel di bawahnya mulai dari B3 sampai 

dengan B31. Terakhir tekan tombol ENTER atau CTRL+V. 

 

 
Gambar 2.5  Bilangan acak bulat dari 70 sampai 90 sudah

dihasilkan. 
 

7. Seperti yang disebutkan di atas, fungsi rand() atau 

randbetween() akan me-refresh lembar kerja sehingga 

kita akan mendapatkan bilangan baru setiap kali 

berkas ini dibuka kembali atau ketika Anda menekan 

tombol ENTER atau mengetikan teks sembarang di sel 

lain. Untuk menjaga agar bilangan acak yang 

dihasilkan selalu tetap, Anda perlu menyimpan 

bilangan tersebut sebagai value bukan formula. Blok 

semua angka yang dihasilkan, yakni dari sel B2 sampai 
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dengan B31. Tekan tombol CTRL+C untuk menyalin. 

Sebelum di tempel, klik tombol panah di bawah tombol 

Paste. Lalu pilih Paste Values. 

 

 
Gambar 2.6  Pilih Paste Values untuk mempertahankan nilai.
 

Sampai di sini kita sudah punya 30 data acak dengan 

kisaran nilai antara 70 sampai dengan 90. Apabila 

menginginkan kisaran angka yang lain, Anda dapat dengan 

mudah mengganti batas bawah dan batas atasnya. Sebagai 

informasi, Anda juga bisa memberikan pembobotan nilai 

yang berbeda sehingga satu angka punya kemungkinan 

muncul lebih besar dibanding yang lain. Anda bisa 

mengombinasikan fungsi RAND dengan MATCH dan membuat 

distribusi probabilitas yang menentukan probabilitas angka 
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yang muncul. Semakin besar probabilitasnya, semakin besar 

pula peluang untuk muncul. 

 

22.2 Membuat Distribusi Frekuensi Kelompok 

Untuk kebutuhan analisis data, terkadang Anda perlu 

menyajikan data dalam tabel frekuensi tunggal ke dalam 

tabel distribusi frekuensi berkelompok. Misalkan kita 

menggunakan data yang sudah kita per oleh secara acak di 

atas. Pada praktiknya Anda bisa menggunakan data asli. 

Berikut ini langkah-langkahnya. 

1. Tentukan nilai maksimum, minimum, dan 

rentang/jangkauan data. 

- Pada sel D2 tuliskan formula =MAX(B2:B31) 

- Pada sel D3 tuliskan formula =MIN(B2:B31) 

- Pada sel D4 tuliskan formula =D2 – D3 

 

 
Gambar 2.7  Menentukan MAX, MIN, dan

rentang/jangkauan. 
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Angka-angka di atas mungkin berbeda dengan hasil 

Anda peroleh. 

 

2. Gunakan rumus k-Struggles untuk menentukan banyak 

kelas. Pada sel D5 tuliskan =1+3.3*LOG10(30) 

 

 
Gambar 2.7  Menentukan banyak kelas dengan rumus k-

Struggles. 
 

Di Excel kita menggunakan fungsi LOG10 untuk 

menentukan nilai logaritma basis 10 dari sebuah 

bilangan karena fungsi LOG adalah logaritma basis e 

atau logaritma natural. Sebagai contoh, pada sel D5 

diperoleh angka 5.8745.  

3. Selanjutnya adalah menentukan nilai k yang mungkin 

berdasarkan angka ini. Di sini kita tidak menggunakan 

pembulatan karena di sini bukan fungsi floor atau ceil. 

Tetapi kita menggunakan logika sederhana. Angka 

5.8745 menyatakan banyaknya kelas yang harus kita 
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buat. Angka ini mengandung dua pilihan yaitu 5 atau 6 

dan tidak mungkin kurang dari 5 atau lebih dari 6.  

Sebagai contoh kita mengambil nilai k = 5 (perhatikan, 

bukan dibulatkan). Tuliskan angka ini di sel D6. 

Kemudian kita tentukan panjang kelas. Di sel D7, 

tuliskan formula =D4/D6. Diperoleh angka 3.8. Angka 

ini seperti halnya pada langkah ke-3. Sehingga pada 

sel D8 kita isi (misalkan) angka 4 sebagai panjang kelas. 

4. Selanjutnya kita tuliskan judul tiga kolom. Tuliskan 

‘Batas Bawah’ di sel F2, ‘Batas Atas’ di sel G2, dan 

‘Frekuensi’ di sel H2. 

5. Pertama, kita perlu menetapkan batas bawah kelas 

pertama, yaitu di sel F3. Sebagai permulaan, kita 

tuliskan =D3 dengan asumsi batas bawah kelas pertama 

adalah nilai paling kecil (minimum). 

 

 
Gambar 2.8  Menentukan batas bawah kelas pertama. 
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Apakah batas bawah kelas pertama harus selalu nilai 

minimum? Jawabannya tentu saja tidak. Kita bisa 

memulainya dari nilai yang lebih kecil dari nilai 

minimum asalkan selisihnya dengan nilai minimum 

tidak lebih dari p (panjang kelas). Yang tidak boleh 

adalah mengisinya dengan nilai yang lebih dari nilai 

minimum karena berarti nilai minimumnya tidak 

termasuk di dalam tabel, dan ini tidak mungkin. 

6. Tuliskan rumus di batas atas kelas pertama, yaitu di sel 

G3, dengan =F3+$D$8-1. Tanda $ berarti sel tersebut 

adalah sel absolut. 

 

 
Gambar 2.8  Menentukan batas bawah kelas pertama. 
 

7. Selanjutnya kita tentukan kelas kedua. Di kolom Batas 

Bawah, yaitu F4 kita tuliskan formula =F3+$D$8 dan 

untuk formula di G4 kita salin dari G3. 

8. Untuk kelas selanjutnya, kita salin formula di sel F4 dan 

G4 secara langsung lalu tempelkan ke baris di 
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bawahnya sampai dengan baris ke-7 sehingga kita 

mendapatkan 5 (lima) kelas sebagai berikut: 

 

 
Gambar 2.9  Percobaan pertama membuat tabel distribusi

frekuensi. 
 

Perhatikan bahwa dengan mengambil nilai p = 4 dan k 

= 5 kita mendapatkan tabel frekuensi dengan nilai 

minimum 70 dan nilai maksimum 89. Hal ini sudah 

sesuai dengan data yang kita miliki karena nilai 

maksimumnya adalah 89. Ada kalanya kita mendapati 

kondisi tidak demikian, di mana nilai maksimum yang 

termuat di dalam tabel kurang dari nilai maksimum 

pada data. Jika terjadi demikian, maka kita perlu 

mengubah pemilihan nilai p dan nilai k. 

9. Untuk selanjutnya kita akan mengisi kolom frekuensi. 

Pertama, blok terlebih dahulu semua kolom frekuensi di 

setiap kelas, yaitu rentang H3:H7. Dengan kondisi masih 

terblok seperti itu, ketikan formula sebagai berikut: 

=FREQUENCY(B2:B31;G3:G7) 
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Di mana B2:B31 adalah rentang di mana data 

tersimpan dan G3:G7 adalah rentang batas atas pada 

tabel.  

 

 
Gambar 2.10  Menuliskan rumus untuk menghitung frekuensi
 

Setelah menuliskan rumus, tekan tombol 

CTRL+SHIFT+ENTER secara bersamaan sehingga baris 

formula menjadi berada di dalam tanda kurung 

kurawal {}. Di sini Anda tidak bisa memasukkan tanda 

ini secara manual. 

 

 
Gambar 2.11  Rumus frekuensi berubah secara otomatis. 
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Sekarang, pada kolom frekuensi sudah terisi angka-

angka yang menyatakan banyaknya bilangan yang 

termuat di dalam batas-batas yang bersesuaian. 

Sebagai contoh, untuk kelas pertama, batas atas adalah 

70 dan batas bawah adalah 73. Angka 4 pada kolom 

frekuensi berati bahwa pada data terdapat 4 (empat) 

datum yang nilainya berada di antara (inklusi) 70 

sampai dengan 73, yaitu: 73, 71, 70, dan 73. Hasil ini 

mungkin berbeda dengan milik Anda karena kita 

menggunakan data yang berbeda. 

 

22.3 Membuat Grafik dengan Microsoft Excel 

Kita bisa membuat grafik dari data yang kita miliki. 

Untuk tujuan informatif, terlebih dahulu kita sisipkan sebuah 

kolom di sebelah kiri kolom frekuensi dan beri judul kolomnya 

dengan ‘Interval’. 

 

 
Gambar 2.12  Menambahkan kolom baru. 
 

Selanjutnya, ikuti langkah-langkah berikut: 
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1. Pada sel H3 tuliskan formula berikut untuk 

menggabungkan nilai pada kolom F dan G, yaitu =F3&” 

– “&G3. Lalu salin formula tersebut sampai ke sel H7. 

Sehingga kita sekarang memiliki tabel seperti Gambar 

2.13 berikut. 

 

 
Gambar 2.13  Menambahkan keterangan pada kolom

interval. 
 

2. Blok rentang H2:I7. Kemudian klik tab Insert, pilih 

Recommended Charts untuk memilih jenis grafik yang 

kita inginkan. Jenis grafik yang paling umum digunakan 

untuk merepresentasikan tabel distribusi frekuensi 

kumulatif adalah grafik jenis batang. 
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Gambar 2.14  Menambahkan keterangan pada kolom

interval. 
 

3. Pada layar yang ditampilkan, pilih jenis grafik yang 

Anda inginkan. 

 

 
Gambar 2.15  Pemilihan jenis grafik. 
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Setiap kali Anda memilih jenis grafik yang diinginkan, 

Anda dapat melihat pra-tinjau grafik yang akan 

dihasilkan. Apabila sudah sesuai, klik OK. Kemudian 

pada layar sekarang bertambah sebuah gambar grafik. 

Anda bisa mengubah grafik ini termasuk apabila 

perubahannya dilakukan langsung terhadap data, 

maka perubahannya bisa langsung Anda lihat dan 

rasakan. 

 

 
Gambar 2.16  Sebuah gambar grafik berhasil dibuat di

dalam Excel. 
 

 



2 – Statistika Deskriptif #1 

28 

22.4 Menghitung Frekuensi Kumulatif 

Sebelumnya, kita tulis dulu kolom di sebelah kanan 

Frekuensi yaitu pada sel J2 dengan ‘Frekuensi Kumulatif’. 

Kita bisa menggunakan dua cara untuk menghitung frekuensi 

kumulatif. Yang pertama adalah dengan menggunakan 

ekspresi penjumlahan dasar, yaitu: 

1. Pada sel J3 tulis rumus =I3 

2. Pada sel J4 tulis rumus =J3+I4 

3. Salin sel J4 lalu tempel ke bawah sampai J7 

 

Cara kedua adalah dengan menggunakan rumus SUM.  

1. Pada sel J3 tulis rumus =SUM($I$3:I3). Tekan ENTER 

2. Tarik/salin rumus pada sel J3 ke sel di bawahnya 

sampai J7. 

 

 

Gambar 2.17  Membuat kolom frekuensi kumulatif dengan
rumus SUM. 
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Perhatikan bahwa angka pada baris terakhir di kolom 

Frekuensi Kumulatif harus sama dengan jumlah atau 

banyaknya data. Apabila ada perbedaan berarti 

terdapat kesalahan dalam menyusun tabel distribusi 

frekuensi berkelompoknya. Anda perlu mengulangi 

penyusunannya agar sesuai. 

 

LLATIHAN 

Gunakan fungsi RANDBETWEEN untuk menghasilkan data 

nilai antara 50 sampai 100 (inklusif) sebanyak 100 datum. 

Setelah itu: 

1. Ubah ke dalam tabel distribusi frekuensi berkelompok! 

2. Tentukan kelas interval dan frekuensi kumulatifnya. 

3. Buat grafik batang berdasarkan tabel tersebut. 
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 33 

STATISTIKA DESKRIPTIF #2 
 

 

Statistik deskriptif merupakan statistik yang 

berhubungan dengan pengumpulan data, penyajian data 

(pembuatan tabel dan grafik), dan melakukan perhitungan 

statistik untuk mendeskripsikan atau menggambarkan data 

yang telah terkumpul, dan tanpa membuat kesimpulan yang 

berlaku umum (generalisasi). 

Bab ini merupakan bagian kedua statistik deskriptif 

yang membahas cara menghitung ukuran-ukuran pemusatan 

(mean, modus, median, quartile) dan penyebaran (standar 

deviasi, ragam, dan jangkauan/rentang), Skewness, Kurtosis 

dan melakukan analisis kurtosis menggunakan rasio 

Skewness untuk memperkirakan distribusi data (apakah 

normal atau bukan normal) pada SPSS. 

Untuk keperluan praktik, berikut adalah data tinggi 

badan 25 orang mahasiswa (dalam centimeter) yang diambil 

secara acak. 
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NNo.  TTinggi Jenis Kelamin 

1 170.2 Pria 
2 172.5 Pria 
3 180.3 Pria 
4 172.5 Pria 
5 159.6 Wanita 
6 168.5 Wanita 
7 168.5 Pria 
8 172.5 Pria 
9 174.5 Pria 

10 159.6 Wanita 
11 170.4 Wanita 
12 161.3 Wanita 
13 172.5 Pria 
14 170.4 Wanita 
15 168.9 Wanita 
16 168.9 Wanita 
17 177.5 Wanita 
18 174.5 Pria 
19 186.6 Wanita 
20 164.8 Wanita 
21 170.4 Pria 
22 168.9 Pria 
23 164.8 Wanita 
24 167.2 Wanita 
25 167.2 Wanita 

 

Gunakan aplikasi SPSS untuk mengolah data tersebut 

untuk mendapatkan gambaran umum dari data tersebut. 

Langkah-langkahnya adalah sebagai berikut. 
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33.1. Mendefinisikan Variabel 

1. Buka aplikasi SPSS, tunggu sampai ditampilkan layar 

kotak dialog di bawah: 

 

 
Gambar 3.1  Splash screen. 

 

Pada dialog di atas, klik tombol Cancel. 

2. Selanjutnya, akan tampak tampilan berikut: 

 

 
Gambar 3.2  Jendela awal SPSS. 
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Pada jendela tersebut klik tab Variable View yang ada 

di pojok kiri bawah untuk berpindah ke halaman 

pendefinisian variabel. 

Data di atas terdapat dua variabel, yaitu Tinggi Badan 

dan Jenis Kelamin, maka akan definisikan dua variabel. 

Untuk mengisi variabel, perhatikan tata cara pengisian 

berikut. 

 

Nama 
Kolom 

Keterangan 

Name Nama variabel. Tulis tanpa simbol atau 
spasi. 

Type Tipe data yang termuat di dalam 
variabel 

Width Panjang data. Sebagai contoh, apabila 
tipe data adalah Number maka width 
berarti banyaknya angka (digit) dari 
bilangan tersebut, termasuk desimal. 

Decimals Banyaknya angka di belakang koma. 
Label Keterangan dari Name. Di sini kita bisa 

menggunakan spasi dan simbol lain 
Values Batasan nilai. Apabila tidak ada 

batasan, pilih None. 
Missing Batasan pencilan/outlier yaitu datum 

yang tidak diikutkan dalam analisis. 
Jika tidak ada, pilih None. 

Columns Lebar kolom yang ditampilkan. Tidak 
berpengaruh terhadap isi data. 

Align Perataan data yang ditampilkan. Tidak 
berpengaruh terhadap isi data 

Measure Ukuran data, terdapat tiga jenis: 
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Scale: data diperoleh dengan cara 
mengukur menggunakan alat ukur. 
Contoh tinggi badan yang diukur 
menggunakan meteran. 
Nominal: data yang diperoleh dengan 
cara memberi nilai atau kuantifikasi 
atau hanya penanda. Misal pada hasil 
angket. 
Ordinal: data yang berupa urutan atau 
data yang diperoleh sebagai hasil dari 
mengurutkan data yang sudah ada. 
Sebagai contoh data rangking siswa. 

Role Cara mendapatkan data. Biasanya kita 
menggunakan Input. 

 

Berdasarkan uraian di atas, kita definisikan dua 

variabel dengan pengaturan sebagai berikut: 

  

Nama Kolom Tinggi Badan Jenis Kelamin 

Name tinggi_badan Jenis_kelamin 
Type Number Number 
Width 4 1 
Decimals 1 0 
Label Tinggi badan Jenis Kelamin 
Values None {1, Pria}, {2, 

Wanita} 
Missing None None 
Columns 8 8 
Align Right Right 
Measure Scale Nominal 
Role Input Input 
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Untuk kolom Values, klik tombol titik tiga di sebelah 

kanan None. 

 

   
Gambar 3.3  Pengisian kolom value. 

 

Pada gambar di atas, isikan 1 pada kolom Value, dan 

Laki-laki pada kolom Label. Kemudian klik Add. 

Ulangi hal yang sama untuk value kedua. Setelah 

selesai klik OK. Berikut tampilan definisi variabel pada 

SPSS. 

 

 
Gambar 3.4  Pendefinisian variabel. 
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3. Untuk melihat hasilnya, kita kembali ke tampilan data. 

Klik tab Data View di pojok kiri bawah. 

 

 
Gambar 3.4  Pendefinisian variabel. 

 

33.2. Memasukkan Data 

Selanjutnya kita isi data yang kita punya di atas ke 

dalam data view. Tak lupa, pada kolom jenis_kelamin kita 

tidak bisa mengisinya dengan ‘Pria’ atau ‘Wanita’ melainkan 

dengan angka 1 untuk Pria dan 2 untuk Wanita. Cara paling 

mudah adalah dengan melakukan penggantian terlebih 

dahulu atau Anda bisa memasukkannya secara manual. 

Sebagai contoh, salin terlebih dahulu data tersebut ke 

dalam Excel. Lalu tekan tombol CTRL+H pada bagian Find 

what, ketik Pria. Pada bagian Replace with, ketik 1. Lalu klik 

tombol Replace All. Lakukan hal yang sama untuk Wanita. 

Replace with dengan angka 2. Setelah berubah, pilih kolom 
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Tinggi badan dan Jenis kelamin mulai baris kedua (yang 

berisi angka) lalu tekan tombol CTRL+C untuk menyalin. 

Kembali lagi ke SPSS, letakan kursor di pojok kiri atas. Tekan 

tombol CTRL+V untuk tempel. 

 

 
Gambar 3.5  Pengisian data. 

 

33.3. Menganalisis Data 

Langkah-langkah analisis sebagai berikut: 

1. Dari baris menu, pilih menu Analyze, lalu pilih submenu 

Descriptive Statistics, lalu pilih lagi submenu 

Frequencies. Untuk selanjutnya urutan langkah ini 

ditulis secara singkat sebagai: Klik menu Analyze → 

Descriptive Statisitcs → Frequencies. 
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Gambar 3.6  Mengakses menu statistik deskriptif. 
 

Selanjutnya, akan tampil kotak dialog sebagai berikut. 

 

 
Gambar 3.7  Deskriptif statistik. 

 

2. Kolom Variable(s) harus diisi dengan jenis-jenis 

variabel apa yang ingin kita analisis. Karena ingin 

dibuat frekuensi dari variabel Tinggi Badan, maka klik 

variabel Tinggi Badan, kemudian klik tanda panah ke 

kanan. 

3. Klik tombol Statistics, maka akan tampil kotak dialog 

berikut. 
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Gambar 3.8  Opsi Statistics. 

 

4. Pilihan Statistics meliputi berbagai ukuran untuk 

menggambarkan data, antara lain sebagai berikut: 

a. PercentilesValues. Untuk keseragaman klik 

Quartiles dan Percentile(s). Kemudian pada 

kotak di samping kanan Percentiles ketik 10, lalu 

klik tombol Add. Sekali lagi ketik 90 pada kotak 

terdahulu, dan klik lagi tombol Add. Pengerjaan 

ini dimaksudkan untuk membuat nilai persentil 

pada 10 dan 90. 
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b. Dispersion atau ukuran penyebaran. Untuk 

keseragaman, semua atau keenam jenis 

pengukuran Dispersion dipilih semua. 

c. Central Tendency atau ukuran pemusatan, untuk 

keseragaman pilih Mean, Median, dan Mode. 

d. Distribution atau bentuk distribusi data. Untuk 

keseragaman, beri tanda centang pada Skewness 

dan Kurtosis. 

 

 
Gambar 3.9  Pilihan Statistics. 

 

Lalu klik tombol Continue. 
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5. Selanjutnya klik tombol Charts. Akan ditampilkan kotak 

dialog Frequencies: Charts. Charts ini berkenaan 

dengan jenis grafik yang ingin kita pilih. Pada Chart 

Type, untuk keseragaman kita pilih Histogram. Lalu beri 

tanda centang kotak Show normal curve on histogram. 

 

 
Gambar 3.10  Pilihan Charts. 

 

Lalu klik tombol Continue. 

6. Kemudian klik tombol Format. Pada menu ini kita bisa 

menentukan urutan bagaimana data ditampilkan dan 

perlakuan apabila kita memiliki variabel ganda. 
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Gambar 3.11  Pilihan Format. 

 

Pada submenu Order by (data akan ditampilkan dalam 

urutan seperti apa) kita seragamkan saja dengan 

memilih susunan naik (dari data terkecil ke data 

terbesar). Untuk itu pilih Ascending values. 

7. Selanjutnya klik OK. Maka semua proses pengisian dan 

pengolahan data telah selesai, dan kita akan lihat 

hasilnya (outputnya) pada Editor Output. 

 

33.4. Output SPSS dan Analisisnya 

Setiap kali kita selesai melakukan pengaturan analisis, 

kita menekan tombol OK untuk mengonfirmasi bahwa semua 

hasil analisis disesuaikan dengan parameter yang kita 

masukan, maka SPSS akan melakukan proses kalkulasi 

menggunakan pemroses SPSS. Setelah proses selesai, SPSS 

akan menampilkan jendela baru yang kita sebut dengan 

output SPSS. 
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Secara umum, jendela ini terdiri atas tiga bagian. 

Perhatikan gambar berikut. 

 

 
Gambar 3.12  Jendela utama layar output. 

 

Bagian paling atas kita kenal dengan nama menu dan 

toolbar. Bagian menu memuat berbagai macam perintah 

yang sudah dikelompokkan sesuai dengan fungsinya masing-

masing. Bagian sebelah kiri kita kenal dengan nama 

bookmark. Bagian ini berisi pintasan penanda hasil analisis 

pada output sehingga kita tidak perlu menggulung layar 

terlalu jauh. Bagian sebelah kanan kita kenal dengan nama 

Output SPSS. Bagian paling atas dari sebuah output adalah 

script yang dieksekusi oleh pemroses SPSS. 

Bagian kiri dan kanan akan selalu bertambah seiring 

dengan aktivitas analisis yang kita lakukan di halaman 
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utama. Anda dapat menyimpan hasil output secara 

keseluruhan sebagai output SPSS (spo), atau mengekspornya 

ke dalam format lain, atau menyalin sebagian dari output. 

 

33.5. Output Bagian Pertama (Statistics) 

 

 
Gambar 3.13  Output SPSS hasil analisis deskriptif. 
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Berikut adalah penjelasan output di atas. 

a. N atau jumlah data yang valid adalah 25 buah, 

sedangkan data yang hilang (missing) adalah nol. Ini 

artinya semua data bisa diproses 

b. Mean atau rata-rata tinggi badan adalah 170,12 cm 

dengan standar error adalah 1,20655 cm. Penggunaan 

standar error of Mean adalah untuk memeriksa besar 

rata-rata populasi yang diperkirakan dari sampel. 

Untuk itu, dengan standar error of Mean tertentu dan 

pada tingkat kepercayaan 95% (SPSS sebagian besar 

menggunakan angka ini sebagai standar), rata-rata 

populasi tinggi badan menjadi: 

Rata-rata Populasi = 

 

= 

= 

 

= 

Rata-rata ± 2 standar error of 

Mean 

170,12 ± (2 x 1,20655) cm 

(170, 12 – 2.4131) sampai 

(170, 12 + 2.4131) 

167, 7069 cm sampai 

172,5331cm 

(Angka 2 digunakan karena tingkat kepercayaan 95%) 

c. Median atau titik tengah data jika semua data diurutkan 

dan dibagi 2 sama besar. Angka median 170,20 cm 

menunjukkan bahwa 50% tinggi badan adalah 170,20 

cm ke atas, dan 50%-nya 170,20 cm ke bawah. 
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d. Standar Deviasi adalah 6,03276 cm dan variansinya 

adalah 36,394 cm. Penggunaan standar deviasi adalah 

untuk menilai dispersi rata-rata dari sampel. Untuk itu, 

dengan standar deviasi tertentu dan pada tingkat 

kepercayaan 95%, rata-rata tinggi badan menjadi: 

Rata-rata tingi badan =

 

=

=

=

Rata-rata ± 2 x Standar 

Deviasi 

170,12 ± (2 x 6,03276) cm 

170,12 ± 12,06552 

158,05448 – 182,18552 cm 

Perhatikan bahwa kedua batas angka berbeda tipis 

dengan nilai minimum dan maksimum, ini artinya 

sebaran data adalah baik. 

e. Ukuran Skewnes adalah 0,572 cm. Untuk penilaian, 

nilai tersebut diubah ke angka rasio. 

Rasio adalah = nilai kurtosis/standar error kurtosis  

  = 0,572/0,902  

  = 0,63. 

Sebagai pedoman, bila rasio kurtosis berada antara -2 

sampai dengan +2, maka distribusi data adalah 

normal. 

f. Ukuran kurtosis adalah 1,460 cm 

g. Data minimum = 159,60 cm; data maksimum = 

186,60 cm 
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h. Range = Data maksimum – Data minimum = 27,00 cm 

i. Angka Persentil: 

- 10% responden di bawah 160,62 cm 

- 25% responden di bawah 167,20 cm 

- 50% responden di bawah 170,20 cm 

- 75% responden di bawah 172,50 cm 

- 90% responden di bawah 178,62 cm 

 

33.6. Output Bagian Kedua (Tinggi Badan) 

Output ini merupakan gambaran tinggi badan 

responden dalam tabel frekuensi. 

 

 
Gambar 3.14  Output SPSS deskriptif tinggi badan. 
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33.7. Output Bagian Ketiga (Histogram) 

 

 
Gambar 3.15  Grafik histogram. 

 

Terlihat grafik data berbentuk seperti lonceng, ini 

artinya distribusi data adalah normal atau mendekati normal 

(pengujian secara statistik akan dibahas nanti).  
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LLATIHAN 

Berikut ini adalah sampel nilai UTS Statistika I dari 

sekelompok mahasiswa di sebuah universitas: 

30, 35, 42, 50, 58, 66, 74, 82, 90, 98, 55, 53, 68, 71, 56, 

59, 62, 71 

Dengan perhitungan matematis dan aplikasi SPSS 

tentukanlah: rata-rata hitung, median, simpangan baku 

(Std. Deviation), variance, kemiringan, kurtosis, rentang, 

dan percentil, serta gambarkan bagan histogram data 

tersebut. 
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44 

UJI PRASYARAT ANALISIS 
 

 

4.1. Pengantar 

Uji persyaratan analisis diperlukan untuk mengetahui 

apakah analisis data untuk pengujian hipotesis dapat 

dilanjutkan atau tidak. Beberapa teknik analisis data 

menuntut uji persyaratan analisis. Misal, analisis varian 

menyaratkan bahwa data berasal dari populasi yang 

terdistribusi normal dan kelompok-kelompok yang 

dibandingkan homogen. Oleh karena itu analisis varian 

menyaratkan uji normalitas dan homogenitas data. 

Bagian ini akan dibahas secara singkat terkait uji 

normalitas dan uji homogenitas. Uji normalitas data adalah 

bentuk pengujian tentang normalitas distribusi data. Tujuan 

dari uji ini adalah untuk mengetahui apakah data yang 

terambil merupakan data terdistribusi normal atau bukan. 

Maksud dari terdistribusi normal adalah data akan mengikuti 

bentuk distribusi normal di mana data memusat pada nilai 

rata-rata dan median. Uji normalitas adalah uji yang 
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dilakukan untuk mengecek apakah data penelitian kita 

berasal dari populasi yang sebarannya normal. Uji ini perlu 

dilakukan karena semua perhitungan statistik parametrik. 

Pada dasarnya uji homogenitas dimaksudkan untuk 

memperlihatkan bahwa dua atau lebih kelompok data 

sampel berasal dari populasi yang memiliki variansi yang 

sama. Pada perkuliahan ini akan dikenalkan salah satu uji 

homogenitas yang sering digunakan dalam penelitian yaitu 

uji Levene. 

 

44.2. Microsoft Excel untuk Uji Normalitas 

Pada bagian ini kita akan melakukan uji normalitas 

menggunakan Microsoft Excel. Untuk keperluan contoh, kita 

akan menggunakan data hasil pengacakan bilangan pada 

Bab 2, yaitu pada Gambar 2.5. 

 

Contoh 4.1 

Ujilah normalitas data berikut menggunakan metode 

Chi-Square 
 

82 83 81 86 73 81 
78 83 79 72 73 90 
81 83 74 81 84 87 
90 74 80 80 77 90 
87 83 90 86 74 78 

 

Gambar 4.1  Data uji normalitas. 
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Berikut adalah langkah-langkah melakukan uji 

normalitas dengan teknik Chi-Square menggunakan 

Microsoft Excel. 

1. Ubah data ke dalam bentuk tabel distribusi frekuensi 

kelompok. Silakan mengikut langkah-langkah 

sebagaimana yang dituliskan di halaman 18 sampai 

23. Dengan mengikuti langkah-langkah di atas, kita per 

oleh data dalam bentuk tabel distribusi frekuensi 

kelompok. Asumsikan tabel tersebut kita tuliskan ulang 

di sel A1. Sementara baris ke-2 kita kosongkan untuk 

keperluan analisis selanjutnya. Tampilannya sebagai 

berikut. 

 

 
Gambar 4.2  Tabel awal dengan 5 (lima) kelas. 

 

2. Pada kolom C3 sampai C7, kita hitung nilai tengah tiap 

kelas, yaitu jumlahan batas atas dan batas bawah, lalu 

dibagi 2. Misal, pada sel C3 masukan rumus = (72 + 

75)/2. Lakukan hal yang sama sampai sel C7. 
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3. Pada sel D3 masukan rumus =C3^2. Salin sampai sel D7. 

4. Pada sel E3 masukan rumus =B3*C3. Salin sampai sel 

E7. 

5. Pada sel F3 masukan rumus =B3*D3. Salin sampai sel 

F7. 

6. Pada sel B8 masukan rumus =SUM(B3:B7). Salin sampai 

sel F8. 

7. Selanjutnya, kita hitung rata-rata. Misalkan kita simpan 

rata-rata di sel B10, masukan rumus =E8/B8. 

8. Selanjutnya, kita hitung simpangan baku. Misalkan kita 

simpan simpangan baku di sel B11, masukan rumus 

=SQRT((F8-E8^2/B8)/(B8-1)). 

 

 
Gambar 4.3  Penghitungan rata-rata dan simpangan baku. 
 

Sampai sini kita sudah menghitung nilai rata-rata dan 

simpangan baku. 

9. Kita isi sel G2 dengan tepi bawah kelas pertama, yaitu 

72 – 0.5. Jadi, pada sel ini tuliskan rumus =72-0.5. Jika 
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batas bawah berupa desimal, misal 72.1 maka 

pengurangnya adalah 0.05, bukan 0.5. Demikian juga 

pada sel G3, tuliskan rumus =76-0.5. Lakukan sampai 

sel G6. Pada sel G7, kita isikan dengan tepi atas kelas 

terakhir, yaitu 91 + 0.5. Jadi, pada sel ini tuliskan 

rumus =91+0.5. 

(TIPS: Agar lebih cepat, Anda bisa menggunakan 

panjang kelas. Sebagai contoh, panjang kelas tabel ini 

ini adalah 4. Pada sel G4 tuliskan rumus =G3+4. Salin 

rumus ini sampai sel G7). 

 

 
Gambar 4.4  Hasil pengisian kolom Batas Kelas. 
 

10. Pada sel H2 masukan rumus =(G2-$B$10)/$B$11. Salin 

sampai sel H7. 

11. Pada sel I2 masukan rumus =NORMSDIST(H2). Salin 

sampai sel I7 

12. Pada sel J3 masukan rumus =I3-I2. Salin sampai J7 

13. Pada sel K3 masukan rumus =J3*$B$8. Salin sampai K7 
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14. Pada sel L3 masukan rumus =B3. Salin rumus ini sampai 

L7 

15. Pada sel M3 masukan rumus =(L3-K3)^2/K3. Salin 

sampai M7. 

16. Selanjutnya pada sel M8 masukan rumus =SUM(M3:M7). 

 

 
Gambar 4.5  Hasil melengkapi tabel bantuan 

 

Langkah-langkah di atas menghasilkan nilai Chi-

Square hitung sebagaimana yang terlihat pada 

Gambar 4.5, yaitu: 2
hitung = 5.285. 

17. Berikutnya adalah menentukan nilai Chi-Square tabel. 

Misalkan nilainya kita simpan di sel B12. Di sini tuliskan 

rumus =CHIINV(0.05;5-3) dengan 0.05 adalah taraf 

signifikansi, yaitu 5%; 5 adalah banyaknya kelas dan 5 

– 3 adalah derajat kebebasan (degree of freedom). 

Dengan demikian diperoleh nilai Chi-Square pada 

tabel adalah 5.991, atau 2
tabel = 5.991. 
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Gambar 4.6  Menentukan 2

tabel. 
 

18. Bila nilai Chi-Square hitung lebih kecil daripada nilai 

Chi-Square tabel ( 2
hitung < 2

tabel), maka data 

dinyatakan terdistribusi normal, dan bila sebaliknya, 

maka data tidak atau bukan terdistribusi normal. 

Karena 2
hitung < 2

tabel, maka data tterdistribusi normal. 

 

4.3. Aplikasi SPSS untuk Uji Normalitas 

Uji Normalitas adalah uji statistik yang dilakukan untuk 

mengetahui bagaimana sebaran sebuah data. Cara uji 

normalitas dengan SPSS dapat dilakukan dengan uji Shapiro-

Wilk atau Lilliefors serta Kolmogorov-Smirnov. Selain itu juga 

bisa dengan metode grafik. 

 

a. Uji Kolmogorov-Smirnov 

Pertama kita akan membahas Uji Normalitas 

Kolmogorov-Smirnov dengan SPSS. Konsep dasar dari uji 
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normalitas Kolmogorov-Smirnov adalah dengan 

membandingkan distribusi data (yang akan diuji 

normalitasnya) dengan distribusi normal baku. 

Distribusi normal baku adalah data yang telah 

ditransformasikan ke dalam bentuk Z-Score dan diasumsikan 

normal. Jika signifikansi di bawah 0,05 berarti data yang diuji 

mempunyai perbedaan yang signifikan dengan data normal 

baku, berarti data tersebut bukan normal. Sebaliknya, jika 

signifikansi di atas 0,05 maka berarti tidak terdapat 

perbedaan yang signifikan antara data yang akan diuji 

dengan data normal baku, artinya data yang kita uji normal. 

 

Contoh 4.2 

Ujilah normalitas data pada Contoh 4.1 menggunakan 

metode Kolmogorov-Smirnov pada SPSS. 

 

1. Buka SPSS, aktifkan tab Variable View untuk 

mendefinisikan sebuah variabel. 

Isikan kolom Name dengan X, Type: Numeric, Width: 8, 

Decimal: 0, Label: Nilai, Values: None, Missing: None, 

Columns: 8, Align: Right, Measure: Scale, Role: Input. 
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Gambar 4.7  Pendefinisian variabel. 
 

2. Aktifkan tab Data View lalu masukkan data tersebut ke 

dalam kolom X. 

 

 
Gambar 4.8  Pengisian data. 
 

3. Klik menu Analyze → Nonparametric Test → Legacy 

Dialogs → 1-Sample K-S. 
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Gambar 4.9  Kotak dialog uji Kolmogorov-Smirnov. 

 

4. Pada Gambar 4.9, klik variabel Nilai [X] lalu klik 

tanda panah ke kanan agar berpindah ke kolom Test 

Variabel List. 

Pada Test Distribution, beri tanda centang pada 

Normal. 

Klik tombol OK. 

5. Interpretasi Uji Normalitas Kolmogorov dengan SPSS.  

Perhatikan tabel yang ditampilkan pada jendela output 

sebagai berikut. 
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Gambar 4.10 Tabel output SPSS hasil uji Kolmogorov. 

 

Pada output, lihat pada baris paling bawah dan paling 

kanan yang berisi Asymp. Sig. (2-tailed), yaitu 0.858. 

Sesuai dengan ketentuan di atas, yaitu jika nilainya di 

atas 0.05 maka distribusi data dinyatakan memenuhi 

asumsi normalitas atau data tterdistribusi normal. 

 

b. Uji Normalitas Shapiro-Wilk dan Lilliefors 

Di sini kita akan membahas 2 uji normalitas yang 

sangat sering dipakai oleh peneliti selain uji Kolmogorov-

Smirnov. Uji Kolmogorov-Smirnov adalah uji yang paling 

populer, tapi sebenarnya uji tersebut mempunyai sedikit 

kelemahan, yaitu reliabel atau andal pada pengujian dengan 

sampel besar (> 200). Bagaimana jika sampel kurang dari 
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itu? dalam SPSS kita bisa menggunakan Shapiro-Wilk dan 

Lilliefors. Sebagai contoh, kita gunakan data yang sama 

dengan data di atas. 

1. Klik Analyze → Descriptive Statistics → Explore 

2. Masukkan variabel Nilai [X] ke dalam Dependent 

List. Apabila dalam variabel terdapat 2 kelompok, 

misal kelompok A dan B, uji normalitas pada masing-

masing kelompok dengan cara memasukkan variabel 

yang menjadi Grouping (A dan B atau 1 dan 2) ke kotak 

Factor List. Pada Display centang Both. Artinya kita 

akan melihat nilai statistik dan plot uji normalitas 

termasuk juga hasil uji Shapiro-Wilk dan Lilliefors. 

 

 
Gambar 4.11 Pengaturan parameter dasar uji normalitas. 
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3. Klik tombol Plots. Beri centang pada Stem-and-Leaf, 

Histogram, dan Normality Plots With Tests. 

 

 
Gambar 4.12 Plot Uji Normalitas dengan SPSS. 

 

Klik tombol Continue 

4. Klik tombol OK.  

5. Interpretasi Output Uji Normalitas dengan SPSS. 

Sebagaimana uraian di atas, terdapat dua uji yaitu 

Shapiro-Wilk dan Lilliefors. 
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SShapiro Wilk 

Untuk menentukan apakah data terdistribusi normal 

menggunakan Shapiro-Wilk, lihat nilai Sig. pada 

kolom Shapiro-Wilk. Nilai Sig itu berarti signifikansi 

atau boleh disebut p-value atau nilai probabilitas. Pada 

contoh ini nilainya sebesar 0.152 lebih dari 0.05, maka 

dikatakan data tterdistribusi normal. 

 

 
Gambar 4.13 Hasil Uji Shapiro-Wilk. 

 

Lilliefors 

Hampir sama dengan Shapiro-Wilk di atas, cara 

interpretasinya adalah dengan melihat nilai Sig. pada 

kolom Kolmogorov-Smirnova. Pada contoh di atas 

nilainya 0.200 lebih dari 0.05, maka data tterdistribusi 

normal. 
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44.4. Aplikasi SPSS untuk Uji Homogenitas 

Perhitungan uji homogenitas menggunakan software 

SPSS adalah dengan Uji Levene Statistics. Cara menafsirkan 

uji Levene ini adalah jika nilai Levene Statistic > 0.05 maka 

dikatakan bahwa variasi data adalah homogen. 

Uji homogenitas dilakukan untuk membandingkan dua 

kelompok data apakah berasal dari sampel dengan distribusi 

yang homogen atau tidak. Apabila kedua data dikatakan 

homogen, berarti kedua data tersebut memiliki sebaran yang 

identik sehingga dapat dibandingkan. 

 

Contoh 4.3 

Ujilah homogenitas kedua data berikut. Kedua data 

merupakan hasil tes pemahaman dari kelompok 

eksperimen dan kelompok kontrol. 

Kelompok eksperimen: 

4  5 9 13 2 9 11 

11 16 19 11 4 4 10 

15 13 5 7 4 8 

Kelompok kontrol: 

6  7 10 12 4 4 14 

13 10 15 6 13 8 4 

11  12 10 5 5 10 

Berikut adalah Langkah-langkahnya: 
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1. Buka SPSS, aktifkan tab Variable View untuk 

mendefinisikan dua buah variabel. 

Untuk variabel pertama, isikan kolom Name dengan 

nilai, Type: Numeric, Width: 8, Decimal: 0, Label: 

Nilai, Values: None, Missing: None, Columns: 8, Align: 

Right, Measure: Scale, Role: Input. 

 

 
Gambar 4.14  Pendefinisian variabel pertama. 
 

Untuk variabel kedua, isikan kolom Name dengan kelas, 

Type: Numeric, Width: 8, Decimal: 0, Label: Nilai. Pada 

kolom Values, klik tanda elipsis (tombol dengan tiga 

titik) selanjutnya ditampilkan jendela seperti pada 

Gambar 4.15. 

Pada gambar tersebut, masukan Value: 1 dan Label: 

Eksperimen. Lalu klik Add. Ulangi untuk kelas Kontrol 

dengan Value: 2. 

Sampai sini kita klik tombol OK. 
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Gambar 4.15  Kotak dialog penentuan value dan label. 
 

 
Gambar 4.16  Hasil penentuan values. 

 

Pada Gambar 4.16 memiliki arti bahwa pada Data 

View, setiap data nilai akan dikelompokkan 

berdasarkan variabelnya. Semua nilai yang diperoleh 

pada kelas eksperimen diberi tanda ‘kelompok 1’ dan 

untuk kelas kontrol diberi tanda ‘kelompok 2’. 
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Selanjutnya untuk kolom Missing: None, Columns: 8, 

Align: Right, Measure: Nominal, dan Role: Input. 

 

 
Gambar 4.17  Pendefinisian dua variabel. 
 

6. Aktifkan tab Data View lalu masukkan data tersebut ke 

dalam kolom nilai. Ada pun untuk kolom kelas, 

disesuaikan dengan asal dari angka/nilai tersebut. 

Apabila berasal dari kelas eksperimen diisi dengan nilai 

1 apabila berasal dari kelas kontrol diisi dengan nilai 2. 

Penulisan value ini akan kita gunakan untuk 

mengelompokkan nilai. 
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Gambar 4.18  Pengisian nilai lengkap. 

 

7. Klik menu Analyze → Compare Means → One-Way ANOVA. 

8. Klik variabel Nilai [nilai] lalu klik panah yang 

mengarah ke Dependent List 

9. Klik variabel Kelas [kelas] lalu klik panah yang 

mengarah ke Factor 

 

 
Gambar 4.19  One-Way ANOVA. 
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10. Klik tombol Options 

11. Pada kotak dialog yang ditampilkan, beri tanda centang 

pada Homogenity of variance test di bagian kotak 

Statistics. 

 

 
Gambar 4.20  Pengaturan One-Way ANOVA. 

 

Klik tombol Continue. 

12. Klik tombol OK 

13. Interpretasi hasil uji homogenitas varians. Perhatikan 

tabel Test of Homogeneity of Variances. 
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Gambar 4.21  Output tabel uji homogenitas 

 

Ketentuan 

Jika nilai Sig ≥ , maka H0 diterima, berarti data 

berasal dari dua sampel yang homogen 

Jika nilai Sig < , maka H0 ditolak, berarti data berasal 

dari dua sampel yang tidak homogen. 

 

Karena nilai Sig = 0.351 > 0.05 maka data H0 

diterima. Artinya data berasal dari dua sampel yang 

homogen atau kkedua data homogen. 

 

LATIHAN 

1. Ujilah normalitas data berikut baik dengan 

menggunakan Microsoft Excel maupun SPSS (metode 

Kolmogorov-Smirnov, Shapiro-Wilk, dan Lilliefors): 
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Tabel 
Hasil Belajar Siswa yang Menggunakan Metode 

Permainan (Kelas III-A) 

NNo  NNama Skor 

1 Farhan I 100 
2 Faisal Adha Putra 100 
3 Boy C 100 
4 Ardun 100 
5 Hana 100 
6 Febrianallah 100 
7 Asep 100 
8 Anggi Intan Lestari 100 
9 Imelda Apriliani 100 
10 Revisa Rahmannura, T 100 
11 Muhaemin, A 95 
12 M, Reynaldi, F 95 
13 M, Faisal M 95 
14 M, Ridho A 95 
15 Firly Febrina 95 
16 Imaddudin, AR 95 
17 M, Ajrika 95 
18 M, Abu Ajid, A 90 
19 Isma Ayu Nuranisa 90 
20 Irham F 85 
21 Refa Kamila 85 
22 Ratu Syifa Fauziyah 85 
23 Farikhatunnisa 85 
24 Kartika Sari 85 
25 M Aldi Maulana 85 
26 Deta P 80 
27 Padil Zarkasih 80 
28 Farah Fauziyah 80 
29 Ameliana 80 
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30 Astri Ayu, R 80 
31 Winzi Farahiyah 80 
32 Diwa H 75 
33 Putri Diana Vita 75 
34 Dwi 75 
35 Syauqi 75 
36 M, Karim 75 
37 Fabri Lukmansyah 75 
38 Saskia Wafa Fauziyah 70 
39 Kintan 70 
40 Reni Oktaviani 70 
41 Rifyal Amrulloh 70 
42 Romi RS 70 
43 M, Faisal Nur 70 
44 Deni Rahman 65 

 

Tabel 
Hasil Belajar Siswa yang Menggunakan Metode 

Ekspositori (Kelas III-B) 
NNo  NNama  SSkor  
1 Fanisa Dina A 100 
2 M Nurhidayat 100 
3 Rangga 100 
4 Hanifah PP 100 
5 Prisma W.A 100 
6 Mentari S.A 100 
7 Darmawan 95 
8 Anggilda Kania Dewi 95 
9 Aulia Putri 95 

10 M, Lutfi H 95 
11 Iha Zakiyah 95 
12 Tiffany P.N 90 
13 Khaerun Anisa 90 
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14 Adliya H 90 
15 Ririn Y 90 
16 Rizky R 90 
17 Nadif 90 
18 Raziansyah H 85 
19 Umi Fathin 85 
20 Erlin Nurlinda 85 
21 Riva 85 
22 Widyati HS 80 
23 Diajeng 80 
24 Hesti Spinky 80 
25 Dafi 80 
26 Jorgi 80 
27 Gias 75 
28 Ratu Hey Novia R 75 
29 Putri R 75 
30 Hana Nabila Putri 70 
31 Varis 70 
32 Resultana 70 
33 Jelita 70 
34 Natasya Auliani 70 
35 Dina Fitriana 70 
36 Arif Rahmah Tsani 70 
37 Odiri Vaqda 60 
38 Meidina Putri 55 
39 Aziz 55 
40 Gemuruh 50 
41 Adnan 50 
42 Alya Rahma Z 50 
43 Yoga 45 
44 Faras Nabila 35 

2. Uji juga homogenitas kedua data tersebut. 
 



75 

 

55 

ONE SAMPLE t-TEST 
 

 

5.1 Pengantar 

Salah satu bagian penting dalam ilmu statistik adalah 

persoalan inferensi yaitu penarikan kesimpulan secara 

statistik. Dua hal pokok yang menjadi pembicaraan dalam 

statistik inferensi adalah penaksiran parameter populasi dan 

uji hipotesis. Teknik inferensi yang pertama dikembangkan 

adalah mengenai pembuatan sejumlah besar asumsi sifat 

populasi di mana sampel telah diambil. Teknik yang banyak 

digunakan pada metode-metode pengujian hipotesis dan 

penaksiran interval ini kemudian dikenal sebagai Statistik 

Parametrik, karena harga-harga populasi merupakan 

parameter. 

Distribusi populasi atau distribusi variabel acak yang 

digunakan pada teknik inferensi ini mempunyai bentuk 

matematik yang diketahui, akan tetapi memuat beberapa 

parameter yang tidak diketahui. One Sample t Test adalah uji 

komparatif untuk menilai perbedaan antara nilai tertentu 



5 – One Sample t-Test 

76 

dengan rata-rata kelompok populasi. One sample t test 

disebut juga dengan istilah student t test atau uji t satu sampel 

oleh karena uji t di sini menggunakan satu sampel. 

 

55.2 One Sample t-Test dengan SPSS 

Kita mulai dengan sebuah kasus 

 

Contoh 5.1 

Seorang guru menduga bahwa siswa yang mengikuti 

pembelajaran menggunakan metode X memiliki hasil 

belajar rata-rata 75. Hal ini didasarkan pada data hasil 

belajar dari dua kelas yang menggunakan metode yang 

sama, sebagai berikut: 

100 100 100 100 100 100 100 

100 100 100 95 95 95 95 

95 95 95 90  90 85 85 

85 85 85  85 80 80 80 

80 80  80 75 75 75 75 

75  75 70 70 70 70 70 

70 65 

Ujilah kebenaran dugaan tersebut dengan taraf 

kesalahan sebesar 5%. 

 

1. Buat data baru, lalu klik tab Variabel View. 
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2. Definisikan sebuah variabel dengan ketentuan sebagai 

berikut: Kolom Name dengan nilai, Type: Numeric, 

Width: 8, Decimal: 0, Label: Nilai, Values: None, 

Missing: None, Columns: 8, Align: Right, Measure: 

Scale, Role: Input. 

 

 
Gambar 5.1  Definisi variabel. 
 

3. Buka tab Data View lalu masukan semua data pada 

kolom nilai. 

 

 
Gambar 5.2  Memasukkan data nilai ke dalam SPSS 
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4. Klik menu Analyze → Compare Means → One-Sample T-

Test 

5. Pada jendela yang ditampilkan, pilih variabel Nilai 

[nilai] kemudian klik tombol panah ke kanan 

sehingga variabel Nilai [nilai] berpindah ke kolom 

Test Variable(s). Pada kolom Test Value, kita isikan 

dengan parameter penduga. Dalam contoh ini 

parameter penduganya adalah 75. 

 

 
Gambar 5.3  Pengisian parameter One-Sample T Test. 
 

6. Klik tombol Option  

7. Pada kotak dialog yang ditampilkan, isikan derajat 

kepercayaan sebesar 95% (atau  = 5%). Setelah itu klik 

tombol Continue. 
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Gambar 5.4  Pengaturan taraf kepercayaan 
 

8. Klik tombol OK akan muncul jendela output. 

9. Interpretasi output One-Sample T-Test 

Perhatikan kedua output berikut. 

 

 
Gambar 5.5  Tabel One-Sample Statistics. 

 

Tabel One-Sample Statistics di atas menunjukkan 

nilai statistik deskriptif, yaitu N=44 artinya jumlah sampel 

yang dipakai adalah 44 orang siswa. Mean= 85.68 

artinya nilai rata-rata hitung adalah 85.68. Std. 

Deviation atau simpangan baku adalah sebesar 

11.289 dan Std. Error Mean adalah sebesar 1.702. 
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Gambar 5.6  Tabel One-sample test dengan test value = 75.
 

Berdasarkan tabel One-Sample Test di atas diketahui 

nilai t (thitung) adalah sebesar 6.277. Nilai df (degree of 

freedom) atau derajat kebebasan adalah sebesar 43. 

Nilai Sig. (2-tailed) atau nilai signifikansi dengan uji 

dua sisi adalah sebesar 0.000. 

 

Rumusan hipotesis penelitian dalam One Sample t Test: 

H0 : Nilai rata-rata hasil belajar siswa yang 

mengikuti pembelajaran menggunakan metode 

X sama dengan 75 

Ha : Nilai rata-rata hasil belajar siswa yang 

mengikuti pembelajaran menggunakan metode 

X tidak sama dengan 75 

 

Dasar pengambilan keputusan One Sample T Test 

Jika nilai Sig. (2-tailed) < 0.05 maka H0 ditolak 

Jika nilai Sig. (2-tailed) > 0.05 maka H0 diterima 
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KKesimpulan One Sample T Test dengan SPSS 

Berdasarkan output tabel One-Sample T Test di atas 

ketahui nilai Sig. (2-tailed) adalah sebesar 0.000 < 

0.05, maka sesuai dengan dasar pengambilan 

keputusan di atas maka H0 ditolak dan Ha diterima. 

Dengan demikian, dapat diartikan bahwa nilai rata-rata 

hasil belajar siswa yang mengikuti pembelajaran 

menggunakan metode X tidak sama dengan 75. 

 

Kesimpulan One Sample t-Test dengan Membandingkan 

Nilai t 

Ketentuan: 

Jika nilai thitung > ttabel maka H0 ditolak 

Jika nilai thitung < ttabel maka H0 diterima 

 

Berdasarkan output tabel One-Sample T Test di atas 

ketahui nilai thitung sebesar 6.277. Selanjutnya cari ttabel 

(uji dua sisi; df) = (0.05; 43) kemudian lihat pada 

distribusi nilai ttabel statistik, diperoleh nilai ttabel sebesar 

1.684. 

Karena nilai thitung = 6.277 > ttabel = 1.684 maka H0 

ditolak dan Ha diterima. Sehingga dapat disimpulkan 

bahwa nilai rata-rata hasil belajar siswa yang mengikuti 



5 – One Sample t-Test 

82 

pembelajaran menggunakan metode X tidak sama 

dengan 75. 

 

LLATIHAN 

Diketahui data 30 nilai hasil ulangan harian siswa dalam 

Mata Pelajaran Matematika Kelas IV SD. 

 

72 48 66 62 76 58 78 32 

74 41 47 57 80 52 54 81 

66 70 85 64 70 60 65 88 

43 37 68 55 39 35 

Ujilah dengan one sample t test untuk mengetahui 

perbedaan dengan hasil ulangan harian sebelumnya jika 

nilai rata-rata sebelumnya adalah 65. 
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66 

TWO SAMPLES t-TEST 
 

 

6.1 Pengantar 

Two Samples t-Test adalah pengujian perbandingan 

yang dikenakan terhadap dua kelompok data. Berdasarkan 

hubungan kedua kelompok data, uji ini dibagi menjadi dua, 

yaitu: independent samples t-test dan dependent samples t-

test. Independent samples t-Test adalah uji komparatif atau uji 

beda untuk mengetahui adakah perbedaan mean atau rerata 

yang bermakna antara 2 kelompok bebas (independen) yang 

berskala data interval/rasio. Dua kelompok bebas yang 

dimaksud di sini adalah dua kelompok yang tidak 

berpasangan, artinya sumber data berasal dari subjek yang 

berbeda. Misal Kelompok Kelas A dan Kelompok kelas B, di 

mana responden dalam kelas A dan kelas B adalah 2 

kelompok yang subjeknya berbeda. Sementara apabila kedua 

kelompok data berasal dari subjek yang sama atau berkaitan, 

maka kita menggunakan dependent samples t-test. 
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66.2 Independent Samples t-Test dengan SPSS 

Kita mulai dengan sebuah contoh kasus sebagai 

berikut. 

 

Contoh 6.1 

Seorang guru ingin pengaruh penerapan metode 

pembelajaran X terhadap hasil belajar siswa pada mata 

pelajaran IPA di Kelas III SD. Guru tersebut menerapkan 

metode pembelajaran X di Kelas IIIA dan metode 

pembelajaran konvensional di Kelas IIIB. Di akhir 

pembelajaran, guru memberikan tes kepada siswa di 

kedua kelas dengan hasil sebagai berikut. 

 

Kelas IIIA Kelas IIIB 

78.00 82.25 
83.25 72.25 
85.00 87.00 
80.25 93.75 
74.50 83.25 
75.50 71.75 
91.50 81.75 
87.75 96.75 
80.75  
78.00  
76.00  
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Dengan taraf kesalahan sebesar 5%, tentukan apakah 

metode X memberikan pengaruh terhadap peningkatan 

hasil belajar IPA Kelas III SD? 

 

Untuk melakukan analisis permasalahan di atas, kita 

perlu memahami terlebih dahulu hubungan kedua kelompok 

data yang disajikan pada tabel di atas. Karena subjek dari 

kedua kelompok data tersebut tidak sama atau tidak 

berhubungan di mana hasil pada kelompok data yang satu 

tidak mempengaruhi hasil pada kelompok data yang lain 

serta sebaliknya, maka dikatakan bahwa kedua kelompok 

data adalah independen atau bebas. Berikut adalah langkah-

langkah analisis data menggunakan SPSS. 

1. Buat data baru, lalu buka tab Variable View. 

2. Definisikan dua variabel. Variabel pertama untuk 

menyimpan data nilai dan variabel kedua untuk 

menyimpan data kelas. 

Untuk variabel pertama, kita buat dengan ketentuan 

sebagai berikut: isikan kolom Name dengan nilai, Type: 

Numeric, Width: 8, Decimal: 2, Label: Nilai, Values: 

None, Missing: None, Columns: 8, Align: Right, Measure: 

Scale, Role: Input. 
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Gambar 6.1  Pendefinisian variabel pertama. 
 

3. Untuk variabel kedua, isikan kolom Name dengan kelas, 

Type: Numeric, Width: 8, Decimal: 0, Label: Nilai. Pada 

kolom Values, klik tanda elipsis (tombol dengan tiga 

titik) selanjutnya ditampilkan jendela seperti pada 

Gambar 6.2. Pada gambar tersebut, masukan Value: 1 

dan Label: Kelas IIIA. Lalu klik Add. Ulangi untuk 

kelas Kelas IIIB dengan Value: 2. 

 

 
Gambar 6.2  Pengaturan values variabel kedua. 
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Gambar 6.2 memiliki arti bahwa pada Data View, 

setiap data nilai akan dikelompokkan berdasarkan 

variabelnya. Semua nilai yang diperoleh pada Kelas IIIA 

diberi tanda ‘Kelas IIIA’ dan untuk Kelas IIIB diberi tanda 

‘Kelas IIIB’. Selanjutnya untuk kolom Missing: None, 

Columns: 8, Align: Right, Measure: Nominal, dan 

Role: Input. 

 

 
Gambar 6.3  Pendefinisian dua variabel. 
 

4. Klik tab Data View lalu masukkan data pada tabel di 

atas ke dalam kolom nilai. Ada pun untuk kolom kelas, 

disesuaikan dengan asal dari angka/nilai tersebut. 

Apabila berasal dari Kelas IIIA diisi dengan nilai 1 

apabila berasal dari Kelas IIIB diisi dengan nilai 2. 

Penulisan value ini akan kita gunakan untuk 

mengelompokkan nilai. 
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Gambar 6.4  Pengisian nilai lengkap. 

 

5. Klik menu Analyze → Compare Mean → Independent-

Samples T Test. 

6. Masukan variabel Nilai ke Test Variable(s) dan 

Kelas ke Grouping Variable. 

 

 
Gambar 6.5  Independent Samples t-Test. 
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7. Klik tombol Define Groups dan isikan 1 di Group 1 dan 

2 di Group 2 dan klik tombol Continue. 

 

 
Gambar 6.6  Pendefinisian grup sesuai dengan values. 

 

8. Klik tombol OK sehingga ditampilkan output SPSS. 

9. Interpretasi output Independent Samples Test. 

 

 
Gambar 6.7  Tabel Independent Samples Test. 
 

Tabel Independent Samples Test menampilkan uji 

varian kedua kelompok. F-test digunakan untuk 
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menguji asumsi dasar dari t-test bahwa varians kedua 

kelompok sama. Langkah pertama adalah menguji 

varians kedua kelompok dengan hipotesis sebagai 

berikut. 

H0 : Kedua kelompok memiliki varian yang sama 

(homogen) 

Ha : Kedua kelompok memiliki varian yang tidak 

sama (tidak homogen) 

Kriteria penolakan H0: 

Jika Fhitung < Ftabel maka H0 diterima 

Jika Fhitung > Ftabel maka H0 ditolak 

atau 

Jika nilai Sig >  maka H0 diterima 

Jika nilai Sig <  maka H0 ditolak 

Perhatikan nilai Sig pada kolom Levene's Test for 

Equality of Variances. Karena nilai Sig (0.236) >  

(0.05) maka H0 diterima. Jadi kedua kelompok memiliki 

varians yang sama (homogen). Dengan demikian, 

untuk analisis selanjutnya kita menggunakan asumsi 

variansnya sama (equal). 

 

Selanjutnya adalah menguji hipotesis penelitian 
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H0 : Metode X tidak memberikan pengaruh yang 

positif dan signifikan terhadap hasil belajar 

Mata pelajaran IPA Siswa Kelas III SD 

Ha : Metode X memberikan pengaruh yang positif 

dan signifikan terhadap hasil belajar Mata 

pelajaran IPA Siswa Kelas III SD 

Hipotesis di atas ditulis dalam hipotesis statistika 

sebagai berikut: 

H0 : μ1 = μ2 

Ha : μ1 ≠ μ2 

Dengan μ1 menyatakan rata-rata hasil belajar siswa di 

Kelas IIIA yang menggunakan metode X dan μ2 

menyatakan rata-rata hasil belajar siswa di Kelas IIIB 

yang tidak menggunakan metode X (metode 

konvensional) 

Kriteria penolakan H0 

Jika nilai Sig (2-tailed) >  maka Ho diterima. 

Jika nilai Sig (2-tailed) <  maka Ho ditolak. 

 

Pada tabel Independent Samples Test, lihat baris Equal 

variances assumed, kolom t-test for Equality of 

Means, terlihat bahwa  Sig (2-tailed) = 0.434 karena 

nilai Sig (2-tailed) >  (0.05) maka H0 diterima. Jadi 
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metode X ttidak memberikan pengaruh yang positif dan 

signifikan terhadap hasil belajar Mata pelajaran IPA 

Siswa Kelas III SD. 

 

6.3 Dependent Samples t-Test dengan SPSS 

Berbeda dengan independent t-test, pada kasus 

dependent t-test dua kelompok data berasal dari subjek yang 

sama atau berkaitan. Sebagai contoh, keterampilan mengetik 

antara sebelum dan sesudah diberikan pelatihan mengetik. 

Data keterampilan mengetik baik sebelum (biasa ditulis X1) 

maupun sesudah (biasa ditulis X2) diberikan pelatihan berasal 

dari subjek yang sama misalkan karyawan di suatu kantor. 

Oleh karena itu X1 dan X2 adalah sampel yang dependen. 

Atau bisa juga data hasil pre test dan post test suatu kelas di 

mana pre test adalah hasil tes sebelum diberikan perlakuan 

dan post test adalah hasil tes sesudah diberikan perlakuan. 

 

Contoh 6.2 

Seorang guru PJOK ingin mengetahui pengaruh 

penerapan teknik pelemparan terhadap kemampuan 

servis pada permainan badminton. Guru tersebut 

mencatat kemampuan servis awal siswa, kemudian 

memberikan teknik pelemparan, dan terakhir mencatat 
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kembali kemampuan servis siswa setelah menerima 

teknik tersebut. 

Diperoleh data sebagai berikut: 

 

Siswa ke Sebelum Sesudah 

1 45 78 
2 38 75 
3 47 80 
4 28 60 
5 37 64 
6 47 75 
7 44 79 
8 35 71 
9 41 67 

10 42 71 
 

Dengan taraf kesalahan sebesar 5%, ujilah pengaruh 

metode pelemparan terhadap kemampuan servis pada 

permainan badminton? 

  

Untuk melakukan analisis permasalahan di atas, kita 

perlu memahami terlebih dahulu hubungan kedua kelompok 

data yang disajikan pada tabel di atas. Karena subjek dari 

kedua kelompok data tersebut sama atau berhubungan di 

mana hasil pada kelompok data yang satu dipengaruhi hasil 

pada kelompok data yang lain serta sebaliknya, maka 
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dikatakan bahwa kedua kelompok data adalah dependen 

atau berkaitan. 

Berikut adalah langkah-langkah analisis data 

menggunakan SPSS. 

1. Buat data baru, lalu klik tab Variable View 

2. Definisikan dua variabel. Variabel pertama untuk 

menyimpan data skor dan variabel kedua untuk 

menyimpan data pencatatan. 

Untuk kedua variabel, kita buat dengan ketentuan yang 

sama sebagai berikut:  

Pada kolom Name isi dengan pretest (variabel pertama) 

dan posttest (variabel kedua), Type: Numeric, Width: 

8, Decimal: 0, Label: Pre Test (variabel pertama) dan 

Post Test (variabel kedua), Values: None, Missing: 

None, Columns: 8, Align: Right, Measure: Scale, Role: 

Input. 

 

 
Gambar 6.8  Pendefinisian variabel penelitian. 
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3. Klik tab Data View lalu masukkan data pada tabel di 

atas ke dalam kolom yang sesuai. 

 

 
Gambar 6.9  Pengisian nilai lengkap. 

 

4. Pilih menu Analyze → Compare Mean → Paired-Samples 

T Test. 

5. Pilih variabel Pre Test pada kolom sebelah kiri lalu klik 

tombol panah ke arah kanan sehingga variabel Pre 

Test sekarang berpindah ke kolom Variable 1, baris 

Pair 1 pada kotak Paired Variables.  
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Lakukan hal yang sama pada variabel Post Test 

sehingga variabel Post Test berada di kolom Variable 

2, baris Pair 1. 

 

 
Gambar 6.10  Pemilihan variabel yang dipasangkan. 

 

6. Klik tombol OK sehingga ditampilkan output SPSS. 

7. Interpretasi Dependent Samples t-Test 

Tabel Paired Samples Correlations menampilkan uji 

korelasi nilai pre test dan post test. 

 

 
Gambar 6.11  Tabel Paired Samples Correlations. 
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Pada bagian ini kita menguji apakah terdapat 

hubungan antara skor pre test dengan skor post test. 

Hipotesis penelitian: 

H0 : Tidak ada hubungan antara skor pre test dan 

post test dengan teknik pelemparan 

Ha : Ada hubungan antara skor pre test dan post test 

dengan teknik pelemparan 

Kriteria penolakan H0: 

Jika thitung < ttabel maka H0 diterima 

Jika thitung > ttabel maka H0 ditolak 

atau 

Jika nilai Sig >  maka H0 diterima 

Jika nilai Sig <  maka H0 ditolak 

Pada tabel di atas, nilai Sig. = 0.004. berdasarkan 

ketentuan, karena nilai Sig. (0.004) <  (0.05) maka 

H0 ditolak. Jadi ada hubungan antara pre test dan post 

test dengan teknik pelemparan dengan tingkat 

hubungan/korelasi cukup besar, yaitu 0.817. 

 

Tabel Paired Samples Test menampilkan uji beda nilai 

pre test (sebelum) dan post test (sesudah) perlakuan. 
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Gambar 6.12  Paired Samples Test Table. 
 

Selanjutnya, setelah kita mengetahui bahwa terdapat 

hubungan antara skor pre test dan post test dengan 

teknik pelemparan maka kita bisa melanjutkan analisis 

untuk menguji hipotesis penelitian berikut: 

 

H0 : Tidak terdapat perbedaan skor pre test dan post 

test dengan teknik pelemparan 

Ha : Terdapat perbedaan skor pre test dan post test 

dengan teknik pelemparan 

 

Hipotesis di atas dapat dituliskan dalam hipotesis 

statistik sebagai berikut: 

H0 : μ1 = μ2 

Ha : μ1 ≠ μ2 

Dengan μ1 menyatakan rata-rata skor kemampuan 

servis sebelum diberikan teknik pelemparan dan μ2 

menyatakan rata-rata skor kemampuan servis sesudah 

diberikan teknik pelemparan. 

Kriteria penolakan H0 

Jika nilai Sig (2-tailed) >  maka Ho diterima. 
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Jika nilai Sig (2-tailed) <  maka Ho ditolak. 

 

Pada tabel Paired Samples Test, terlihat bahwa  Sig 

(2-tailed) = 0.000 karena nilai Sig (2-tailed) <  

(0.05) maka H0 ditolak. Jadi terdapat perbedaan skor 

pre test dan post test dengan teknik pelemparan. 

Sehingga dapat disimpulkan bahwa pemberian teknik 

pelemparan mmemberikan pengaruh yang positif dan 

signifikan terhadap kemampuan servis pada permainan 

badminton. 

 

LATIHAN 1 

Diberikan data nilai hasil belajar Kelas VA dan VB. Kelas VA 

merupakan kelas kontrol dengan pembelajaran ceramah 

dan kelas VB merupakan kelas eksperimen dengan 

pembelajaran inkuiri sebagai berikut. 

 

Sampel Kelas VA Kelas VB 
1 80 73 
2 78 81 
3 78 77 
4 81 79 
5 87 64 
6 67 89 
7 76 72 
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8 68 82 
9 75 76 

10 74 78 
11 81 75 
12 77 87 
13 79 67 
14 64 76 
15 89 73 

Ujilah apakah kedua kelas terdapat perbedaan dengan 

SPSS. 

 

LLATIHAN 2 

Seorang guru ingin menguji efektivitas model pembelajaran 

statistik dengan studi kasus. Maka dilakukan pre test dan 

post test dari 21 siswanya. 

 

Sampel Pre Test Post Test 
1 76 79 
2 83 89 
3 75 70 
4 76 75 
5 60 79 
6 66 80 
7 77 89 
8 90 90 
9 75 83 

10 65 70 
11 70 75 
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12 75 75 
13 85 80 
14 76 79 
15 76 76 
16 45 80 
17 79 75 
18 75 89 
19 79 85 
20 68 70 
21 80 80 

Ujilah data tersebut dengan uji t berpasangan (dependent 

samples t-test) dengan SPSS, gunakan  = 5% (Anggap 

data terdistribusi normal dan homogen). 
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ONE-WAY ANOVA 
 

 

7.1 Definisi Anova 

Baik independent maupun dependent samples t-test 

keduanya digunakan untuk membandingkan rata-rata hanya 

dari dua sampel. Bagaimana jika kita ingin membandingkan 

rata-rata lebih dari dua sampel? Untuk keperluan ini kita 

menggunakan Anova. 

Anova merupakan singkatan dari “analysis of variance”. 

Anova adalah salah satu uji komparatif yang digunakan untuk 

menguji perbedaan mean (rata-rata) data lebih dari dua 

kelompok. Misalnya kita ingin mengetahui apakah ada 

perbedaan rata-rata IQ antara siswa SLTP Kelas I, II, III. Uji 

dalam Anova menggunakan uji F karena dipakai untuk 

pengujian lebih dari dua sampel. Dalam praktik, analisis 

varians dapat merupakan uji hipotesis (lebih sering dipakai) 

maupun pendugaan (estimasi, khususnya di bidang genetika 

terapan). 
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Ada dua jenis Anova, yaitu analisis varian satu faktor 

(one-way anova) dan analisis varian dua faktor (two-ways 

anova). Pada bagian ini kita akan membahas One-way 

Anova. 

 

77.2 Asumsi Uji ANOVA 

Untuk melakukan uji Anova, harus dipenuhi beberapa 

asumsi, yaitu: 

1. Sampel berasal dari kelompok yang independen. 

2. Varian antar kelompok harus homogen. 

3. Data masing-masing kelompok terdistribusi normal  

Asumsi yang pertama harus dipenuhi pada saat 

pengambilan sampel yang dilakukan secara acak terhadap 

beberapa (lebih dari 2) kelompok yang independen, yang 

mana nilai pada satu kelompok tidak tergantung pada nilai 

di kelompok lain. 

Sedangkan pemenuhan terhadap asumsi kedua dan 

ketiga dapat dicek jika data telah dimasukkan ke komputer. 

Jika asumsi ini tidak terpenuhi dapat dilakukan transformasi 

terhadap data. Apabila proses transformasi tidak juga dapat 

memenuhi asumsi ini maka uji Anova tidak valid untuk 

dilakukan, sehingga harus menggunakan uji non-parametrik 

misalnya Kruskal Wallis. 
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77.3 Prinsip ANOVA 

Prinsip Uji Anova adalah melakukan analisis variabilitas 

data menjadi dua sumber variasi yaitu variasi di dalam 

kelompok (within) dan variasi antar kelompok (between). 

Bila variasi within dan between sama (nilai 

perbandingan kedua varian mendekati angka satu), maka 

berarti tidak ada perbedaan efek dari intervensi yang 

dilakukan, dengan kata lain nilai mean yang dibandingkan 

tidak ada perbedaan.  

Sebaliknya bila variasi antar kelompok lebih besar dari 

variasi di dalam kelompok, artinya intervensi tersebut 

memberikan efek yang berbeda, dengan kata lain nilai mean 

yang dibandingkan menunjukkan adanya perbedaan. 

 

7.4 One-Way Anova dengan SPSS 

Setelah kita memahami sedikit tentang One-Way 

Anova, selanjutnya kita akan mencoba melakukan uji One-

Way Anova dengan SPSS. Agar lebih mudah memahami, kita 

gunakan contoh sebagai berikut: 

 

Contoh 7.1 

Berikut ini disajikan data skor TOEFL Mahasiswa PGMI 

yang mengikuti kursus bahasa Inggris. 
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Sampel 
Lama Kursus 

3 bulan 6 bulan 9 bulan 
1 423 444 478 
2 410 459 480 
3 421 440 494 
4 428 435 507 
5 404 468 459 

Ujilah apakah ada perbedaan antara lama kursus 

terhadap skor TOEFL? (Gunakan taraf signifikansi 5%). 

 

Berikut ini langkah-langkah untuk menjawab 

pertanyaan di atas. 

1. Buat data baru, lalu klik tab Variable View 

2. Pada kasus ini, kita akan mendefinisikan dua variabel. 

Variabel pertama adalah lama kursus (berupa nominal) 

dan yang kedua adalah variabel skor. 

Untuk variabel pertama, kita buat dengan ketentuan 

sebagai berikut: Pada kolom Name isi dengan lama, 

Type: Numeric, Width: 8, Decimal: 0, Label: Lama 

Kursus, Values: None, Missing: None, Columns: 8, Align: 

Right, Measure: Nominal, Role: Input. 

Untuk variabel kedua, kita buat dengan ketentuan 

sebagai berikut: Pada kolom Name isi dengan skor, 

Type: Numeric, Width: 8, Decimal: 2, Label: Skor TOEFL, 

Values: None, Missing: None, Columns: 8, Align: Right, 

Measure: Scale, Role: Input. 
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Gambar 7.1  Pendefinisian dua variabel. 
 

3. Buka tab Data View lalu masukan data di atas. Kolom 

lama diisi dengan lama kursus. 

 

 
Gambar 7.2  Pengisian data pada SPSS. 

 

4. Pilih menu Analyze → Compare Mean → One Way Anova. 
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5. Klik variabel Skor TOEFL [skor] lalu tekan tombol 

panah ke kanan di bagian atas sehingga variabel Skor 

TOEFL [skor] berpindah ke kotak Dependent List. Klik 

variabel Lama Kursus [lama] lalu tekan tombol panah 

ke kanan di bagian bawah sehingga variabel Lama 

Kursus [lama] berpindah ke kotak Factor. 

 

 
Gambar 7.3  Pengaturan variabel. 
 

6. Klik tombol Post Hoc. Pada jendela yang ditampilkan, 

beri tanda centang pada LSD di bagian Equal 

Variances Assumed. Ini dilakukan untuk melakukan uji 

lanjutan secara parsial antar dua kelompok. 
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Gambar 7.4  Pengaturan Pos Hoc. 
 

Klik tombol Continue. 

7. Klik tombol Options. Pada jendela yang ditampilkan, 

beri tanda centang pada Descriptive dan Homogeneity 

of Variances Test di bagian Statistics. 

 

 
Gambar 7.5  Pengaturan Options. 
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Klik tombol Continue. 

8. Klik tombol OK sehingga muncul output SPSS. 

Interpretasi output Descriptive 

 

 
Gambar 7.6  Tabel Descriptive. 
 

Tabel Descriptives menunjukkan hasil analisis statistik 

deskriptifnya seperti rata per kelompok, standar deviasi, 

standar error, minimum dan maksimum. 

 

Interpretasi output Test of Homogeneity of Variances 

 

 
Gambar 7.7  Tabel Test of Homogeneity of Variances. 

 

Tabel Test of Homogeneity of Variances menunjukan 

hasil uji homogenitas varians sebagai prasyarat untuk 

dapat menggunakan ANOVA. 
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Hipotesis Penelitian: 

H0 : Ketiga kelompok memiliki nilai varian yang 

sama 

Ha : Ketiga kelompok memiliki nilai varian yang tidak 

sama 

Ketentuan penerimaan/penolakan: 

Jika nilai Sig >  maka H0 diterima. 

Jika nilai Sig <   maka H0 ditolak. 

 

Kesimpulan: 

Pada tabel terlihat bahwa nilai Sig = 0.478. Karena 

nilai Sig >  maka H0 ditolak. Jadi, ketiga kelompok 

memiliki nilai varian yang sama atau dengan kata lain 

varians antar kelompok bersifat homogen. Dengan 

demikian prasyarat untuk dapat menggunakan ANOVA 

terpenuhi. 

Tabel ANOVA menunjukkan hasil uji beda rata-rata 

secara keseluruhan 

 

 
Gambar 7.8  Tabel ANOVA. 
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Hipotesis Penelitian: 

H0 : Ketiga kelompok memiliki rata-rata Skor TOEFL 

yang sama 

Ha : Ketiga kelompok memiliki rata-rata Skor TOEFL 

yang berbeda 

Ketentuan penerimaan/penolakan : 

Jika nilai Sig >  maka H0 diterima. 

Jika nilai Sig <  maka H0 ditolak. 

Pada tabel terlihat nilai Sig = 0.000. Karena nilai sig 

<  maka H0 ditolak. Jadi, ketiga kelompok memiliki 

rata-rata Skor TOEFL yang berbeda. Sehingga dapat 

disimpulkan ada perbedaan rata-rata Skor TOEFL 

antara mahasiswa yang mengambil kursus tiga bulan, 

enam bulan, dan sembilan bulan. 

 

Keterangan: 

jika hasil pengujiannya signifikan maka dilanjutkan ke 

uji Post Hoc, tetapi jika tidak signifikan pengujian 

berhenti sampai di sini. 

 

Tabel Multiple Comparisons menunjukkan hasil uji lanjut 

untuk mengetahui perbedaan antar kelompok secara 

spesifik sekaligus untuk mengetahui Skor TOEFL yang 

paling tinggi. 
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Gambar 7.9  Tabel Multiple Comparisons. 

  

Hipotesis Penelitian: 

H0 : Kedua kelompok memiliki rata-rata Skor TOEFL 

yang sama 

Ha : Kedua kelompok memiliki rata-rata Skor TOEFL 

yang berbeda 

Ketentuan penerimaan/penolakan: 

Jika nilai Sig >  maka H0 diterima. 

Jika nilai Sig <  maka H0 ditolak. 

 

Misalnya untuk melihat perbedaan Skor TOEFL antara 

mahasiswa yang kursus tiga bulan dan enam bulan 

diperoleh nilai Sig = 0.004. Oleh karena nilai Sig <  

maka disimpulkan bahwa ada perbedaan Skor TOEFL 

antara mahasiswa yang kursus tiga bulan dan enam 

bulan. Dalam hal ini Skor TOEFL mahasiswa yang 
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kursus enam bulan lebih tinggi dari pada yang kursus 

tiga bulan. 

Dengan kata lain lama kursus berpengaruh terhadap 

peningkatan Skor TOEFL mahasiswa. 

 

LLATIHAN 

Telah dilakukan pengumpulan data untuk mengetahui 

adakah hubungan antara tingkat stres mahasiswa pada 

Jurusan Pendidikan IPA, Pendidikan Matematika, dan 

Pendidikan Biologi di tahun ke-3. Tingkat stres diukur pada 

skala 1-10. Skala 1 hingga 3 menunjukkan mahasiswa 

cukup stres. Skala 4 sampai 6 menunjukkan mahasiswa 

dalam keadaan stres dan skala 7 ke atas menunjukkan 

mahasiswa sangat stres. Pengamatan dilakukan dengan 

menggunakan metode pengumpulan data yaitu kuesioner 

yang disebarkan pada 75 responden. Diperoleh data 

seperti pada tabel berikut. 

 

Pendidikan 
IPA 

Pendidikan 
Matematika 

Pendidikan 
Biologi 

4 2 1 4 1 2 4 1 2 8 6 6 5 9 5 
6 2 2 7 4 2 5 9 1 8 2 8 1 9 6 
2 1 3 9 5 3 6 8 1 7 1 1 3 2 7 
8 7 5 5 4 4 7 4 4 7 9 4 2 1 3 
8 5 2 4 7 5 8 7 7 7 8 8 5 4 4 
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Gunakan SPSS untuk menguji apakah terdapat pengaruh 

antara jurusan/program studi mahasiswa terhadap tingkat 

stres mahasiswa tingkat ke-3 tersebut. Gunakan taraf 

signifikansi 5%. 
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TWO-WAYS ANOVA 
 

 

8.1 Pengertian 

Two-Ways Anova disebut juga dengan Anova dua Arah 

atau Analisis Varian dua Faktor. Anova dua arah 

membandingkan perbedaan rata-rata antara kelompok yang 

telah dibagi pada dua variabel independen (disebut faktor). 

Two-Ways Anova mensyaratkan dua variabel independen 

berskala data kategori dan satu variabel terikat berskala data 

kuantitatif/numerik (interval atau rasio). 

 

8.2 Two-Ways Anova dengan SPSS 

Untuk memperjelas bagaimana melakukan uji Two-

Ways Anova, kita mulai dengan sebuah contoh. 

 

Contoh 8.1 

Telah dilakukan penelitian dengan judul “Pengaruh 

Gender dan Letak Geografis terhadap Hasil Belajar 
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IPA”. Sampel yang terlibat dalam penelitian adalah 40 

orang yang dikategorikan berdasarkan: 

1. Gender, yaitu: Pria dan Wanita 

2. Letak geografis, yaitu: urban, sub-urban, dan rural. 

Hasil belajar IPA  diperoleh dengan memberikan tes 

tulis sesuai dengan indikator materi yang diajarkan 

sebelum tes diberikan. 

Data penelitian disajikan pada tabel berikut: 

 

No. 
Sampel 

Jenis 
Kelamin 

Letak Geografis Nilai Tes 

1 Pria Urban 24 
2 Pria Urban 35 
3 Pria Urban 44 
4 Pria Urban 35 
5 Pria Urban 34 
6 Pria Urban 44 
7 Pria Urban 11 
8 Pria Sub-urban 45 
9 Pria Sub-urban 65 

10 Pria Sub-urban 43 
11 Pria Sub-urban 45 
12 Pria Sub-urban 35 
13 Pria Rural 87 
14 Pria Rural 84 
15 Pria Rural 76 
16 Pria Rural 99 
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17 Pria Rural 45 
18 Pria Rural 76 
19 Wanita Urban 68 
20 Wanita Sub-urban 87 
21 Wanita Sub-urban 53 
22 Wanita Sub-urban 76 
23 Wanita Sub-urban 66 
24 Wanita Sub-urban 67 
25 Wanita Sub-urban 65 
26 Wanita Sub-urban 65 
27 Wanita Sub-urban 66 
28 Wanita Sub-urban 56 
29 Wanita Sub-urban 66 
30 Wanita Sub-urban 67 
31 Wanita Sub-urban 66 
32 Wanita Sub-urban 56 
33 Wanita Sub-urban 66 
34 Wanita Sub-urban 55 
35 Wanita Rural 55 
36 Wanita Rural 76 
37 Wanita Rural 66 
38 Wanita Rural 86 
39 Wanita Rural 65 
40 Wanita Rural 70 

 

Ujilah hipotesis bahwa ada pengaruh gender dan letak 

geografis terhadap hasil belajar IPA. Berikut adalah langkah-

langkah untuk menjawab permasalahan pada contoh di atas: 
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1. Buat data baru, lalu klik tab Variabel View 

2. Kita definisikan tiga variabel. 

Untuk variabel pertama, kita buat dengan ketentuan 

sebagai berikut: Pada kolom Name isi dengan gender, 

Type: Numeric, Width: 8, Decimal: 0, Label: Gender. 

Pada kolom Values, klik tanda elipsis lalu isikan value 

sebagai berikut: Value : 1; Label : Pria; dan Value : 2; 

Label : Wanita. Pada kolom Missing: None, Columns: 8, 

Align: Right, Measure: Nominal, Role: Input. 

 

 
Gambar 8.1  Pengaturan variabel Gender. 

 

Untuk variabel kedua, kita buat dengan ketentuan 

sebagai berikut: Pada kolom Name isi dengan letak, 
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Type: Numeric, Width: 8, Decimal: 0, Label: Letak 

Geografis. Pada kolom Values, klik tanda elipsis lalu 

isikan value sebagai berikut: Value : 1; Label : urban; 

Value : 2; Label : suburban; dan Value : 3; Label : rural. 

Pada kolom Missing: None, Columns: 8, Align: Right, 

Measure: Nominal, Role: Input. 

 

 
Gambar 8.2  Pengaturan variabel Letak. 

 

Untuk variabel ketiga, kita buat dengan ketentuan 

sebagai berikut: Pada kolom Name isi dengan nilai, 

Type: Numeric, Width: 8, Decimal: 0, Label: Nilai 

Ujian; Values: None; Missing: None, Columns: 8, Align: 

Right, Measure: Scale, Role: Input. 
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Gambar 8.3  Pendefinisian variabel. 

 

3. Buka tab Data View, lalu masukan data pada tabel di 

atas dengan terlebih dahulu melakukan penyesuaian 

value-nya. Akan lebih mudah jika kita menggunakan 

fasilitas Replace pada Microsoft Excel. 

 

 
Gambar 8.4  Input data 
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4. Klik menu Analyze → General Linear Model → 

Univariate. Pada jendela yang ditampilkan, masukkan 

variabel Nilai Tes [nilai] ke kotak Dependent 

Variable. Sementara variabel Gender [gender] dan 

Letak Geografis [letak] ke kotak Fixed factor(s). 

 

 
Gambar 8.5  Pengaturan parameter Univariate. 
 

5. Klik tombol Plot. Pada jendela yang ditampilkan, 

masukkan variabel gender  ke kotak Horizontal Axis 

dan letak ke kotak Separate Lines. 



8 – Two-Way Anova 

124 

 
Gambar 8.6  Pengaturan parameter Plots. 

 

Lalu klik Add. 

 

 
Gambar 8.7  Parameter Plots. 
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Klik tombol Continue. 

6. Klik tombol Post Hoc. Pada kotak dialog yang 

ditampilkan, masukkan variabel letak ke kotak Post 

Hoc Test for dan beri tanda centang pada Tukey di 

dalam kotak Equal Variances Assumed. 

 

 
Gambar 8.8  Pengaturan uji Post Hoc 
 

Klik tombol Continue. 

7. Klik tombol Options.  
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Pada jendela yang ditampilkan, masukkan variabel 

gender, letak, dan gender*letak ke dalam kotak 

Display Means for. Di bagian Display beri tanda 

centang pada Descriptive statistics dan 

Homogentity test. 

 

 
Gambar 8.9  Pengaturan Options. 

 

Klik tombol Continue. 
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8. Klik tombol OK. Akan ditampilkan output SPSS 

9. Interpretasi output SPSS 

Tabel Descriptive Statistics 

 

 
Gambar 8.10 Tabel Descriptive Statistics. 

 

Dari tabel di atas, kita bisa menilai rata-rata nilai tes 

berdasarkan gender dan letak geografis. Sebagai 

contoh: nilai rata-rata ujian pria yang berada di area 

urban sebesar  32.43 sedangkan nilai ujian wanita yang 

berada di area sub-urban sebesar 65.13 dan begitu 

seterusnya. 
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Asumsi Homogenitas: Levene Test 

Di bawah ini adalah Tabel Levene’s Test. Digunakan 

untuk menilai homogenitas tiap variabel. 

 

 
Gambar 8.11 Tabel Levene's Test of Equality of Error

Variances. 
 

Tabel dii atas menunjukkan nilai (Signifikansi) Sig. 

0.527. Karena nilai Sig >  bisa dikatakan varian antar 

grup berbeda secara signifikan. 

 

Output Two-Ways ANOVA dengan SPSS 

Tabel di bawah ini menunjukkan hasil dari uji Two-Ways 

Anova: 
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Gambar 8.12 Tabel Tests of Between-Subjects Effects. 

 

Dari tabel di atas, kita mendapatkan nilai-nilai penting 

yang bisa disimpulkan sebagai berikut: 

  

Corrected Model: 

Pengaruh semua variabel independen (Gender, Letak 

Geografis dan interaksi Gender dengan Letak 

Geografis atau “gender*letak”) secara bersama-

sama terhadap variabel dependen (Nilai Tes). 

Apabila nilai Sig. <  maka pengaruh tersebut 

signifikan. Pada tabel di atas, nilai Sig = 0.000 berarti 

model valid. 

 

Intercept: 

Nilai perubahan variabel dependen tanpa perlu 

dipengaruhi keberadaan variabel independen, artinya 
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tanpa ada pengaruh variabel independen, variabel 

dependen dapat berubah nilainya. Apabila nilai Sig. 

<  maka pengaruh tersebut signifikan. Pada tabel di 

atas, nilai Sig = 0.000 berarti intercept signifikan. 

 

GGender: 

Pengaruh gender terhadap Nilai Tes di dalam model. 

Apabila nilai Sig. <  maka pengaruh tersebut 

signifikan. Pada tabel di atas, nilai Sig = 0.005 berarti 

gender berpengaruh signifikan. 

 

Letak Geografis: 

Pengaruh letak geografis terhadap nilai tes di dalam 

model. Apabila nilai Sig. <  maka pengaruh tersebut 

signifikan. Pada tabel di atas, nilai Sig. = 0.000 

berarti letak geografis berpengaruh signifikan. 

 

Gender*Letak: 

Pengaruh Gender*Letak terhadap nilai tes di dalam 

model. Apabila nilai Sig. <  maka pengaruh tersebut 

signifikan. Pada tabel di atas, nilai Sig. = 0.005 

berarti gender*letak berpengaruh signifikan. 
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EError: 

Semakin kecil maka model semakin baik. 

 

R Squared: 

Nilai determinasi berganda semua variabel 

independen dengan dependen. Pada tabel di atas 

nilai R-Squared sebesar 0.668 di mana mendekati 1, 

berarti korelasi kuat. 

 

Kesimpulan Hipotesis Two-Ways ANOVA 

Dari 7 kesimpulan di atas, dalam uji Two-Ways Anova, 

poin 1, 3, 4 dan 5 adalah yang terpenting (tanpa 

mengabaikan yang lain). Oleh karena hasil uji F 

menunjukkan bahwa signifikan ada perbedaan atau 

menerima Ha, maka selayaknya Uji ANOVA 

dilanjutkan ke tahap selanjutnya, yaitu Uji Post Hoc. 

 

Post Hoc Test 

Uji post hoc adalah uji lanjut atau uji yang menilai 

adanya perbedaan signifikan antar kelompok. 

 

Tabel Tukey Post Hoc 

Tabel di bawah ini adalah Tabel Tukey Post Hoc yang 

digunakan untuk menilai kategori manakah dari 
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variabel letak geografis yang memiliki perbedaan 

signifikan: 

 

 
Gambar 8.13 Tabel Multiple Comparisons. 

 

Yang ada perbedaan signifikan ditandai dengan 

tanda bintang (*). Dari tabel di atas, semuanya 

ditandai dengan bintang, berarti  semuanya ada 

perbedaan yang signifikan. 

 

Diagram Plot 

Diagram plot di bawah ini berguna untuk menilai 

apakah ada interaksi efek antar variabel. Namun 

diagram ini tidak bisa dijadikan bahan acuan yang 

valid. Tetapi hanya sekedar memberikan gambaran 

saja. Apabila garis-garis tidak menunjukkan 

kesejajaran, maka dicurigai ada efek interaksi. 
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Gambar 8.14 Diagram Plot Mean Pasca Uji ANOVA. 

 

Diagram di atas menunjukkan ada ketidak-sejajaran 

garis, maka dicurigai ada efek interaksi. 

 

LLATIHAN 

Seorang guru ingin mengetahui prestasi belajar siswa 

berdasarkan gender (laki-laki dan perempuan) setelah 

menerapkan model pembelajaran kooperatif pada materi 
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yang sama. Sampel yang diambil 3 sekolah, di mana ketiga 

sekolah tersebut diterapkan model pembelajaran yang 

berbeda. Berikut hasil tes belajarnya: 

 

Jenis Kelamin 
Nama Sekolah 

Sekolah A Sekolah B Sekolah C 

Laki-Laki 

60 70 80 
40 60 60 
70 80 90 
50 70 80 
50 80 90 
60 60 80 
80 70 70 

Perempuan 

70 70 70 
40 80 90 
60 60 80 
70 70 100 
80 60 90 
60 50 90 
50 70 70 

Gunakan taraf signifikansi 5% untuk menguji apakah 

metode pembelajaran kooperatif memberikan pengaruh 

terhadap prestasi belajar apabila ditinjau dari gender dan 

lokasi sekolahnya. 
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Perhatikan bahwa, sebelum tabel tersebut dapat dianalisis 

menggunakan SPSS, kita perlu mengubah tabel tersebut 

menjadi hubungan rasional. Pertama, kita perlu membuat 

pasangan terurut antara jenis kelamin, nama sekolah, dan 

skor. Pasangan terurut ini kemudian dituliskan ke dalam 

tabel dengan format sebagai berikut: 

 

No. Jenis Kelamin Nama Sekolah Skor 
    

Sebagai contoh, pada baris pertama kita isi dengan 

pasangan (1, Laki-laki, Sekolah A, 60). Pada baris kedua 

kita isi dengan pasangan (2, Laki-laki, Sekolah A, 40), dan 

seterusnya sehingga kita akan mendapatkan tabel 

sebanyak 52 baris. 

 

No. Jenis Kelamin Nama Sekolah Skor 
1 Laki-laki Sekolah A 60 
2 Laki-laki Sekolah A 40 
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99 

UJI KOMPARATIF NON 
PARAMETRIK SAMPEL 

INDEPENDEN 
 

 

9.1 Pengantar 

Pada bab-bab sebelumnya, teknik pengujian yang 

dilakukan mensyaratkan sejumlah asumsi yang harus 

dipenuhi terutama berkaitan dengan distribusi samplingnya 

(misal: normal dan homogen), atau jenis datanya (misal: 

skala dan nominal). Kita mengenal teknik tersebut dengan 

nama statistik parametrik.  

Sebaliknya, pengujian dengan statistik non parametrik 

merupakan pengujian yang tidak membutuhkan asumsi 

mengenai bentuk distribusi sampling statistika dan atau 

bentuk distribusi populasinya. Pengujian non parametrik tidak 

menuntut: sampel yang diambil harus terdistribusi normal dan 

angka-angka sampel merupakan ukuran-ukuran tingkat taraf 

tinggi. 
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Metode statistik non parametrik merupakan metode 

statistik yang dapat digunakan dengan mengabaikan segala 

asumsi yang melandasi metode statistik parametrik, terutama 

yang berkaitan dengan distribusi normal. Uji statistik non 

parametrik yang akan dipelajari pada bagian ini adalah uji 

komparatif dua sampel independen dengan Chi-Square Test 

untuk data berupa kategori dan Mann Whitney U Test untuk 

data berupa nominal atau skala. 

 

99.2 Uji Chi-Square 

Metode Chi-Square ( 2) digunakan untuk mengadakan 

pendekatan (mengestimasi) dari beberapa faktor atau 

mengevaluasi frekuensi yang diselidiki atau frekuensi hasil 

observasi (fo) dengan frekuensi yang diharapkan (fh) dari 

sampel apakah terdapat hubungan atau perbedaan yang 

signifikan atau tidak. Untuk mengatasi permasalahan seperti 

ini, maka perlu diadakan teknik pengujian yang dinamakan 

pengujian Chi-Square. 

Uji Chi-Square digunakan apabila data berbentuk 

kategori atau hasil transformasi ke dalam bentuk kategori. 

Prosedur uji Chi-Square dilakukan dengan mentabulasi suatu 

variabel ke dalam kategori-kategori dan melakukan uji 

hipotesis bahwa frekuensi yang diamati tidak berbeda dengan 

nilai yang diharapkan. Kita mulai dengan contoh berikut: 
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Contoh 9.1 

Seorang peneliti melakukan penelitian tentang 

pelaksanaan Proyek Penguatan Profil Pelajar Pancasila, 

khususnya pada profil disiplin. Penelitian dilakukan di 

tiga Sekolah Dasar (SD) yaitu SD 1, SD 2, dan SD 3 yang 

melibatkan sebanyak 725 siswa dengan distribusi: SD 1 

= 275 siswa; SD 2 = 250; dan SD 3 = 200 siswa. 

Instrumen pengukuran kualitas disiplin telah disusun 

dengan satu mekanisme tertentu sehingga memberikan 

skor kedisiplinan yang diklasifikasikan ke dalam 3 (tiga) 

level disiplin, yaitu: tinggi, sedang, dan rendah. Setelah 

dilakukan pengukuran, peneliti melakukan tabulasi 

frekuensi berdasarkan ketiga kriteria tersebut. Berikut 

adalah hasil tabulasi tersebut. 

 

Nama 
Sekolah 

Kualitas Disiplin 
Total Tinggi 

(100 – 85) 
Sedang 

(84 – 66) 
Rendah 
(65 – 0) 

SD 1 150 75 50 275 
SD 2 75 150 25 250 
SD 3 150 25 25 200 
Jumlah 375 250 100 725 

 

Lakukan analisis untuk memeriksa apakah ada 

perbedaan kualitas pelaksanaan disiplin di ketiga SD 

tersebut. Gunakan taraf signifikansi sebesar 5%. 
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Secara umum terdapat dua tahap untuk menyelesaikan 

masalah tersebut, yaitu: pembobotan dan analisis Chi-Square. 

Berikut adalah langkah-langkah setiap tahap penyelesaian 

masalah di atas. 

 

LLangkah 1: memberi bobot data 

1. Buat data baru, lalu klik tab Variable View. 

2. Definisikan dua variabel. Untuk variabel pertama, pada 

kolom Name isi dengan tingkat, Type: Numeric, Width: 

8, Decimal: 0, Label: Tingkat Kedisiplinan, Values: 

None, Missing: None, Columns: 8, Align: Right, Measure: 

Nominal, Role: Input. Untuk variabel kedua, pada 

kolom Name isi dengan jumlah, Type: Numeric, Width: 8, 

Decimal: 0, Label: Banyak Siswa, Values: None, 

Missing: None, Columns: 8, Align: Right, Measure: 

Scale, Role: Input. 

 

 
Gambar 9.1 Pendefinisian Variabel. 
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3. Buka tab Data View, masukkan data yang akan 

dianalisis sebagaimana Gambar 9.2 dengan ketentuan 

pada kolom tingkat diisi 1 bila kategori Tinggi, 2 bila 

Sedang, dan 3 bila Rendah. 

 

 
Gambar 9.2 Input data. 
 

4. Klik menu Data → Weight Cases 

5. Pada kotak dialog yang ditampilkan, pilih Weight cases 

by pada bagian sebelah kanan. Pada kolom di sebelah 

kiri, pilih/klik Banyak Siswa [jumlah] lalu klik tanda 

panah ke kanan sehingga variabel Banyak Siswa 

berpindah ke kotak Frequency Variable. 
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Gambar 9.3 Pemberian bobot. 
 

Kemudian klik tombol OK. 

 

LLangkah 2: Analisis Chi-Square 

6. Klik Analyze → Nonparametric Test → Legacy Dialogs 

→ Chi Square. 

7. Pada kotak dialog yang ditampilkan, pilih variabel 

Tingkat Kedisiplinan lalu klik tanda panah ke kanan 

sehingga variabel ini berpindah ke Test Variable List. 
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Gambar 9.4 Pengaturan parameter uji Chi-Square. 
 

8. Klik tombol OK sehingga ditampilkan output SPSS 

9. Interpretasi hasil uji Chi-Square 
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HHasil Analisis Chi Square Test 

 

 
Gambar 9.5 Tabel uji statistik pada Chi-Square. 

 

Hipotesis Penelitian: 

H0 : Tidak terdapat perbedaan kualitas pelaksanaan 

disiplin antara siswa SD 1, SD 2, dan SD 3. 

Ha : Terdapat perbedaan kualitas pelaksanaan 

disiplin antara siswa SD 1, SD 2, dan SD 3. 

Ketentuan penerimaan/penolakan: 

Jika nilai Asymp. Sig. >  maka H0 diterima. 

Jika nilai Asymp. Sig. <  maka H0 ditolak. 

Berdasarkan tabel di atas dengan tingkat kepercayaan 

 = 5%, terlihat nilai Asymp. Sig. = 0.000 < , 

sehingga H0 ditolak. 

Jadi, terdapat perbedaan tingkat kedisiplinan yang 

signifikan antara siswa SD 1, SD 2, dan SD 3. 
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99.3 Uji Mann Whitney 

Uji Mann Whitney pada hakikatnya sama dengan uji 

Independent Sample T Test dengan persyaratan yang lebih 

longgar. Ada dua kelonggaran prasyarat yaitu: mampu 

digunakan untuk tipe data ordinal dan tidak mensyaratkan 

distribusi tertentu (normal). Uji Mann-Whitney/Wilcoxon 

merupakan alternatif bagi uji-t. Uji Mann Whitney digunakan 

untuk membandingkan dua mean populasi yang berasal dari 

populasi yang sama. Uji Mann-Whitney juga digunakan untuk 

menguji apakah dua mean populasi sama atau tidak. 

 

Contoh 9.2 

Seorang peneliti ingin mengetahui, apakah terdapat 

perbedaan nilai tes siswa yang diajar dengan metode A 

dan yang diajar dengan metode B. Berikut datanya. 

Nilai tes siswa yang diajar dengan metode A : 56, 70, 

57, 58, 45, 37, 69, 67, 60 

Nilai tes siswa yang diajar dengan metode B : 75, 59, 

27, 91 

Gunakan  = 5 %. 

 

Berikut adalah langkah-langkah penyelesaian dengan 

SPSS. 

1. Buat data baru, lalu klik tab Variable View 
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2. Definisikan dua variabel 

Ketentuan variabel pertama: Pada kolom Name isi 

dengan nilai, Type: Numeric, Width: 8, Decimal: 0, 

Label: Nilai Tes, Values : None, Missing: None, 

Columns: 8, Align: Right, Measure: Scale, Role: Input. 

Ketentuan variabel kedua: Pada kolom Name isi dengan 

metode, Type: Numeric, Width: 8, Decimal: 0, Label: 

Metode. Pada kolom Values, klik tanda elipsis lalu 

isikan value sebagai berikut: Value : 1, Label : Metode 

A; dan Value : 2; Label : Metode B. Pada kolom Missing: 

None, Columns: 8, Align: Right, Measure: Nominal, Role: 

Input. 

 

 
Gambar 9.6 Pendefinisian value untuk variabel metode. 
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Gambar 9.7 Daftar variabel yang digunakan. 
 

3. Klik tab Data View. Masukkan data di atas dengan 

ketentuan semua nilai dari siswa yang menggunakan 

metode A ditulis dengan 1 pada kolom metode dan 

metode B ditulis dengan 2. 

 

 
Gambar 9.8 Input data. 
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4. Klik menu Analyze → Nonparametric Test → Legacy 

Dialogs → 2 Independent Samples 

5. Pada kotak dialog yang ditampilkan, pilih variabel 

Nilai Tes [nilai] lalu klik tanda panah ke kanan 

sehingga variabel ini berpindah ke Test Variable List 

di sebelah kanan. Klik juga variabel Metode [metode] 

lalu klik tanda panah ke kanan di bawah tanda panah 

sebelumnya sehingga variabel ini berpindah ke kolom 

Grouping Variable. 

 

 
Gambar 9.9 Memilih variabel. 
 

6. Klik tombol Define Groups. 
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7. Pada kotak dialog yang ditampilkan isikan 1 pada Group 

1 dan 2 pada Group 2. 

 

 
Gambar 9.10 Menentukan pembagian grup. 

 

Klik tombol Continue untuk kembali ke kotak dialog Two 

Independent Samples Test. 

8. Pada kolom Test Type beri tanda centang pada Mann-

Whitney U 

9. Klik tombol OK sehingga ditampilkan output SPSS 

10. Interpretasi hasil uji Mann-Whitney 

TTabel Rank 

 

 
Gambar 9.11 Output tabel Rank. 
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Tabel di atas menunjukkan hasil pemeringkatan 

keseluruhan nilai yang diberi angka sesuai dengan 

peringkatnya. Terlihat, nilai siswa yang menggunakan 

metode A memiliki nilai rata-rata peringkat sebesar 

6.44 dan metode B sebesar 8.25. Secara sederhana kita 

dapat mengatakan bahwa peringkat nilai siswa yang 

menggunakan metode A lebih baik dari pada siswa 

yang menggunakan metode B. 

 

SStatistik Uji Mann-Whitney 

 

 
Gambar 9.12 Tabel Statistik Uji Mann-Whitney. 

 

Hipotesis Penelitian: 

H0 : Tidak ada perbedaan nilai tes siswa yang diajar 

dengan metode A dan yang diajar dengan 

metode B 
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Ha : Ada perbedaan nilai tes siswa yang diajar 

dengan metode A dan yang diajar dengan 

metode B 

Ketentuan penerimaan/penolakan: 

Jika nilai Asymp. Sig. >  maka H0 diterima. 

Jika nilai Asymp. Sig. <  maka H0 ditolak. 

 

Berdasarkan tabel di atas dengan tingkat kepercayaan 

 = 5%, terlihat nilai Asymp. Sig. = 0.440 < , 

sehingga H0 diterima. Jadi, terdapat tidak ada 

perbedaan nilai tes siswa yang diajar dengan metode A 

dan yang diajar dengan metode B. 

 

LLATIHAN -- 1 

Seorang peneliti melakukan penelitian tentang 

pelaksanaan Proyek Penguatan Profil Pelajar Pancasila, 

khususnya pada profil disiplin. Penelitian dilakukan di tiga 

Sekolah Dasar (SD) yaitu SD 1, SD 2, dan SD 3 yang 

melibatkan sebanyak 625 siswa dengan distribusi: SD 1 = 

225 siswa; SD 2 = 225; dan SD 3 = 175 siswa. Instrumen 

pengukuran kualitas disiplin telah disusun dengan satu 

mekanisme tertentu sehingga memberikan skor 
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kedisiplinan yang diklasifikasikan ke dalam 3 (tiga) level 

disiplin, yaitu: tinggi, sedang, dan rendah. Setelah 

dilakukan pengukuran, peneliti melakukan tabulasi 

frekuensi berdasarkan ketiga kriteria tersebut. Berikut 

adalah hasil tabulasi tersebut. 

 

Nama 
Sekolah 

Kualitas Disiplin 
Total Tinggi 

(100 – 85) 
Sedang 

(84 – 66) 
Rendah 
(65 – 0) 

SD 1 100 75 50 225 
SD 2 50 150 25 225 
SD 3 125 25 25 175 
Jumlah 275 250 100 625 

 

 

LLATIHAN -- 2 

Seorang peneliti ingin mengetahui, apakah terdapat 

perbedaan nilai tes siswa yang diajar dengan metode A dan 

yang diajar dengan metode B. Berikut datanya. 

Nilai tes siswa yang diajar dengan metode A : 76, 50, 87, 

78, 55, 67, 63, 67, 60 

Nilai tes siswa yang diajar dengan metode B : 45, 59, 37, 

81, 65 

Gunakan  = 5 %. 
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110 

UJI KOMPARATIF NON 
PARAMETRIK SAMPEL 

DEPENDEN 
 

 

10.1 Pengantar 

Pada BAB 9, kita sudah mempraktikkan cara melakukan 

analisis data menggunakan SPSS untuk membandingkan dua 

kelompok data yang independen dengan teknik analisis 

statistika non parametrik. Pada bagian ini, kita akan melihat 

bagaimana apabila kedua kelompok data yang kita analisis 

berasal dari subjek yang berkaitan atau dependen. Kita akan 

mencoba melakukan analisis tersebut dengan teknik 

McNemar, Sign Test, dan Uji Wilcoxon. 

 

10.2 Uji McNemar 

Uji McNemar adalah salah satu pengujian dalam 

statistik yang dikenal dalam penelitian dan berperan dalam 

pengambilan keputusan. Bila Anda menggunakan penelitian 
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yang melibatkan data nominal, maka pengujian ini harus 

Anda kuasai! 

Analisis ini biasanya digunakan untuk pengukuran 

statistik non parametrik yaitu untuk data nominal 

berpasangan untuk kasus dua variabel. 

Uji McNemar merupakan pengujian statistik yang 

digunakan untuk menentukan apakah terdapat perbedaan 

yang signifikan antara variabel dependen atau saling 

berpasangan antara 2 kelompok terkait. 

Salah satu contoh yang paling umum adalah kondisi 

“sebelum” dan “sesudah” sebuah perlakuan atau treatment. 

Sebagai contoh penggunaan, uji ini dapat digunakan untuk 

mengetahui efektivitas perlakukan terhadap kecenderungan 

pemilih pada saat Pilkada. Tes ini kadang disebut sebagai Uji 

Chi-Square McNemar karena pengujiannya memiliki 

distribusi Chi-Square. 

Secara umum terdapat empat asumsi Uji McNemar: 

1. Memiliki satu variabel dependen dengan sifat dikotomi 

dan satu variabel Independent kategoris dengan dua 

kelompok terkait. Contoh variabel dikotomi seperti 

“aman dan tidak aman” atau “lulus dan gagal”. 

2. Kedua kelompok variabel harus saling eksklusif atau 

tidak ada yang timpang tindih. Sederhananya, data 

atau peserta pada satu kelompok hanya bisa berada di 
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salah satu dari dua kelompok dan tidak bisa berada di 

kelompok lain di waktu yang bersamaan. 

3. Sampel bersifat acak dari populasi yang sesuai 

4. Skala data yang digunakan adalah nominal atau 

ordinal 

Jika data Anda tidak memenuhi keempat asumsi ini, 

ada baiknya untuk mempertimbangkan melakukan pengujian 

lain untuk data Anda seperti Uji Chi-Square biasa. 

Pada umumnya uji McNemar ini digunakan untuk 

mengukur sebelum dan sesudah diberikan suatu perlakuan 

pada sampel tersebut, bentuk isian data hanya ada dua 

pilihan yaitu "Ya" atau "Tidak", "suka" atau "tidak suka", 

"Berminat" atau "tidak berminat" dan lain sebagainya, bentuk 

isiannya di berikan pengodean dari masing-masing 

pemilihan yaitu 1 atau 2, contoh: 1=Ya, dan 2= tidak. 

 

Contoh 10.1: 

Mahasiswa program studi A ingin menilai kinerja 

terhadap ketua himpunan selama ketua himpunannya 

masih menjabat sebagai ketua himpunan pada 

program studi tersebut. Sampel diambil sebanyak 20 

mahasiswa untuk menilai sebelum dan sesudah 

terpilihnya ketua himpunan. Data yang digunakan 
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berbentuk skala nominal yaitu: suka atau tidak suka. 

Berikut hasil survei dari 20 mahasiswa tersebut. 

 

No Nama Penilai Sebelum Sesudah 

1 Aini Suka Tidak suka 
2 Udin Suka Tidak suka 
3 Zuhra Suka Tidak suka 
4 Rudi Tidak suka Suka 
5 Susi Suka Suka 
6 Vera Suka Suka 
7 Roby Tidak suka Tidak suka 
8 Ihsan Suka Suka 
9 Rival Suka Suka 

10 Fitria Suka Suka 
11 Hengky Suka Tidak suka 
12 Husnul Tidak suka Tidak suka 
13 Idami Tidak suka Suka 
14 Putra Suka Suka 
15 Randy Suka Suka 
16 Rahmi Tidak suka Tidak suka 
17 Melani Suka Tidak suka 
18 Amelia Tidak suka Tidak suka 
19  Tidak suka Suka 
20 Fauzy Suka Suka 

 

Sebelum data di atas dianalisis lebih lanjut, jadi kita 

tentukan dulu hipotesis yang akan di uji: 
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HHipotesis penelitian 

H0 : Tidak berbeda secara nyata sikap pemilih 

terhadap penilaian kinerja ketua himpunan 

sebelum dipilih dan sesudah dipilih 

Ha : Berbeda secara nyata sikap pemilih terhadap 

penilaian kinerja ketua himpunan sebelum 

dipilih dan sesudah dipilih 

 

Kriteria Pengujian Statistik: 

Jika 2
hitung < 2

tabel dan nilai Sig. > 0.05 maka H0 

diterima 

Jika 2
hitung > 2

tabel dan nilai Sig. < 0.05 Maka H0 

ditolak 

 

Langkah-langkah menggunakan SPSS: 

1. Buat data baru, lalu klik tab Variabel View 

2. Definisikan dua variabel 

Ketentuan variabel pertama: Pada kolom Name isi 

dengan sebelum, Type: Numeric, Width: 8, Decimal: 0, 

Label: Sebelum Dipilih. Pada kolom Values, klik tanda 

elipsis lalu isikan value sebagai berikut: Value : 1, Label 

: Suka; dan Value : 2; Label : Tidak Suka. Pada kolom 

Missing: None, Columns: 8, Align: Right, Measure: 

Nominal, Role: Input. 
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Ketentuan variabel kedua: Pada kolom Name isi dengan 

sesudah, Type: Numeric, Width: 8, Decimal: 0, Label: 

Sesudah Dipilih. Pada kolom Values, klik tanda elipsis 

lalu isikan value sebagai berikut: Value : 1, Label : 

Suka; dan Value : 2; Label : Tidak Suka. 

 

 
Gambar 10.1 Penentuan values variabel sebelum

dan sesudah. 
 

Pada kolom Missing: None, Columns: 8, Align: Right, 

Measure: Nominal, Role: Input. 
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Gambar 10.2 Pendefinisian variabel. 
 

3. Kita isi variabel dari data di atas. Akan tetapi pada 

kolom sebelum dan sesudah tidak diisi dengan ‘Suka’ 

atau ‘Tidak Suka’ melainkan menggantinya dengan 

angka 1 atau 2. 

 

 
Gambar 10.3 Pengisian data. 
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4. Klik menu Analyze →  Nonparametric Tests  →  Legacy 

Dialogs →  2 Related Samples sehingga muncul kotak 

Two-Relates-Samples Tests. 

5. Pada kotak dialog yang ditampilkan, klik variabel  

Sebelum dipilih [sebelum] (kotak sebelah kiri) lalu klik 

tombol panah ke kanan. Lakukan hal yang sama pada 

variabel Sesudah dipilih [sesudah] sehingga kedua 

variabel sekarang berada di kotak sebelah kanan 

dengan posisi di baris pertama (Pair 1), kolom 

Variable1 berisi variabel Sebelum dipilih [sebelum] 

dan  kolom Variable2 berisi variabel Sesudah dipilih 

[sesudah]. Selanjutnya pada Test Type centang 

McNemar. 

 

 
Gambar 10.4 Pemilihan pasangan variabel. 
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6. Klik tombol OK sehingga ditampilkan output SPSS 

7. Interpretasi output SPSS 

AAnalisis Hasil 

 
Gambar 10.5 Tabel Test Statistics. 

 

Pada tabel di atas, tidak tercantum nilai 2
hitung. Jadi 

sebelum diambil keputusan dari kasus di atas kita cari 

terlebih dahulu nilai 2
hitung dengan menggunakan 

rumus berikut: 

 

2
hitung

b c 1

b c
 

Gambar 10.6 Rumus menentukan Zhitung. 
 

Keterangan:  
Z = luas di bawah kurva normal 
b dan c = nilai pada tabel kontingensi atau 
kekonsistenan yang tidak sama dalam pemilihan 
sebelum dan sesudah. 
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Gambar 10.7 Tabel Crosstabs. 
  

Dari tabel di atas terlihat bahwa sebelum dipilih dan 

sesudah dipilih sikap pemilih yang menjawab suka 

hanya tinggal 8 orang, sedangkan pemilih yang 

berubah pikiran  sebelum dan sesudah dari suka 

menjadi tidak suka ada 5 orang. 

Sikap pemilih yang sebelumnya menjawab tidak suka 

dan setelah dipilih menjawab suka ada 3 orang. Jadi 

nilai yang dimasukkan ke dalam rumus 2 yaitu nilai 5 

dan 3, berikut ini cara mencari nilai 2
hitung: 

 

2
hitung

b c 1 5 3 1 1 1
0.354

2.828b c 5 3 8
 

Gambar 10.8 Menentukan nilai 2
hitung. 

 

Selanjutnya mencari nilai 2
tabel (tabel distribusi 2) 

dengan taraf kepercayaan 5%. Untuk menentukan df 

(degree of freedom, atau derajat kebebasan) digunakan 

rumus =( −1)×( −1) di mana r = jumlah baris dan 

c = jumlah kolom. Untuk tabel 2 x 2 maka df = (2-1) x 
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(2-1) = 1. Dengan demikian, berdasarkan tabel 

distribusi 2 diperoleh nilai 2
hitung = 3.841. 

Dari hasil perhitungan, diperoleh bahwa 2
hitung < 2

tabel. 

Selain itu, nilai Sig. = 0.727 > 0.05. berdasarkan 

ketentuan, maka H0 diterima. 

 

KKesimpulan: 

Karena H0 diterima, maka disimpulkan bahwa sikap 

pemilih terhadap penilaian kinerja ketua himpunan 

sebelum dan sesudah dipilih tidak menunjukkan 

perbedaan secara nyata. Atau dalam artian lain selama 

menjabat sebagai ketua himpunan kepercayaan 

mahasiswa berkurang dikarenakan mungkin saja 

kinerjanya yang kurang baik. 

 

10.3 Uji Tanda (Sign Test) 

Salah satu jenis uji statistik non parametrik yang cukup 

populer digunakan oleh peneliti untuk melakukan penelitian 

adalah uji Tanda atau Sign Test. Nama uji Tanda itu sendiri 

diberikan karena pada kenyataannya bahwa tes ini 

menggunakan tanda tambah (+) dan kurang (-), dan bukan 

ukuran-ukuran kuantitatif sebagai datanya (Siegel, 1997). 

Metode Sign Test dilakukan untuk menguji komparatif 

dua sambil yang berpasangan (dependent) dengan data 
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berjenis ordinal. Tes ini sering kali digunakan terutama untuk 

penelitian di mana pengukuran kuantitatif tidak mungkin atau 

tidak dapat dijalankan, tetapi masih memungkinkan untuk 

menentukan tingkatan bagi kedua anggota setiap pasangan 

berdasarkan hubungan antara keduanya. Oleh karena itu, 

Sign Test biasa dipakai untuk data bertipe ordinal. 

 

Contoh 10.2 

Seorang guru ingin mengetahui apakah ada perbedaan 

antara nilai ujian seorang siswa pada mata ajar 

tertentu, jika ia belajar sendirian dan jika ia belajar 

berkelompok. Untuk itu, diadakan dua kali uji mata 

ajar, pertama siswa belajar sendiri-sendiri dan yang 

kedua sebelum ujian siswa dapat dengan bebas belajar 

secara berkelompok. Berikut hasil nilai keduanya 

(angka dalam rentang nilai sampai 100). 

 

NNo  SSendiri  KKelompok  

1 80 78 
2 82 85 
3 84 82 
4 86 78 
5 80 84 
6 84 89 
7 83 83 
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8 81 81 
9 82 90 

10 80 78 
11 83 85 
12 84 82 
13 82 86 
14 81 91 
15 80 80 
16 79 89 
17 75 79 

 

Hipotesis untuk permasalahan di atas dirumuskan 

sebagai berikut : 

H0 : Tidak  ada  perbedaan  nilai  siswa  jika  ia  

belajar  sendiri  dengan  jika  ia  belajar 

berkelompok 

Ha : Ada perbedaan nilai siswa jika ia belajar sendiri 

dengan jika ia belajar berkelompok 

  

Kriteria Pengujian Statistik: 

Jika nilai Sig. > 0.05 maka H0 diterima 

Jika nilai Sig. < 0.05 maka H0 ditolak 

 

Langkah-langkah menggunakan SPSS: 

1. Buat data baru, lalu klik tab Variabel View 

2. Definisikan dua variabel 
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Ketentuan variabel pertama: Pada kolom Name isi 

dengan sendiri, Type: Numeric, Width: 8, Decimal: 0, 

Label: Sendiri, Values: None, Missing: None, Columns: 

8, Align: Right, Measure: Scale, Role: Input. 

Ketentuan variabel kedua: Pada kolom Name isi dengan 

kelompok, Type: Numeric, Width: 8, Decimal: 0, Label: 

Kelompok, Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Scale, Role: Input. 

 

 
Gambar 10.9 Pendefinisian variabel. 
 

3. Kita isi variabel dari data di atas seperti biasa. Anda bisa 

menggunakan Salin (CTRL+C) dan Tempel (CTRL+V) atau 

menuliskan ulang secara manual. 
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Gambar 10.10 Pengisian data. 
 

4. Klik menu Analyze →  Nonparametric Tests  →  Legacy 

Dialogs →  2 Related Samples. 

5. Pada kotak dialog yang ditampilkan, klik variabel  

Sendiri [sendiri] (kotak sebelah kiri) lalu klik tombol 

panah ke kanan. Lakukan hal yang sama pada variabel 

Kelompok [kelompok] sehingga kedua variabel 

sekarang berada di kotak sebelah kanan dengan posisi 

di baris pertama (Pair 1), kolom Variable1 berisi 

variabel Sendiri [sendiri] dan  kolom Variable2 

berisi variabel Kelompok [kelompok]. Selanjutnya pada 

Test Type centang Sign. 
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Gambar 10.11 Pengaturan variabel dan jenis tes. 
 

6. Klik tombol Options. Pada bagian Statistics beri 

centang kotak Descriptive. 

 

 
Gambar 10.12 Opsi memunculkan statistik deskriptif. 
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Klik tombol Continue. 

7. Klik tombol OK sehingga ditampilkan output SPSS 

8. Interpretasi output SPSS 

Hasil Analisis dengan SPSS 

DDescriptive 

 

 
Gambar 10.13 Tabel statistik deskriptif. 
 

Bagian statistika deskriptif di atas menyajikan deskripsi 

(jumlah pengamatan, rata-rata, simpangan baku, nilai 

minimun dan maksimum) dari pasangan sendiri dan 

kelompok. 

Berdasarkan tabel statistik deskriptif di atas dapat dilihat 

bahwa nilai rata-rata siswa yang belajar sendiri adalah 

81.53 dan nilai rata-rata siswa yang belajar 

berkelompok adalah 83.53. Serta standar deviasi 

(seberapa jauh rentang data dari mean) yang belajar 

sendiri adalah 2.528 dan yang belajar berkelompok 

adalah 4.361 dengan banyaknya data yang diamati 

sejumlah 17 data. 

 



10 – Uji Komparatif Non Parametrik Sampel Dependen 

170 

FFrequencies 

 

 
Gambar 10.14 Tabel frekuensi. 
 

Bagian tabel frekuensi di atas menyatakan banyaknya 

tanda bagi selisih rangking. Berdasarkan tabel frekuensi 

di atas dapat dilihat bahwa ada 5 data dengan 

perbedaan negatif, 9 data dengan perbedaan positif 

dan 3 data dengan perbedaan data nol (pasangan data 

sama nilainya) dari sebanyak 17 data. 

 

Test Statistics 

 

 
Gambar 10.15 Tabel Test Statistics. 
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Bagian dari nilai Test Statistics di atas menyajikan hasil 

uji binomial. Terlihat bahwa pada kolom Exact Sig.(2-

tailed) atau signifikansi untuk uji dua arah diperoleh 

nilai 0.424, maka nilai p = 0.424 > 0.05 atau H0 

diterima. 

 

KKesimpulan 

H0 diterima berarti tidak  ada  perbedaan  nilai  siswa  

jika  ia  belajar  sendiri  dengan  jika  ia  belajar 

berkelompok. Atau dapat dikatakan bahwa perbedaan 

cara belajar baik secara sendiri-sendiri maupun 

berkelompok tidak berpengaruh terhadap hasil belajar 

atau kemampuan kognitif siswa. 

 

10.4 Uji Wilcoxon 

Uji Dependent Samples yang akan dipelajari selanjutnya 

adalah Uji Wilcoxon. Uji Wilcoxon digunakan jika besar 

maupun arah perbedaan diperhatikan dalam menentukan 

apakah ada perbedaan nyata antara data pasangan yang 

diambil dari satu sampel atau sampel yang berhubungan. 

Uji ini merupakan penyempurnaan dari uji tanda. Jika 

dalam uji tanda besarnya selisih nilai angka antara positif dan 

negatif tidak diperhitungkan, sedangkan dalam uji Wilcoxon 

besarnya selisih diperhitungkan. Seperti halnya dalam uji 
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tanda, uji ini digunakan untuk menguji signifikansi hipotesis 

komparatif dua sampel berpasangan yang berkorelasi bila 

datanya berbentuk ordinal. 

 

Contoh 10.3 

Seorang guru mengadakan penelitian pengaruh model 

pembelajaran terhadap skor benar dari 10 siswa 

sebagai berikut. Ujilah apakah ada perbedaan 

pengaruh model pembelajaran terhadap skor benar 

dari siswa tersebut. Diketahui data tidak terdistribusi 

normal. 

 

NNo  SSebelum  SSesudah  

1 1 4 
2 3 4 
3 2 3 
4 1 2 
5 2 5 
6 4 2 
7 1 1 
8 4 3 
9 2 3 
10 3 4 

 

Hipotesis untuk permasalahan di atas dirumuskan 

sebagai berikut : 
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H0 : Tidak ada perbedaan pengaruh model 

pembelajaran terhadap skor benar dari siswa 

tersebut 

Ha : Ada perbedaan pengaruh model pembelajaran 

terhadap skor benar dari siswa tersebut 

  

Kriteria Pengujian Statistik: 

Jika nilai Sig. > 0.05 maka H0 diterima 

Jika nilai Sig. < 0.05 maka H0 ditolak 

 

Langkah-langkah menggunakan SPSS: 

1. Buat data baru, lalu klik tab Variabel View 

2. Definisikan dua variabel 

Ketentuan variabel pertama: Pada kolom Name isi 

dengan sebelum, Type: Numeric, Width: 8, Decimal: 0, 

Label: Sebelum, Values: None, Missing: None, Columns: 

8, Align: Right, Measure: Scale, Role: Input. 

Ketentuan variabel kedua: Pada kolom Name isi dengan 

sesudah, Type: Numeric, Width: 8, Decimal: 0, Label: 

Sesudah, Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Scale, Role: Input. 
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Gambar 10.16 Pendefinisian variabel. 
 

3. Kita isi variabel dari data di atas seperti biasa. Anda bisa 

menggunakan Salin (CTRL+C) dan Tempel (CTRL+V) atau 

menuliskan ulang secara manual. 

 

 
Gambar 10.17 Pengisian data. 
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4. Klik menu Analyze →  Nonparametric Tests  →  Legacy 

Dialogs →  2 Related Samples. 

5. Pada kotak dialog yang ditampilkan, klik variabel  

Sebelum [sebelum] (kotak sebelah kiri) lalu klik tombol 

panah ke kanan. Lakukan hal yang sama pada variabel 

Sesudah [sesudah] sehingga kedua variabel sekarang 

berada di kotak sebelah kanan dengan posisi di baris 

pertama (Pair 1), kolom Variable1 berisi variabel 

Sebelum [sebelum] dan  kolom Variable2 berisi 

variabel Sesudah [sesudah]. Selanjutnya pada Test 

Type beri tanda centang pada Wilcoxon. 

 

 
Gambar 10.18 Pengaturan variabel dan jenis tes. 
 

6. Klik tombol OK sehingga ditampilkan output SPSS 
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7. Interpretasi output SPSS 

HHasil Analisis dengan SPSS 

 

 
Gambar 10.19 Tabel Test Statistics. 

 

Berdasarkan hasil analisis dengan tingkat kepercayaan 

95% (  = 5%) terlihat nilai Asymp Sig (2-tailed) = 

0.142. Dengan demikian nilai  Asymp Sig (2-tailed) 

> , sehingga H0 diterima. 

 

Kesimpulan: tidak ada perbedaan/pengaruh model 

pembelajaran terhadap skor siswa. 

 

LATIHAN - 1 

Seratus orang siswa ditanya apakah mereka memikirkan 

atau tidak tentang kedisiplinan, yaitu perlunya menilang 

orang yang melanggar lalu lintas. Mereka kemudian diberi 
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pelajaran dan diperlihatkan sebuah video mengenai 

beberapa kejadian serius yang disebabkan oleh 

ketidakdisiplinan. Mereka kemudian ditanya pendapatnya 

mengenai penilangan tersebut. Apakah hasil yang 

diberikan di bawah ini menunjukkan sebuah perubahan 

penting dalam sikap sebagai hasil dari pelajaran video? 

 

 Sebelum diberi Pelajaran 

Mendukung Berlawanan 

Setelah 

diberi 

pelajaran 

Mendukung 
31 16 

Berlawanan 8 45 
 

 

LLATIHAN -- 2 

Di desa Sidakarya telah dilakukan kampanye tentang 

makanan bergizi. Untuk meneliti apakah kampanye 

tersebut mempunyai efek positif, dilakukan pengamatan 

terhadap 18 keluarga secara acak. Ujilah pada taraf nyata 

5%. Penilaian sebelum dan sesudah kampanye 

memberikan informasi sebagai berikut: 
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Keluarga Sebelum Sesudah 

1 2 4 
2 3 4 
3 1 2 
4 3 3 
5 2 3 
6 2 4 
7 2 2 
8 3 4 
9 2 2 

10 1 2 
11 1 3 
12 2 3 
13 2 4 
14 3 5 
15 4 5 
16 3 2 
17 2 3 
18 4 3 

  
 

LLATIHAN -- 3 

Seorang guru mengadakan penelitian pengaruh model 

pembelajaran terhadap skor benar dari 15 siswa sebagai 

berikut. Ujilah apakah ada perbedaan pengaruh model 
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pembelajaran terhadap skor benar dari siswa tersebut. 

Diketahui data tidak terdistribusi normal: 

 

No. Pre Test Post Test 

1 1 4 
2 3 4 
3 2 3 
4 1 2 
5 2 5 
6 4 2 
7 1 1 
8 4 3 
9 2 3 

10 3 4 
11 4 1 
12 2 3 
13 3 3 
14 3 4 
15 3 5 
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111 
UJI KOMPARATIF NON 
PARAMETRIK K-SAMPEL 

INDEPENDEN 
 

 

11.1 Pengantar 

Peneliti sering kali menemui kasus di mana harus 

mencari perbedaan di antara banyak sampel (lebih dari 2). 

Dalam kasus 2 sampel atau 2 grup, akan lebih mudah 

diidentifikasi apakah terdapat perbedaan atau tidak. Tetapi 

ketika berhadapan dengan 3 atau lebih (K samples) maka 

diperlukan metode lain yang mampu untuk menjawab 

pertanyaan itu. Kasus itu akan lebih rumit, jika di antara 

banyak sampel tersebut tidak berkorelasi atau tidak 

berhubungan. Akan tetapi banyak metode telah dirancang 

oleh para ahli untuk menangani kasus tersebut. 

Ada banyak metode untuk mencari perbedaan antara 

banyak sampel yang tidak berkorelasi dengan statistik non 

parametrik. Ada perluasan median test, ada uji Kruskal Wallis 
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dan ada juga Uji Jonckheere-Terspat. Semunya mempunyai 

keunggulan tersendiri dan dalam artikel ini kita akan 

membahas tentang Uji Kruskal Wallis. 

K-Independent Samples Test di sebut juga uji Kruskal-

Wallis pada hakikatnya sama dengan uji Anova dengan 

prasyarat yang lebih longgar. Kelonggaran prasyarat tersebut 

yaitu: mampu digunakan untuk data ordinal, dan distribusi 

variabel yang di uji tidak harus normal. Uji ini digunakan 

untuk menetapkan apakah nilai variabel tertentu berbeda 

pada dua atau lebih kelompok. 

 

111.2 Uji Kruskal Wallis 

Kruskal Wallis sebenarnya adalah nama dari dua orang 

ahli yaitu William Henry Kruskal dan W. Allen Wallis. William 

Henry Kruskal lahir di New York pada 10 Oktober 1919 dan 

meninggal pada 21 April 2005. Beliau berdarah Yahudi dan 

ahli matematika serta statistik yang mempunyai banyak sekali 

karya yang ditinggalkan. 

William Allen Wallis lahir di Philadelphia pada 5 

November 1912 dan wafat pada 12 Oktober 1998. Beliau 

adalah ahli ekonomi dan statistik yang pernah menjadi 

penasihat 4 presiden Amerika Serikat yaitu Dwight 

Eisenhower, Richard Nixon, Gerald Ford, dan Ronald Reagan. 
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Keduanya bekerja sama dan merancang suatu metode 

statistik yang sering disebut dengan Kruskal Wallis. 

Uji Kruskal Wallis digunakan untuk menguji apakah k 

sampel bebas berasal dari populasi-populasi yang berbeda. 

Uji Kruskal-Wallis merupakan suatu uji padanan bagi analisis 

ragam dalam metode parametrik. 

 

Contoh 11.1 

Seorang guru melakukan penelitian kelas. Guru 

tersebut ingin mengetahui apakah ada perbedaan 

prestasi belajar siswa yang diajar dengan strategi A, 

strategi B, dan strategi C. Setelah diadakan perlakuan 

hasilnya adalah sebagai berikut. 

 

Strategi A Strategi B Strategi C 

36 50 62 
45 50 90 
59 40 45 
61 77 70 
 60 90 

 

Ujilah dengan uji statistik untuk mengetahui ada atau 

tidak perbedaan prestasi belajar antara siswa yang 

diajar strategi A, B, dan C. Asumsikan data tidak 

terdistribusi normal,  = 5 %. 
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Hipotesis untuk permasalahan di atas dirumuskan 

sebagai berikut : 

H0 : Tidak ada perbedaan prestasi belajar antara 

siswa yang diajar strategi A, B, dan C 

Ha : Ada perbedaan prestasi belajar antara siswa 

yang diajar strategi A, B, dan C 

  

Kriteria Pengujian Statistik: 

Jika nilai Sig. > 0.05 maka H0 diterima 

Jika nilai Sig. < 0.05 maka H0 ditolak 

 

Langkah-langkah menggunakan SPSS: 

1. Buat data baru, lalu klik tab Variable View 

2. Definisikan dua variabel 

Ketentuan variabel pertama: Pada kolom Name isi 

dengan strategi, Type: Numeric, Width: 8, Decimal: 0, 

Label: (kosongkan), Values: None, Missing: None, 

Columns: 8, Align: Right, Measure: Nominal, Role: 

Input. 

Ketentuan variabel kedua: Pada kolom Name isi dengan 

prestasi, Type: Numeric, Width: 8, Decimal: 0, Label: 

(kosongkan), Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Scale, Role: Input. 
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Gambar 11.1 Pendefinisian variabel. 
 

3. Buka tab Data View, masukkan data yang pada tabel 

dengan memasukkan angka 1 untuk strategi A, angka 

2 untuk strategi B, dan angka 3 untuk strategi C. 

 

 
Gambar 11.2 Memasukkan data. 
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4. Klik menu Analyze →  Nonparametric Tests  →  Legacy 

Dialogs →  K-Independent Samples. 

5. Pada kotak dialog yang ditampilkan, klik variabel 

prestasi lalu klik tanda panah ke kanan sehingga 

variabel ini berpindah ke kotak Test Variable List di 

sebelah kanan. Klik variabel strategi lalu klik tanda 

panah ke kanan yang berada di bawah tanda panah 

sebelumnya sehingga variabel strategi berpindah ke 

kolom Grouping Variable. 

 

 
Gambar 11.3 Pengaturan variabel. 
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6. Klik tombol Define Range, masukkan rentang nilai 

variabel strategi pada kotak Minimum: 1 dan Maximum: 

3. 

 

 
Gambar 11.4 Pengaturan pengelompokan variabel. 

 

Klik tombol Continue. 

7. Pada kotak Test Type, beri tanda centang pada 

Kruskal-Wallis H 

8. Klik tombol OK. 

Hasil analisis dengan SPSS sebagai berikut. 

 

 
Gambar 11.5 Tabel Test Statistics. 
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Berdasarkan hasil analisis, tingkat kepercayaan 95% 

(  = 5%) Asymp Sig = 0.134 >  = 0.05, sehingga 

H0 diterima. 

Kesimpulan: Tidak ada perbedaan prestasi belajar 

antara siswa yang diajar strategi A, B, dan C. 

 

111.3 Uji Chi-Square untuk k-Sampel Independen 

Uji Chi-Square k-sampel digunakan untuk menguji 

hipotesis komparatif lebih dari dua sampel atau untuk 

memeriksa apakah sampel-sampel yang diambil secara acak 

variabelnya berasal dari populasi yang homogen. 

Pengujian dengan menggunakan Chi-Square 

diterapkan pada kasus di mana akan diuji apakah frekuensi 

data yang diamati (frekuensi/data observasi) sama atau tidak 

dengan frekuensi harapan atau frekuensi secara teoritis. Chi-

Square tergolong ke dalam jenis statistik non parametrik 

sehingga Chi-Square tidak memerlukan syarat data 

terdistribusi normal (Sufren dan  Natanael 2013). 

 

Contoh 11.2 

Sampel 500  siswa berpartisipasi dalam studi yang 

dirancang untuk mengevaluasi tingkat penerimaan 

mereka terhadap implementasi Kurikulum Merdeka di 

sekolah. Tabel berikut menunjukkan data siswa yang 
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telah diklasifikasikan berdasarkan asal sekolah dan 

tingkat penerimaan mereka. 

 

SSekolah  

PPenerimaan terhadap IKM  

MMenerima  
BBiasa 

SSaja 
Menolak  Total  

SD 1 12 150 26 188 
SDIT 2 19 122 17 158 
MI 1 19 120 15 154 
Jumlah 50 392 58 500 

 

Apakah data ini menunjukkan bahwa ada hubungan 

antara tingkat penerimaan siswa terhadap IKM dan asal 

sekolah, dari sampel 500 siswa tersebut? (Gunakan  

= 5% ). 

 

Hipotesis untuk permasalahan di atas dirumuskan 

sebagai berikut : 

H0 : Tidak ada perbedaan tingkat penerimaan siswa 

terhadap IKM dan asal sekolah 

Ha : Ada perbedaan tingkat penerimaan siswa 

terhadap IKM dan asal sekolah 

 

 



11 – Uji Komparatif non Parametrik k-Sample Independen 

190 

KKriteria Pengujian Statistik: 

Jika nilai Sig. > 0.05 maka H0 diterima 

Jika nilai Sig. < 0.05 maka H0 ditolak 

 

Langkah-langkah Analisis dengan SPSS : 

1. Buat data baru, klik tab Variabel View 

2. Definisikan tiga variabel: 

Variabel pertama: Pada kolom Name isi dengan Baris, 

Type: Numeric, Width: 8, Decimal: 0, Label: 

(kosongkan), Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Nominal, Role: Input. 

Variabel kedua: Pada kolom Name isi dengan Kolom, 

Type: Numeric, Width: 8, Decimal: 0, Label: 

(kosongkan), Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Nominal, Role: Input. 

Variabel ketiga: Pada kolom Name isi dengan Jumlah, 

Type: Numeric, Width: 8, Decimal: 0, Label: 

(kosongkan), Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Scale, Role: Input. 

 

Keterangan: 

Baris menyatakan kelompok umur. 

Kolom menyatakan tingkat penerimaan yang siswa 

Jumlah menyatakan jumlah/frekuensi pada tiap-tiap sel 
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Gambar 11.6 Pengaturan variabel. 
 

3. Klik tab Data View. Masukkan semua data ke dalam 

kolom-kolom yang bersesuaian. 

 

 
Gambar 11.7 Pengisian data. 
 

4. Selanjutnya harus ditegaskan kepada SPSS bahwa 

variabel jumlah mewakili frekuensi untuk masing-

masing unik pengodean BARIS dan KOLOM. Klik menu 
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Data → Weight Cases. Setelah muncul kotak dialog, beri 

tanda centang pada Weight case by kemudian 

pindahkan variabel jumlah dengan mengeklik tanda 

panah ke kanan. 

 

 
Gambar 11.8 Pembobotan variabel. 
 

Klik tombol OK. 

5. Klik menu Analyze → Descriptive Satistic → 

Crosstab. Selanjutnya klik variabel Row lalu klik tanda 

panah ke kanan sehingga variabel Baris berpindah ke 

kolom Row(s). Klik variabel Kolom lalu klik tanda panah 

ke kanan sehingga variabel Kolom berpindah ke kolom 

Column(s). 
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Gambar 11.9 Penentuan variabel crosstab. 
 

6. Klik tombol Statistics. Pada kotak dialog yang 

ditampilkan,  pilih Chi-square. 

 

 
Gambar 11.10 Pemilihan statistics. 
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Klik tombol continue. 

7. Klik tombol OK. 

8. Interpretasi hasil Output SPSS 

HHasil Analisis 

 

 
Gambar 11.11 Tabel Uji Chi-Square. 

 

Diperoleh nilai Sig. = 0.000. (lihat baris Pearson Chi-

Square). Karena Sig (0.000) < α (0.05) maka H0 ditolak. 

Kesimpulannya ada perbedaan tingkat penerimaan 

siswa terhadap IKM dan asal sekolah. 

 

11.4 Perluasan Uji Median 

Perluasan uji median menentukan apakah k kelompok 

saling bebas (ukuran tidak harus sama) ditarik dari populasi 

yang sama atau dari populasi yang ber-median sama. 

Variabel yang dikaji sekurang-kurangnya diukur dalam skala 

ordinal. 
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Contoh 11.3 

Seorang peneliti pendidikan ingin mempelajari apakah 

ada hubungan antara tingkat pendidikan ibu dengan 

banyaknya kunjungan ke sekolah anaknya. Diambil 

sampel secara acak sebanyak 10% dari 440 anak yang 

terdaftar di sekolah. Dari sampel tersebut didapat nama 

dari 44 ibu-ibu yang kemudian dijadikan sampel. 

Datanya adalah sebagai berikut: 

 

Jumlah kunjungan ke sekolah oleh ibu digolongkan 
menurut tingkat pendidikan 
 

SD SMP SMA PT 
4 2 2 9 
2 0 0 4 
3 4 0 4 
0 2 5 5 
0 1 4 2 
3 5 2 2 
7 6 3 3 
5 1 1 2 
1 3 8 2 
1 2 7 6 

 1 6  
  5  
  1  
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Buktikan hipotesis bahwa banyaknya ibu ke sekolah 

bervariasi menurut tingkat pendidikan yang ditamatkanya. 

(gunakan  = 5%). 

Hipotesis dari permasalahan di atas, dapat dirumuskan 

sebagai berikut : 

H0 : Tidak ada perbedaan banyaknya kunjungan di 

antara para ibu dengan variasi tingkat 

pendidikannya 

Ha : Ada perbedaan banyaknya kunjungan di antara 

para ibu dengan variasi tingkat pendidikannya 

 

AAnalisis dengan SPSS 

1. Buat data baru, klik tab Variabel View 

2. Definisikan dua variabel 

Variabel pertama: Pada kolom Name isi dengan 

kunjungan, Type: Numeric, Width: 8, Decimal: 0, Label: 

Banyak Kunjungan, Values: None, Missing: None, 

Columns: 8, Align: Right, Measure: Scale, Role: Input. 

Variabel kedua: Pada kolom Name isi dengan 

pendidikan, Type: Numeric, Width: 8, Decimal: 0, Label: 

Tingkat Pendidikan, Values: None, Missing: None, 

Columns: 8, Align: Right, Measure: Ordinal, Role: 

Input. 
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Gambar 11.12 Pendefinisian variabel. 

 

3. Buka tab Data View, lalu isikan data pada tabel di atas 

dengan memberikan kode 1 untuk tingkat pendidikan 

SD, 2 untuk tingkat pendidikan SMP, 3 untuk tingkat 

pendidikan SMA, dan 4 untuk tingkat pendidikan PT. 

 

 
Gambar 11.13 Memasukkan data. 
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4. Klik menu Analyze → Nonparametric Test → Legacy 

Dialogs → K Independent Samples 

5. Pada kotak dialog yang ditampilkan, pilih variabel 

Banyak Kunjungan [kunjungan] lalu klik tombol panah 

ke kanan sehingga variabel ini berpindah ke kolom 

Test Variable List. Pilih variabel Tingkat Pendidikan 

[pendidikan] lalu klik tombol panah ke kanan 

sehingga variabel ini berpindah ke kolom Grouping 

Variable. Pada kolom Test Type beri tanda centang 

pada Median. 

 

 
Gambar 11.14 Memilih variabel yang akan diuji. 

 

6. Pada Grouping Variable, klik Define Range. Pada kotak 

dialog yang ditampilkan, masukkan nilai Minimum : 1 

dan Maximum: 4. 
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Gambar 11.15 Mendefinisikan pengelompokan variabel. 

 

Klik tombol Continue. 

7. Klik tombol Options. 

8. Pada kotak dialog yang ditampilkan, beri tanda centang 

pada Descriptive. 

 

 
Gambar 11.16 Memilih statistik descriptive. 

 

Klik tombol Continue. 
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9. Klik tombol OK. 

Hasil analisis dengan SPSS 

 
Gambar 11.17 Tabel Descriptive Statistics. 
 

Descriptive statistics menunjukkan banyaknya 

kunjungan adalah sebanyak 44 ibu-ibu berdasarkan 

variasi tingkat pendidikannya, dan dapat dilihat pula 

mean yang diperoleh adalah 3.09, dengan simpangan 

baku 2.301, dan nilai minimum dari banyaknya 

kunjungan adalah 0, sedangkan nilai maksimum dari 

banyaknya kunjungan adalah 9. 

 

 
Gambar 11.18 Tabel Test Statistics. 
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Dari luaran di atas nilai Asymp. Sig. adalah 0.730 > 

0.05, maka H0 diterima sehingga tidak cukup bukti 

menolak H0 (terima H0). 

Sehingga kesimpulan yang diperoleh adalah tidak ada 

perbedaan banyaknya kunjungan di antara para ibu 

dengan variasi tingkat pendidikannya. 

 

LLATIHAN -- 1 

Seorang guru melakukan penelitian kelas. Guru tersebut 

ingin mengetahui apakah ada perbedaan prestasi belajar 

siswa yang diajar dengan strategi A, strategi B, dan strategi 

C. Setelah diadakan perlakuan hasilnya adalah sebagai 

berikut. 

 

Strategi A Strategi B Strategi C 

46 60 52 
55 60 80 
69 50 35 
71 87 60 
59 70 80 

 55  
 

Ujilah dengan uji statistik untuk mengetahui ada atau tidak 

perbedaan prestasi belajar antara siswa yang diajar strategi 
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A, B, dan C. Asumsikan data tidak terdistribusi normal,  = 

5 %.  

 

LLATIHAN -- 2 

Dilakukan penelitian untuk mengetahui adakah hubungan 

antara penghasilan keluarga per bulan dengan jumlah 

pelanggaran kedisiplinan yang diterapkan di Sekolah X. 

Dalam hal ini penghasilan keluarga dikelompokkan 

menjadi 4 kategori, yaitu penghasilan kurang dari 2 juta, 

antara 2 juta sampai 3.5 juta, antara 3.5 juta sampai 5 juta 

dan penghasilan lebih dari 5 juta. Dalam penelitian ini 

digunakan 50 orang responden, jumlah pelanggaran 

kedisiplinan yang dilakukan masing-masing siswa dan 

penghasilan orang tuanya disajikan pada tabel berikut: 

 

Penghasilan Keluarga 

< 2 juta 2 – 3.5 juta 3.5 – 5 juta > 5 juta 

0 2 1 0 
1 1 1 3 
2 3 1 2 
2 1 1 2 
1 1 2 2 
1 2 3 1 
2 3 2 1 
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2 2 1 1 
3 2 2 2 
1 1 1 4 
1 2 2 2 
0 1 4 2 
  2  
  2  

 

Buktikan hipotesis yang menyatakan tidak ada perbedaan 

banyaknya pelanggaran kedisiplinan yang dilakukan siswa 

berdasarkan penghasilan keluarganya per bulan. 

Asumsikan data tidak terdistribusi normal,  = 5 %.  
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112 

UJI KORELASI DUA SAMPEL 
 

 

12.1 Pengantar 

Analisis korelasi merupakan metode statistik yang 

digunakan untuk mengukur besarnya hubungan linier antara 

dua variabel atau lebih. Nilai korelasi populasi ( ) berkisar 

pada interval -1 ≤  ≤ 1. Jika korelasi bernilai positif, maka 

hubungan antara dua variabel bersifat searah. Sebaliknya, 

jika korelasi bernilai negatif, maka hubungan antara dua 

variabel bersifat berlawanan arah. 

Misalkan korelasi sampel antara variabel X dan Y (rxy) 

bernilai positif mengartikan bahwa jika nilai X naik maka nilai 

Y juga naik, sedangkan jika nilai X turun maka nilai Y juga 

turun. 

Misalkan korelasi sampel antara variabel X dan Y (rxy) 

bernilai negatif mengartikan bahwa jika nilai X naik maka 

nilai Y juga turun, sedangkan jika nilai X turun maka nilai Y 

juga naik. 
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Tabel Koefisien Korelasi dan Interpretasinya 
NNilai KKorelasi  IInterpretasi  

0.00 - 0.09 Hubungan korelasinya diabaikan 
0.10 - 0.29 Hubungan korelasi rendah 
0.30 - 0.49 Hubungan korelasi moderat 
0.50 - 0.70 Hubungan korelasi sedang 

> 0.70 Hubungan korelasi sangat kuat 
 

Korelasi Pearson Product Moment (r) merupakan 

analisis regresi yang sangat populer dan sering dipakai oleh 

mahasiswa dan peneliti. Analisis korelasi ini dikenalkan oleh 

Karl Pearson pada tahun 1900. Korelasi ini digunakan untuk 

mengetahui derajat hubungan dan kontribusi variabel bebas 

(independent) dengan variabel terikat (dependent). 

Teknik analisis Korelasi PPM termasuk teknik statistik 

parametrik yang menggunakan interval dan rasio dengan 

persyaratan data dipilih secara acak (random), datanya 

terdistribusi normal, data yang dihubungkan berpola linier, 

dan data yang dihubungkan mempunyai pasangan yang 

sama sesuai dengan subjek yang sama. 

Charles Spearman mengenalkan koefisien korelasi tata 

jenjang (rank–order correlation coeficient). Analisis ini 

digunakan untuk bahan atau data yang telah terkumpul atau 

dilaporkan berbentuk tata – jenjang, sehingga lebih mudah 

untuk melakukan analisis. Sebagai ilustrasi, seorang peneliti 
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dalam aktivitas analisis mampu menyusun data yang 

selanjutnya dapat dibuat penjenjangan tanpa memperhatikan 

beda skor, maka kita dapat melakukan analisis dan 

memperoleh nilai r-nya dengan rumus yang lebih sederhana. 

 

112.2 Uji Korelasi Statistika Parametrik 

Pada bagian ini kita akan mencoba melakukan 

pengujian korelasi dengan menggunakan teknik statistika 

parametrik yang paling populer, yaitu Korelasi Product 

Moment atau biasa juga disebut Korelasi Pearson. 

 

Contoh 12.1 

Berikut disajikan data nilai matematika dan nilai IPA 

siswa kelas V SD X. 

 

Matematika  IPA  

45 57 
35 43 
50 62 
40 53 
31 44 
28 40 
58 69 
60 73 
68 79 
75 83 
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Ujilah apakah ada korelasi yang positif antara 

kemampuan Matematika dengan hasil belajar IPA? 

(Gunakan taraf signifikansi 5%). 

 

PProsedur Analisis 

1. Buat data baru, klik tab Variable View 

2. Definisikan dua variabel. 

Variabel pertama: Pada kolom Name isi dengan 

matematika, Type: Numeric, Width: 8, Decimal: 2, Label: 

Nilai Matematika, Values: None, Missing: None, 

Columns: 8, Align: Right, Measure: Scale, Role: Input. 

Variabel kedua: Pada kolom Name isi dengan ipa, Type: 

Numeric, Width: 8, Decimal: 2, Label: Nilai IPA, 

Values: None, Missing: None, Columns: 8, Align: Right, 

Measure: Scale, Role: Input. 

 

 
Gambar 12.1 Pendefinisian variabel. 
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3. Buka tab Data View kemudian masukkan data pada 

tabel di atas pada kolom yang bersesuaian. 

 

 
Gambar 12.2 Memasukkan data nilai. 
 

4. Klik menu Analyze   Correlate  Bivariate 

5. Pada kotak dialog yang ditampilkan, klik variabel Nilai 

Matematika [matematika] lalu klik tombol panah ke 

kanan. Lakukan hal yang sama pada variabel Nilai 

IPA [ipa] sehingga kedua variabel berpindah ke kotak 

Variables di sebelah kanan. 

Pada kolom Correlation Coefficients beri tanda 

centang pada Pearson. 

Pada kolom Test of Significance pilih Two-Tailed. 
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Gambar 12.3 Pemilihan variabel dan jenis pengujian. 
 

6. Klik tombol Options. 

7. Pada kotak dialog yang ditampilkan beri tanda centang 

pada Means and Standard Deviation dan Cross 

Product Deviations and Covariance. 

 

 
Gambar 12.4 Pemilihan jenis statistics yang ditampilkan. 
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Klik tombol Continue. 

8. Klik tombol OK sehingga ditampilkan output SPSS. 

AAnalisis output SPSS 

Dasar pengambilan keputusan dalam uji korelasi 

Pearson: 

1) Jika nilai Sig. < 0.05 maka disimpulkan terdapat 

korelasi yang signifikan antara variabel yang 

dihubungkan. 

2) Sebaliknya, Jika nilai Sig. > 0,05 maka 

disimpulkan tidak terdapat korelasi yang 

signifikan antara variabel yang dihubungkan. 

 

 
Gambar 12.5 Tabel Descriptive Statistics. 

 

Tabel Descriptive Statistics menampilkan hasil 

analisis statistik deskriptifnya seperti rata-rata per 

variabel, standar deviasi, dan jumlah sampel. Pada 

tabel ini ditampilkan rata-rata nilai Matematika 49 dan 

IPA 60.30 dengan standar deviasi masing-masing 

15.98 dan 15.44 secara sekilas rata-rata nilai IPA lebih 

tinggi dari pada nilai matematika akan tetapi standar 

deviasinya tidak jauh berbeda. 
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Gambar 12.6 Tabel Correlations. 
 

Tabel Correlations, ada dua tanda dalam penafsiran 

korelasi melalui nilai koefisien, yaitu tanda (+) dan (-) 

yang berhubungan dengan arah korelasi, serta 

menyatakan kuat tidaknya korelasi. 

 

Hipotesis Penelitian : 

H0 : Tidak ada hubungan (korelasi) antara dua 

variabel 

Ha : Ada hubungan (korelasi) antara dua variabel 

 

Ketentuan: 

Jika nilai Sig (2-tailed) > α maka H0 diterima. 

Jika nilai Sig (2-tailed) < α maka H0 ditolak. 
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atau 

Jika nilai thitung < ttabel maka H0 diterima. 

Jika nilai thitung > ttabel maka H0 ditolak. 

 

Terlihat pada tabel Correlations nilai Sig (2-tailed) 

= 0.000. Karena nilai Sig (2-tailed) <  maka H0 di 

tolak. Selain itu, nilai korelasi di antara kedua variabel 

ini sebesar 0.993 (positif) dan termasuk dalam kategori 

korelasi sangat kuat. Jadi ada korelasi positif yang 

sangat kuat antara kemampuan Matematika dengan 

hasil belajar IPA, sehingga semakin tinggi kemampuan 

Matematika semakin tinggi pula hasil belajar IPA. 

 

112.3 Uji Korelasi Statistika Non Parametrik 

Dalam statistika parametrik notasi r menyatakan 

koefisien korelasi antara dua variabel kontinu X dan Y. Begitu 

juga dalam statistika non parametrik, bila nilai-nilai 

pengamatan x dan y diganti dengan peringkatnya kemudian 

peringkat-peringkat tersebut disubstitusikan ke dalam rumus 

bagi r tentu akan diperoleh koefisien korelasi non 

parametriknya. 

Terdapat tiga jenis koefisien korelasi peringkat pada 

non parametrik yang umumnya digunakan yaitu Spearman R, 

Kendal Tau dan Gamma Coefficient. Statistik Chi-Square juga 
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merupakan bagian dari korelasi non-parametrik, tetapi 

berbeda dengan ketiga jenis korelasi tersebut, 

perhitungannya didasarkan pada tabel frekuensi dua arah 

(tabel silang). Selain itu, dalam Spearman R, Kendal Tau dan 

Gamma menyaratkan data dalam skala ordinal (atau dapat 

diordinal/di peringkat), sedangkan pada statistik Chi-Square 

dapat berupa data nominal maupun ordinal. 

Spearman R adalah ukuran korelasi pada statistik non-

parametrik yang analog dengan koefisien korelasi Pearson 

Product Moment pada statistik parametrik. Spearman R 

adalah korelasi Pearson yang dihitung atas dasar rank dari 

data. 

Kendal Tau, adalah ukuran korelasi yang setara dengan 

Spearman R, terkait dengan asumsi yang mendasarinya serta 

kekuatan statistiknya. Namun, besaran Spearman R dan 

Kendal Tau akan berbeda karena perbedaan dalam logika 

mendasari serta formula perhitungannya. Jika Spearman R 

setara dengan koefisien korelasi Pearson Product Moment, 

yaitu koefisien korelasinya pada dasarnya menunjukkan 

proporsi variabilitas (di mana untuk Spearman R dihitung dari 

ranks sedangkan korelasi Pearson dari data aslinya), 

sebaliknya ukuran Kendal Tahu merupakan probabilitas 

perbedaan antara probabilitas data dua variabel dalam 
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urutan yang sama dengan probabilitas dua variabel dalam 

urutan yang berbeda. 

Berdasarkan logika perhitungan ini, Noether 

sebagaimana dikutip oleh Daniel (1991), mengemukakan 

bahwa koefisien Kendal Tau lebih mudah ditafsirkan 

dibandingkan Spearman R. Gamma Statistic, lebih baik 

dibandingkan Spearman R atau Kendal Tau ketika data 

mengandung banyak observasi yang memiliki nilai yang 

sama. 

Selanjutnya koefisien korelasi non parametrik yang 

akan kita praktikkan di sini adalah Spearman R. Dengan 

teknik ini kita tidak lagi harus mengasumsikan bahwa 

hubungan yang mendasari antara X dan Y harus linear. Ini 

berarti jika datanya menunjukkan adanya hubungan yang 

kurvalinier, maka korelasi peringkat lebih dapat dipercaya 

daripada korelasi biasa. Kita juga tidak perlu mengasumsikan 

bahwa sebaran bagi X dan Y adalah normal. 

 

Contoh 12.2 

Seorang guru ingin mengetahui apakah terdapat 

hubungan antara Motivasi Belajar dengan Prestasi 

Belajar IPS siswa di SD 12. Untuk itu dipilih 12 orang 

siswa untuk dijadikan sampel penelitian. Data yang 

diperoleh dapat dilihat pada gambar di bawah ini. 
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SSiswa  MMotivasi  PPrestasi  

1 71 71 
2 83 88 
3 75 77 
4 68 70 
5 63 73 
6 62 67 
7 80 80 
8 72 88 
9 77 79 

10 72 88 
11 69 75 
12 81 85 

 

Gunakan taraf signifikansi 5%. 

 

PProsedur Analisis 

1. Buat data baru, klik tab Variable View 

2. Definisikan dua variabel. 

Variabel pertama: Pada kolom Name isi dengan 

motivasi, Type: Numeric, Width: 8, Decimal: 0, Label: 

(kosongkan), Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Nominal, Role: Input. 

Variabel kedua: Pada kolom Name isi dengan prestasi, 

Type: Numeric, Width: 8, Decimal: 0, Label: 

(kosongkan), Values: None, Missing: None, Columns: 8, 

Align: Right, Measure: Nominal, Role: Input. 
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Gambar 12.7 Pendefinisian variabel. 

 

3. Klik tab Data View kemudian masukkan data pada tabel 

di atas pada kolom yang bersesuaian. 

 

 
Gambar 12.8 Memasukkan data. 
 

4. Klik menu Analyze   Correlate  Bivariate 

5. Pada kotak dialog yang ditampilkan, klik variabel 

motivasi lalu klik tombol panah ke kanan. Lakukan hal 
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yang sama pada variabel prestasi sehingga kedua 

variabel berpindah ke kotak Variables di sebelah 

kanan. 

Pada kolom Correlation Coefficients beri tanda 

centang pada Spearman. 

Pada kolom Test of Significance pilih Two-Tailed. 

 

 
Gambar 12.9 Pemilihan variabel dan jenis pengujian. 
 

6. Klik tombol Options. 
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7. Pada kotak dialog yang ditampilkan beri tanda centang 

pada Means and Standard Deviation dan Cross 

Product Deviations and Covariance. 

 

 
Gambar 12.10 Pemilihan jenis statistics yang ditampilkan. 

 

Klik tombol Continue. 

8. Klik tombol OK sehingga ditampilkan output SPSS. 

  

Analisis output SPSS 

Dasar pengambilan keputusan dalam uji korelasi 

Pearson: 

1) Jika nilai Sig. < 0.05 maka disimpulkan terdapat 

korelasi yang signifikan antara variabel yang 

dihubungkan. 
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2) Sebaliknya, Jika nilai Sig. > 0,05 maka 

disimpulkan tidak terdapat korelasi yang 

signifikan antara variabel yang dihubungkan. 

 

 
Gambar 12.11 Tabel Correlations. 
 

Tabel Correlations, ada dua tanda dalam penafsiran 

korelasi melalui nilai koefisien, yaitu tanda (+) dan (-) 

yang berhubungan dengan arah korelasi, serta 

menyatakan kuat tidaknya korelasi. 

 

Hipotesis penelitian : 

H0 : Tidak ada hubungan (korelasi) antara dua 

variabel 

Ha : Ada hubungan (korelasi) antara dua variabel 

 

Ketentuan: 

Jika nilai Sig (2-tailed) > α maka H0 diterima. 
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Jika nilai Sig (2-tailed) < α maka H0 ditolak. 

atau 

Jika nilai thitung < ttabel maka H0 diterima. 

Jika nilai thitung > ttabel maka H0 ditolak. 

 

Terlihat pada tabel Correlations nilai Sig (2-tailed) 

= 0.004. Karena nilai Sig (2-tailed) <  maka H0 di 

tolak. Selain itu, nilai korelasi di antara kedua variabel 

ini sebesar 0.762 (positif) dan termasuk dalam kategori 

korelasi sangat kuat. Jadi ada korelasi positif yang 

sangat kuat antara kemampuan motivasi belajar 

dengan prestasi belajar IPS, sehingga semakin tinggi 

motivasi belajar semakin tinggi pula prestasi belajar IPS. 

 

LLATIHAN -- 1 

Suatu penelitian dilakukan untuk mengetahui apakah ada 

hubungan antara variabel tingkat religiositas dengan 

tingkat kenakalan remaja. Penelitian dilakukan dengan 

mengambil sampel sebanyak 9 individu secara acak.  

Distribusi data sebagai berikut. 
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Tingkat 

Religiositas 

Tingkat Kenakalan 

Remaja 

12 20 
11 21 
13 18 
14 19 
15 17 
16 14 
19 13 
17 15 
18 11 

 

Berdasarkan data tersebut lakukan analisis guna 

membuktikan hipotesis yang telah dirumuskan dengan 

taraf kesalahan sebesar 5%. Selanjutnya tentukan arah 

hubungan, kekuatan hubungan dan kontribusi tingkat 

religiositas terhadap tingkat kenakalan remaja.  

  

LATIHAN - 2 

Seorang guru melakukan survei untuk meneliti apakah ada 

korelasi antara kemampuan berbicara dengan 

kemampuan menulis. Untuk kepentingan penelitian 

tersebut diambil 10 siswa untuk diberikan tes 

menggunakan instrumen yang telah disiapkan sebelumnya. 

Hasilnya sebagai berikut. 
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SSiswa ke--  SSkor Menulis  SSkor Membaca  

1 9 8 
2 6 7 
3 5 6 
4 7 8 
5 4 5 
6 3 4 
7 2 2 
8 8 9 
9 7 8 

10 6 6 
 

Hitunglah koefisien korelasi peringkatnya untuk mengukur 

hubungan antara skor menulis dan skor membaca!  
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113 

UJI VALIDITAS DAN 
RELIABILITAS INSTRUMEN 

 
 

13.1 Pengertian 

Validitas berasal dari kata validity yang mempunyai arti 

sejauh mana ketepatan dan kecermatan suatu alat ukur 

dalam melakukan fungsi ukurannya (Azwar 1986). Selain itu 

validitas adalah suatu ukuran yang menunjukkan bahwa 

variabel yang diukur memang benar-benar variabel yang 

hendak diteliti oleh peneliti (Cooper dan Schindler, dalam 

Zulganef, 2006). 

Sedangkan menurut Sugiharto dan Sitinjak (2006), 

validitas berhubungan dengan suatu variabel mengukur apa 

yang seharusnya diukur. Validitas dalam penelitian 

menyatakan derajat ketepatan alat ukur penelitian terhadap 

isi sebenarnya yang diukur. Uji validitas adalah uji yang 

digunakan untuk menunjukkan sejauh mana alat ukur yang 

digunakan dalam suatu mengukur apa yang diukur. Ghozali 
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(2009) menyatakan bahwa uji validitas digunakan untuk 

mengukur sah,  atau valid tidaknya suatu kuesioner. Suatu 

kuesioner dikatakan valid jika pertanyaan pada kuesioner 

mampu untuk mengungkapkan sesuatu yang akan diukur 

oleh kuesioner tersebut. 

Suatu tes dapat dikatakan memiliki validitas yang tinggi 

jika tes tersebut menjalankan fungsi ukurnya, atau 

memberikan hasil ukur yang  tepat dan akurat sesuai dengan 

maksud dikenakannya tes tersebut. Suatu tes menghasilkan 

data yang tidak relevan dengan tujuan diadakannya 

pengukuran dikatakan sebagai tes yang memiliki validitas 

rendah. 

Dalam pengujian validitas terhadap kuesioner, 

dibedakan menjadi 2, yaitu validitas faktor dan validitas item. 

Validitas faktor diukur bila item yang disusun menggunakan 

lebih dari satu faktor (antara faktor satu dengan yang lain ada 

kesamaan). Pengukuran validitas faktor ini dengan cara 

mengkorelasikan antara skor faktor (penjumlahan item dalam 

satu faktor) dengan skor total faktor (total keseluruhan faktor). 

Validitas item ditunjukkan dengan adanya korelasi atau 

dukungan terhadap item total (skor total), perhitungan 

dilakukan dengan cara mengkorelasikan antara skor item 

dengan skor total item. Bila kita menggunakan lebih dari satu 

faktor berarti pengujian validitas item dengan cara 
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mengkorelasikan antara skor item dengan skor faktor, 

kemudian dilanjutkan mengkorelasikan antara skor item 

dengan skor total faktor (penjumlahan dari beberapa faktor). 

Dari hasil perhitungan korelasi akan didapat suatu 

koefisien korelasi yang digunakan untuk mengukur tingkat 

validitas suatu item dan untuk menentukan apakah suatu item 

layak digunakan atau tidak. Dalam penentuan layak atau 

tidaknya suatu item yang akan digunakan, biasanya 

dilakukan uji signifikansi koefisien korelasi pada taraf 

signifikansi 0.05, artinya suatu item dianggap valid jika 

berkorelasi signifikan terhadap skor total. 

 

113.2 Persiapan 

Seorang mahasiswa melakukan penelitian dengan 

menggunakan kuesioner untuk mengetahui atau 

mengungkap prestasi belajar seseorang. Kuesioner terdiri 

atas 10 item dan menggunakan Skala Likert yaitu : 

 1 = sangat tidak setuju 

 2 = tidak setuju 

 3 = netral 

 4 = setuju 

  5 = sangat setuju 

Setelah kuesioner diisi oleh 12 orang responden 

diperoleh data berikut: 
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No. 
Nama 

Responden 

SSoal NNo. 

1 2 3 4 5 

1 Resp 1 2 3 4 2 2 

2 Resp 2 3 3 5 4 4 

3 Resp 3 3 3 4 3 3 

4 Resp 4 2 2 4 3 3 

5 Resp 5 3 4 3 3 4 

6 Resp 6 4 4 5 4 5 

7 Resp 7 4 4 4 3 3 

8 Resp 8 4 4 5 4 4 

9 Resp 9 3 4 4 3 1 

10 Resp 10 4 3 3 2 2 

11 Resp 11 2 3 2 2 1 

12 Resp 12 2 4 5 4 3 

 

No. 
Nama 

Responden 

SSoal NNo. 

6 7 8 9 10 

1 Resp 1 2 3 3 3 2 

2 Resp 2 5 3 3 3 2 

3 Resp 3 2 3 3 3 2 
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4 Resp 4 2 3 2 5 3 

5 Resp 5 3 4 3 2 3 

6 Resp 6 3 4 4 5 5 

7 Resp 7 3 5 4 5 5 

8 Resp 8 3 5 4 5 3 

9 Resp 9 1 3 4 4 3 

10 Resp 10 1 5 3 5 3 

11 Resp 11 3 3 3 2 3 

12 Resp 12 3 4 4 5 3 

 

Angka-angka di atas diperoleh dengan cara melakukan 

kuantifikasi kuesioner berdasarkan jawaban responden. 

Sebagai contoh, untuk Responden 1 pada soal pertama 

(Nomor 1), menjawab 2 yang berarti responden 1 

memberikan jawaban tidak setuju dengan pernyataan pada 

soal Nomor 1. Demikian juga pada soal Nomor 2. Jawaban 

Responden 1 diberi angka 3 karena Responden 1 menjawab 

netral. Demikian seterusnya sampai semua jawaban 

responden selesai dikuantifikasi. Sebagai catatan, pemberian 

skor kuantifikasi bisa berubah sebaliknya untuk pertanyaan 

atau pernyataan negatif. 
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113.3 Uji Validitas dengan Microsoft Excel 

Selanjutnya kita akan mencoba mempraktikkan cara 

melakukan uji validitas instrumen dari contoh di atas. Berikut 

ini langkah-langkahnya. 

1. Pindahkan semua data ke dalam aplikasi Microsoft 

Excel. Sebagai contoh, kita mulai dari sel A1. 

 

 
Gambar 13.1 Penyiapan data di Excel. 
 

2. Pada sel L3 tuliskan rumus =SUM(B3:K3) untuk 

mendapatkan jumlah skor semua item pertanyaan. 

Salin rumus ini sampai sel L14. Data inilah yang biasa 

kita gunakan dalam analisis data suatu variabel yang 

diperoleh dari sebuah angket. Salin  

3. Pada sel B15 tuliskan rumus 

=CORREL(B3:B14;$L$3:$L$14) untuk mendapatkan 
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koefisien korelasi antara skor item pertanyaan pertama 

dengan skor total (jumlah). Sesuaikan tanda ‘;’ dengan 

sistem pemisah di Excel Anda. Salin rumus ini sampai 

sel K15. Sampai sini kita sudah mendapatkan angka 

korelasi antara item pertanyaan pertama sampai 

kesepuluh dengan skor total. Kita ubah tampilan agar 

setiap sel setidaknya memuat tiga angka di belakang 

koma (3 tempat desimal). 

 

 
Gambar 13.2 Hasil penghitungan koefisien korelasi. 
 

4. Selanjutnya kita akan membandingkan nilai rxy pada 

hasil tersebut dengan nilai rtabel pada Tabel r Product 

Moment. Jika digunakan tingkat signifikansi  = 0.05 

(5%) dengan uji 2 sisi dan n = 12 maka titik kritisnya 
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adalah rtabel = 0.576. Di sini n adalah banyak 

responden. 

 

 
Gambar 13.3 Penggalan Tabel r Product Moment. 
 

5. Ketentuan pada pengujian validitas adalah jika nilai rxy 

> rtabel maka item/pertanyaan valid. Pada sel B16 kita 

masukkan rumus =IF(B15>0.576;”Valid”;”Tidak 

Valid”) untuk mendapatkan simpulan dari masing-

masing item pertanyaan. Salin rumus ini sampai sel K16. 

6. Diperoleh hasil uji validitas sebagai berikut: 
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PPertanyaan No.  NNilai rxxy Kesimpulan  

1 0.682 Valid 
2 0.637 Valid 
3 0.704 Valid 
4 0.788 Valid 
5 0.746 Valid 
6 0.405 Tidak Valid 
7 0.659 Valid 
8 0.679 Valid 
9 0.626 Valid 

10 0.642 Valid 
 

7. Pada tabel di atas, terlihat bahwa item soal nomor 6 

tidak valid. Apabila ada item pertanyaan yang tidak 

valid, maka Anda dapat mengganti/memperbaiki 

soalnya, kemudian uji kembali. Selain itu, Anda juga 

dapat membuang/menghapus. Akan tetapi, perlu 

dipastikan apakah ada indikator yang hilang? Setelah 

uji kembali dan ulangi sampai semua item valid. 

 

13.4 Uji Validitas dengan SPSS 

Kita akan menggunakan data yang sama. Untuk 

melakukan uji validitas instrumen, lakukan langkah-langkah 

berikut: 

1. Buat data baru, klik tab Variable View 

2. Definisikan sepuluh variabel sesuai dengan banyaknya 

pertanyaan. Lakukan pengaturan yang sama untuk 
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semua kolom dan hanya berbeda pada kolom Name 

dan Label. Pada kolom Name isi dengan Q1 (selanjutnya 

menyesuaikan), Type: Numeric, Width: 8, Decimal: 0, 

Label: Pertanyaan 1 (selanjutnya menyesuaikan), 

Values: None, Missing: None, Columns: 8, Align: Right, 

Measure: Nominal, Role: Input. 

 

 
Gambar 13.4 Pendefinisian variabel. 
 

3. Klik tab Data View, kemudian masukkan semua data 

bersesuaian dengan kolom item pertanyanya. 
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Gambar 13.5 Semua data sudah dimasukkan. 
 

4. Klik menu Analyze → Scale → Reliability Analysis 

5. Pada kotak dialog Reliability Analysis, pilih semua 

item pertanyaan (tekan CTRL+A) kemudian klik tombol 

panah ke kanan untuk memindahkan semua butir ke 

kolom Items. 



13 – Uji Validitas dan Reliabilitas Instrumen 

236 

 
Gambar 13.6 Pemilihan variabel pengujian. 
 

6. Klik tombol Statistics. Pada kotak dialog yang 

muncul, tandai Items, Scale, dan Scale if item 

deleted di bagian Descriptives for. 

 

 
Gambar 13.7 Opsi Descriptives. 
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Kemudian klik tombol Continue. 

7. Klik tombol OK sehingga ditampilkan output SPSS. 

AAnalisis Validitas 

Tahap I: Menentukan Hipotesis 

H0 : Skor butir berkorelasi positif dengan skor faktor 

Ha : Skor butir tidak berkorelasi positif dengan skor 

faktor 

Tahap II: Menentukan besarnya nilai rtabel dengan 

ketentuan df = jumlah kasus – 2 atau 15 – 2 = 13 dan 

tingkat signifikansi sebesar 5%, diperoleh angka pada 

tabel 0.553. 

Tahap III: Membandingkan nilai Corrected Item–Total 

Correlation dengan rtabel. 

 

 
Gambar 13.8 Tabel Item-Total Statistics. 
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Sebagaimana terlihat pada tabel di atas, ada satu 

pertanyaan dengan nilai Corrected Item – Total 

Correlation-nya lebih kecil dari rtabel yaitu pertanyaan ke-

6. Hal ini sama dengan hasil pengujian menggunakan 

Excel. 

 

113.5 Uji Reliabilitas 

Reliabilitas berasal dari kata reliability, yang berarti 

keajekan pengukuran (Walizer, 1987). Sugiharto dan Sitinjak 

(2006) menyatakan bahwa reliabilitas menunjuk pada suatu 

pengertian bahwa instrumen yang digunakan dalam 

penelitian untuk memperoleh informasi yang digunakan 

dapat dipercaya sebagai alat pengumpulan data dan mampu 

mengungkap informasi yang sebenarnya di lapangan. 

Ghozali (2009) menyatakan bahwa reliabilitas adalah 

alat untuk mengukur suatu kuesioner yang merupakan 

indikator dari variabel atau konstruk. Suatu kuesioner 

dikatakan reliabel atau andal jika jawaban seseorang 

terhadap pernyataan adalah konsisten atau stabil dari waktu 

ke waktu. Reliabilitas suatu tes merujuk pada derajat stabilitas, 

konsistensi, daya prediksi, dan akurasi. Pengukuran yang 

memiliki reliabilitas yang tinggi adalah pengukuran yang 

dapat menghasilkan data yang reliabel. 
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Tinggi rendahnya reliabilitas, secara empiris 

ditunjukkan oleh suatu angka yang disebut nilai koefisien 

reliabilitas. Reliabilitas yang tinggi ditunjukkan dengan nilai rxx 

mendekati angka 1. Kesepakatan secara umum reliabilitas 

yang dianggap sudah cukup memuaskan jika lebih dari atau 

sama dengan 0.700. 

Pengujian reliabilitas instrumen dengan menggunakan 

rumus Alpha Cronbach karena instrumen penelitian biasanya 

berbentuk angket dan skala bertingkat. Jika nilai Alpha > 0.7 

artinya reliabilitas mencukupi (sufficient reliability) sementara 

jika nilai Alpha > 0.80 ini menyugestikan seluruh item reliabel 

dan seluruh tes secara konsisten memiliki reliabilitas yang 

kuat. 

 

113.6 Uji Reliabilitas dengan Microsoft Excel 

Kita akan melanjutkan proses penghitungan Uji 

Validitas dengan Microsoft Excel di atas. Asumsikan semua 

item sudah valid. Untuk melakukan uji reliabilitas, lakukan 

langkah-langkah sebagai berikut: 

1. Kita hitung varians dari masing-masing item dan total 

item. Pada sel B17 masukkan rumus =VAR.S(B3:B14) 

tekan ENTER. Rumus ini digunakan untuk mengestimasi 

varians atau menghitung varians dari sampel. Salin 

rumus ini sampai ke sel L14. 
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Gambar 13.9 Menghitung varians. 
 

2. Pada sel L18 masukkan rumus =SUM(B17:K17) untuk 

menjumlahkan varians semua item. 

3. Pada sel L19 masukkan rumus =(10/(10-1))*(L17-

L18)/L17 tekan ENTER. Rumus ini digunakan untuk 

menghitung nilai Cronbach Alpha. Angka 10 

menyatakan banyaknya item yang diuji. 

 

 
Gambar 13.10 Menghitung Cronbach Alpha. 
 

4. Dari hasil perhitungan di atas diperoleh nilai Cronbach 

Alpha sebesar 0.838. Sesuai dengan ketentuan, 

disimpulkan bahwa instrumen sangat reliabel. 
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113.7 Uji Reliabilitas dengan SPSS 

Untuk menguji reliabilitas dengan SPSS, ulang kembali 

langkah-langkah yang ada di halaman 233 sampai 238. Kita 

akan langsung melihat tabel yang dihasilkan dari langkah-

langkah tersebut, khususnya pada tabel Reliability 

Statistics. 

 

 
Gambar 13.11 Melihat nilai Cronbach’s Alpha. 

 

Pada tabel tersebut terlihat bahwa nilai Cronbach’s 

Alpha adalah sebesar 0.838 (sama dengan nilai Cronbach’s 

Alpha yang kita peroleh menggunakan Excel). Dengan 

demikian, berdasarkan ketentuan dapat dikatakan bahwa 

instrumen tersebut sangat reliabel. 

 

LATIHAN - 1 

Ujilah validitas dan reliabilitas instrumen angket dengan 

hasil kuantifikasi variabelnya sebagai berikut: 
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No Q1 Q2 Q3 Q4 Q5 Q6 Q7 Q8 Q9 Q10 

1 2 1 2 3 4 4 4 4 3 4 

2 4 2 3 4 4 4 4 4 4 4 

3 3 2 3 4 5 5 5 4 4 4 

4 5 2 5 4 4 4 4 4 4 5 

5 2 1 2 3 4 4 4 4 3 3 

6 4 3 4 5 5 5 5 5 5 5 

7 5 3 5 5 5 5 5 5 5 5 

8 2 1 2 3 4 4 4 4 4 4 

9 2 2 2 4 4 4 4 4 4 3 

10 2 2 2 4 4 3 3 4 4 4 

11 4 2 2 4 5 5 5 4 4 5 

12 2 2 2 5 4 4 4 4 4 4 

13 4 2 2 4 4 4 4 4 4 4 

14 5 1 4 5 4 4 4 4 4 5 

15 4 2 4 4 4 4 4 4 2 4 
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114 

ANALISIS REGRESI LINEAR 
SEDERHANA 

 
 
14.1 Pengertian 

Analisis regresi linear sederhana merupakan salah satu 

metode regresi yang dapat dipakai sebagai alat inferensi 

statistik untuk menentukan pengaruh sebuah variabel bebas 

(independen) terhadap variabel terikat (dependen). Uji 

Regresi linear sederhana ataupun regresi linier berganda 

pada intinya memiliki beberapa tujuan, yaitu: 

1. Menghitung nilai estimasi rata-rata dan nilai 

variabel terikat berdasarkan pada nilai variabel 

bebas. 

2. Menguji hipotesis karakteristik dependensi 

3. Meramalkan nilai rata-rata variabel bebas dengan 

didasarkan pada nilai variabel bebas di luar 

jangkauan sampel. 
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114.2 Uji Regresi Linear Sederhana dengan SPSS 

Pada analisis regresi sederhana dengan menggunakan 

SPSS ada beberapa asumsi dan persyaratan yang perlu 

diperiksa dan diuji, beberapa diantaranya adalah: 

1. Variabel bebas tidak berkorelasi dengan 

disturbance term (Error). Nilai disturbance term 

sebesar 0 atau dengan simbol sebagai berikut: E (U 

/ X) = 0, 

2. Jika variabel bebas lebih dari satu, maka antara 

variabel bebas (explanatory) tidak ada hubungan 

linier yang nyata, 

3. Model regresi dikatakan layak jika angka 

signifikansi pada ANOVA < 0.05. Prediktor yang 

digunakan sebagai variabel bebas harus layak. 

Kelayakan ini diketahui jika angka Standard Error of 

Estimate < Standard Deviation 

4. Koefisien regresi harus signifikan. Pengujian 

dilakukan dengan Uji T. Koefisien regresi signifikan 

jika thitung > ttable (nilai kritis) 

5. Model regresi dapat diterangkan dengan 

menggunakan nilai koefisien determinasi (KD = R 

Square x 100%) semakin besar nilai tersebut maka 

model semakin baik. Jika nilai mendekati 1 maka 

model regresi semakin baik 
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6. Residual harus terdistribusi normal 

7. Data berskala interval atau rasio 

8. Kedua variabel bersifat dependen, artinya satu 

variabel merupakan variabel bebas (variabel 

predictor) sedang variabel lainnya variabel terikat 

(variabel response) 

 

Contoh 14.1 

Seorang guru ingin mengetahui pengaruh 

profesionalisme guru terhadap prestasi belajar siswa 

Kelas VIII pada Mata Pelajaran Alquran Hadis di MTs. 

Berikut adalah data yang dikumpulkan setelah 

menyebarkan instrumen berupa angket/kuesioner. 

 

NNo.  PProfesionalisme Guru  PPrestasi Belajar Siswa  

1 28 81 
2 20 84 
3 21 87 
4 23 82 
5 17 86 
6 25 84 
7 22 83 
8 19 85 
9 27 81 
10 25 82 
11 24 85 
12 17 88 
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Sebelum kita masuk pada cara pengolahan data dalam 

uji analisis regresi linear sederhana dengan SPSS, terlebih 

dahulu kita harus memastikan data tersebut telah lolos dalam 

syarat kelayakan model regresi linear sederhana tentunya 

dengan cara melakukan uji normalitas, uji linearitas dan uji 

heteroskedastisitas. Sementara untuk uji autokorelasi tidak 

perlu dilakukan karena data di atas tidak termasuk data time 

series atau data runtut waktu. 

Adapun urutan langkah-langkah uji analisis regresi 

linear sederhana dengan SPSS adalah sebagai berikut: 

1. Buat data baru, klik tab Variable View 

2. Definisikan variabel pertama dengan Name: X; Label: 

Profesionalisme Guru; Measure: Nominal. Variabel 

kedua dengan Name: Y; Label: Prestasi Belajar; 

Measure: Scale. 

 

 
Gambar 14.1 Pendefinisian variabel. 
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3. Klik tab Data View, masukkan data penelitian dengan 

ketentuan X untuk data Profesionalisme Guru dan Y 

untuk Prestasi Belajar. 

 

 
Gambar 14.2 Memasukkan data. 
 

4. Klik menu Analyze → Regression → Linear 

5. Pada kotak dialog Linear Regression, pilih variabel 

Prestasi Belajar [Y] lalu klik tombol panah ke kanan 

sehingga variabel ini berpindah ke kotak Dependent. 

Klik variabel Profesionalisme Guru [X] lalu klik tombol 

panah ke kanan sehingga variabel ini berpindah ke 
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kotak Independent(s). Selanjutnya pada bagian 

Method: pilih Enter. 

 

 
Gambar 14.3 Mengatur variabel dan opsi. 
 

6. Klik tombol OK sehingga ditampilkan output SPSS  

7. Membuat persamaan regresi linear sederhana. 

Secara umum rumus persamaan regresi linear 

sederhana adalah Y = a + bX. Sementara untuk 

mengetahui nilai koefisien regresi tersebut kita dapat 

berpedoman pada output yang berada pada tabel 

coefficients berikut 
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Gambar 14.4 Tabel Coeffcients. 
 

Koefisien Regresi: 

a = Angka konstan dari unstandardized 

coefficients. Dalam contoh ini nilainya sebesar 

95.420. Angka ini merupakan angka konstan 

yang mempunyai arti bahwa jika tidak ada 

Profesionalisme Guru (X) maka nilai Prestasi 

Siswa (Y) adalah sebesar 95.420. 

b = Angka koefisien regresi. Nilainya sebesar -0.511. 

Angka ini menggandung arti bahwa setiap 

penambahan 1% tingkat Profesionalisme Guru 

(X), maka Prestasi Siswa (Y) akan meningkat 

sebesar -0.511 

 

Karena nilai koefisien regresi bernilai minus (-), maka 

dengan demikian dapat dikatakan bahwa 

Profesionalisme Guru (X) berpengaruh negatif terhadap 

Prestasi Siswa (Y). Sehingga persamaan regresinya 

adalah Y = 95.420 – 0.511X. 
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8. Uji hipotesis dalam analisis regresi linear sederhana 

Uji hipotesis atau uji pengaruh berfungsi untuk 

mengetahui apakah koefisien regresi tersebut signifikan 

atau tidak. Hipotesis dalam analisis regresi linear 

sederhana ini adalah: 

H0 : Tidak ada Pengaruh Profesionalisme Guru (X) 

terhadap Prestasi Siswa (Y) 

Ha : Ada Pengaruh Profesionalisme Guru (X) 

terhadap Prestasi Siswa (Y) 

 

Sementara itu, untuk memastikan apakah koefisien 

regresi tersebut signifikan atau tidak (dalam arti variabel 

X berpengaruh terhadap variabel Y) kita dapat 

melakukan uji hipotesis ini dengan cara 

membandingkan nilai signifikansi (Sig.) dengan 

probabilitas 0.05. 

9. Uji hipotesis membandingkan nilai Sig dengan 0.05 

Adapun yang menjadi dasar pengambilan keputusan 

dalam analisis regresi dengan melihat nilai signifikansi 

Sig. hasil output SPSS adalah: 

a. Jika nilai Sig. < 0.05 berarti bahwa ada pengaruh 

Profesionalisme Guru (X) terhadap Prestasi Siswa 

(Y). 
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b. Sebaliknya, jika nilai Sig. > 0.05 berarti bahwa 

tidak ada Profesionalisme Guru (X) terhadap Kinerja 

Prestasi Siswa (Y). 

Berdasarkan output pada Gambar 14.4 di atas 

diketahui nilai signifikansi Sig. sebesar 0.01. Karena 

nilai Sig. < 0.05, dapat disimpulkan bahwa H0 ditolak 

dan Ha diterima, yang berarti bahwa ada Pengaruh 

Profesionalisme Guru (X) terhadap Prestasi Siswa (Y). 

 

10. Melihat besarnya pengaruh variabel X terhadap Y 

Untuk mengetahui besarnya pengaruh Profesionalisme 

Guru (X) terhadap Prestasi Siswa (Y) dalam analisis 

regresi linear sederhana, kita dapat berpedoman pada 

nilai R-Square atau R2 yang terdapat pada output SPSS 

bagian Model Summary. 

 

 
Gambar 14.5 Tabel Model Summary. 
 

Dari output di atas diketahui nilai R-Square sebesar 

0.661. Nilai ini mengandung arti bahwa pengaruh 

Profesionalisme Guru (X) terhadap Prestasi Siswa (Y) 
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adalah sebesar 66.1% sedangkan 33.9% Prestasi Siswa 

dipengaruhi oleh variabel yang lain yang tidak diteliti. 

Merujuk pada pembahasan di atas, maka dapat kita 

simpulkan bahwa profesionalisme guru (X) berpengaruh 

negatif terhadap prestasi siswa (Y) dengan total 

pengaruh sebesar 66.1%. 

 

11. Lakukan Pengujian Linearitas 

Untuk menguji apakah asumsi Linearitas terpenuhi, kita 

dapat menggunakan plot residual dengan fitted value 

(predicted value) atau bisa juga dengan plot residual 

dengan variabel independen (John Neter, 1989:118). 

Berikut adalah cara menampilkan plot residual vs fitted 

value di SPSS: 

- Klik menu Analyze → Regression → Linear 

- Masukkan variabel dependen dan variabel-

variabel bebas seperti pada langkah sebelumnya 

- Klik tombol Save. Beri tanda centang pada 

Unstandardized di kotak Predicted Values dan 

Unstandardized di kotak Residuals. 
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Gambar 14.6 Opsi Save. 
 

Klik tombol Continue. 
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- Klik tombol OK. Pada layar sekarang terdapat dua 

tambahan kolom, yaitu PRE_1 dan RES_1 yang 

menyimpan nilai estimasi dan residual terhadap 

nilai sesungguhnya. 

 

 
Gambar 14.7 Tambahan variabel PRE_1 dan RES_1. 
 

- Selanjutnya, klik menu Graphs → Legacy Dialogs 

→ Scatter/Dot. 

- Pada kotak dialog, klik pilihan Simple Scatter. 

- Klik tombol define. 

Klik variabel Unstandardized Residual lalu klik 

tombol ke kanan yang sejajar dengan baris Y 
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Axis. Dan klik variabel Unstandardized 

Predicted Value lalu klik tombol ke kanan yang 

sejajar dengan baris X. 

 

 
Gambar 14.8 Membuat plotting predicted dan residual. 
 

Klik tombol OK sehingga ditampilkan grafik 

sebagai berikut. 
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Gambar 14.9 Grafik Scatter Plot. 
 

Berdasarkan plot residual dengan fitted value 

tersebut, terlihat bahwa tebaran nilai-nilai pada 

plot membentuk suatu pola acak, sehingga 

asumsi linearitas terpenuhi. 

 

12. Lakukan Pengujian Asumsi Normalitas 

Untuk menguji asumsi Normalitas, dapat 

menggunakan analisis Normal P-P Plot atau dengan uji-

uji normalitas seperti uji Liliefors atau Kolmogorov-

Smirnov. Di sini kita menggunakan Kolmogorov-
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Smirnov untuk menguji normalitas residual regresi. 

Pastikan Anda telah memiliki variabel Unstandardized 

Residuals, yang didapatkan dari hasil uji linearitas di 

atas. Lakukan uji Kolmogorov-Smirnov sebagai berikut: 

- Klik menu Analyze → Nonparametric Test → 

Legacy Dialogs → 1-Sample K-S 

- Pada kotak dialog yang ditampilkan, klik variabel 

Unstandardized Residuals lalu klik tombol ke 

kanan sehingga variabel ini berpindah ke kotak 

Test Variable List. 

 
Gambar 14.10 Menguji normalitas residual. 
 

Klik tombol OK. 
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Gambar 14.11 Tabel One-Sample Kolmogorov Smirnov. 
 

Kita perhatikan nilai Asymp. Sig. (2-tailed) 

yang merupakan p-value untuk uji KS ini. P-Value 

atau Asymp. Sig. (2-tailed) yang dihasilkan 

sebesar 0.391 yang lebih besar dari 0.05. Hal 

ini menunjukkan bahwa residual dari regresi telah 

memenuhi asumsi normalitas. 

 

13. Lakukan Pengujian Asumsi Heteroskedastisitas 

Menurut John Neter (1989:120), untuk mendeteksi 

terjadinya heteroskedastisitas, dapat menggunakan plot 

residual dengan fitted values atau Unstandardized 

Residual VS Unstandardized Predicted Value (yang telah 
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kita lakukan pada uji asumsi Linearitas). Berdasarkan 

plot antara unstandardized residual dengan 

unstandardized predicted value (fitted value) (lihat 

Gambar 14.9) dapat diperhatikan bahwa sebaran titik-

titik pada plot tersebut membentuk pola acak. Hal ini 

mengindikasikan bahwa tidak terjadi 

heteroskedastisitas pada model regresi yang telah 

dibuat. Selain dengan melihat scatter plot, asumsi 

heteroskedastisitas dapat dilihat dengan melakukan uji 

Park dan uji Rank Spearmen. Di sini kita akan 

menggunakan uji Park. Berikut langkahnya: 

- Transformasi logaritma natural terhadap variabel 

independen. Sedangkan untuk variabel dependen 

adalah logaritma natural dari kuadrat residual. 

Caranya, klik menu Transform  Compute 

Variable. Pada kolom Target Variable, tuliskan 

ln_X. Pada kotak Function group, klik All. Pada 

kolom Functions and Special Variables klik 

ganda (double-click) Ln untuk menggunakan 

fungsi Logaritma Natural. Kemudian klik ganda 

(double-click) variabel Profesionalisme Guru [X] 

sehingga pada kotak di Numeric Expression 

menjadi Ln(X). Klik tombol OK. 
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Gambar 14.12 Transformasi variabel X ke logaritma natural. 

 

Untuk variabel dependen, kita masih 

menggunakan cara yang sama hanya saja pada 

ekspresinya kita gunakan kuadrat. Akan tetapi, 

karena tidak ada operator kuadrat, kita 

menggunakan ekspresi RES_1*RES_1 sesuai 

dengan definisi dari kuadrat. Di mana RES_1 

adalah variabel residual yang kita perolah dari 

langkah uji normalitas. Beri nama Target 

Variabel ini dengan nama ln_ekuadrat. 

Perhatikan gambar berikut. 
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Gambar 14.13 Transformasi variabel Y ke logaritma natural. 
 

- Klik menu Analyze → Regression → Linear 

- Pada kotak dialog yang ditampilkan, klik variabel 

ln_ekuadrat lalu klik tombol ke kanan sehingga 

variabel ini berpindah ke kolom Dependent. Klik 

variabel ln_X, lalu klik tombol ke kanan sehingga 

kedua variabel ini berpindah ke kolom 

Independent(s). Perhatikan gambar berikut. 
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Gambar 14.14 Pengaturan variabel untuk regresi. 
 

Klok tombol OK. Ditampilkan output sebagai berikut. 

 

 
Gambar 14.15 Output tabel coefficient. 
 

Berdasarkan output di atas, dapat kita ketahui bahwa 

tidak ada variabel yang signifikan (semua nilai Sig. 
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lebih besar dari 0.05, H0 diterima, tidak signifikan) 

sehingga dapat dikatakan bahwa tidak terdapat 

masalah heteroskedastisitas. 

 

Perlu Anda cermati bahwa uji analisis regresi linear 

sederhana digunakan untuk satu variabel bebas (X). 

sementara jika Anda menggunakan lebih dari satu 

variabel bebas (X) maka uji yang ideal untuk Anda 

lakukan adalah Uji Analisis Regresi Linear Berganda 

 

LLATIHAN -- 1 

Berikut tersaji data tentang variabel X dan variabel Y. 

Var. X : 12 9 15 8 13 12 13 12 9 9 8 10 

Var. Y : 5 7 3 7 5 5 4 5 6 7 6 4 

Berdasarkan data tersebut: 

(a) Rumuskan hipotesisnya; 

(b) Buktikan ada tidaknya hubungan; 

(c) Tentukan arah hubungan; 

(d) Tentukan kekuatan hubungan; dan  

(e) Tentukan kontribusi X terhadap Y 
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115 

ANALISIS REGRESI LINEAR 
BERGANDA 

 
 
15.1 Pengertian 

Regresi linear ganda adalah persamaan regresi yang 

menggambarkan hubungan antara lebih dari satu variabel 

bebas (X) dan satu variabel tak bebas (Y). Hubungan variabel-

variabel tersebut dapat dituliskan dalam bentuk persamaan: 

 

Y = a + b1 X1 + b2 X2 

 

Y : variabel dependen 

a : konstanta 

X1 : variabel bebas ke-1 

b1 : kemiringan garis ke-1 

X2 : variabel bebas ke-2 

b2 : kemiringan garis ke-2 
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115.2 Uji Regresi Linear Berganda dengan SPSS 

Berikut disajikan data fasilitas belajar dan motivasi 

belajar terhadap prestasi belajar siswa. 

 

Fasilitas Belajar  Motivasi Belajar  Prestasi Belajar  

10 8 89 
8 6 85 
6 6 78 
6 4 74 
4 6 69 
4 10 70 
8 10 85 
6 8 71 

10 12 92 
2 6 56 
4 4 67 
4 4 66 
6 9 78 

10 9 90 
 

Hitunglah berapa besarnya kontribusi bersama seluruh 

variabel bebas terhadap variabel terikatnya, ujilah apakah 

ada kontribusi tersebut signifikan, bagaimana persamaan 

garis regresinya, dan tafsirkan maknanya, serta ujilah 

pengaruh secara masing-masing variabel bebas secara 

parsial! (Gunakan taraf signifikansi 5%). 

Berikut adalah langkah-langkah melakukan analisis 

regresi ganda menggunakan SPSS. 
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1. Buat data baru, klik tab Variable View 

2. Definisikan variabel pertama dengan Name: X1; Label: 

Fasilitas Belajar; Measure: Nominal. Variabel kedua 

dengan Name: X2; Label: Motivasi Belajar; Measure: 

Nominal. Variabel ketiga dengan Name: Y; Label: 

Prestasi Belajar; Measure: Scale. 

 

 
Gambar 15.1 Pendefinisian variabel. 
 

3. Klik tab Data View, masukkan data penelitian dengan 

ketentuan X1 untuk data Fasilitas Belajar, X2 untuk 

data Motivasi Belajar, dan Y untuk Prestasi Belajar. 
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Gambar 15.2 Memasukkan data. 
 

4. Klik menu Analyze → Regression → Linear 

5. Pada kotak dialog Linear Regression, pilih variabel 

Prestasi Belajar [Y] lalu klik tombol panah ke kanan 

sehingga variabel ini berpindah ke kotak Dependent. 

Klik variabel Fasilitas Belajar [X1] lalu klik tombol 

panah ke kanan sehingga variabel ini berpindah ke 

kotak Independent(s). Lakukan hal yang sama untuk 

variabel Motivasi Belajar [X2]. Selanjutnya pada 

bagian Method: pilih Enter. 
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Gambar 15.3 Mengatur variabel dan opsi. 
 

6. Klik tombol OK sehingga ditampilkan output SPSS  

7. Melakukan Uji Simultan 

Uji simultan dilakukan untuk memastikan setidaknya 

ada satu variabel bebas/prediktor yang berpengaruh 

signifikan terhadap variabel Y. 

 

 
Gambar 15.4 Tabel ANOVA. 
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Diketahui p-value uji simultan 0.000, lebih kecil dari 

taraf signifikansi (Sig < α). Berdasarkan hasil uji 

simultan dapat dinyatakan bahwa terdapat cukup bukti 

untuk menyatakan bahwa minimal ada satu i yang 

tidak sama dengan nol atau dengan kata lain, minimal 

ada satu variabel bebas yang berpengaruh signifikan 

terhadap variabel Y. 

 

8. Membuat persamaan regresi linear sederhana. 

Secara umum rumus persamaan regresi linear 

sederhana adalah Y = a + b1X1 + b2X2. Sementara 

untuk mengetahui nilai koefisien regresi tersebut kita 

dapat berpedoman pada output yang berada pada 

tabel coefficients berikut. 

 

 
Gambar 15.5 Tabel Coefficients. 
 

Koefisien regresi: 

a = Angka konstan dari unstandardized 

coefficients. Dalam contoh ini nilainya sebesar 
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49.908. Angka ini merupakan angka konstan 

yang mempunyai arti bahwa jika tidak ada 

Fasilitas belajar (X1) dan Motivasi Belajar 

(X2) maka nilai Prestasi Siswa (Y) adalah 

sebesar 49.908. 

b = Angka koefisien regresi. Untuk kasus di atas, 

terdapat dua koefisien regresi, yaitu: 3.871 untuk 

koefisien variabel Fasilitas Belajar (X1) dan 0.301 

untuk koefisien variabel Motivasi Belajar (X2). 

 

Dengan demikian, persamaan regresi linear yang 

berhasil disusun adalah 

Y = 49.908 + 3.871X1 + 0.301X2 

Pada persamaan tersebut semua koefisien bertanda 

positif yang berarti bahwa setiap variabel independen 

(X) memberikan kontribusi positif terhadap variabel 

dependen (Y). 

 

9. Uji hipotesis dalam analisis regresi linear sederhana 

Uji hipotesis atau uji pengaruh berfungsi untuk 

mengetahui apakah koefisien regresi tersebut signifikan 

atau tidak. Hipotesis yang diajukan dalam analisis 

regresi linear sederhana ini adalah: 
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H0 : Tidak ada pengaruh Fasilitas Belajar (X1) 

terhadap Prestasi Siswa (Y) 

Ha : Ada pengaruh Fasilitas Belajar (X1) terhadap 

Prestasi Siswa (Y) 

 

H0 : Tidak ada pengaruh Motivasi Belajar (X2) 

terhadap Prestasi Siswa (Y) 

Ha : Ada pengaruh Motivasi Belajar (X2) terhadap 

Prestasi Siswa (Y) 

 

Sementara itu, untuk memastikan apakah koefisien 

regresi tersebut signifikan atau tidak (dalam arti variabel 

X berpengaruh terhadap variabel Y) kita dapat 

melakukan uji hipotesis ini dengan cara 

membandingkan nilai signifikansi (Sig.) dengan 

probabilitas 0.05. 

Adapun yang menjadi dasar pengambilan keputusan 

dalam analisis regresi dengan melihat nilai signifikansi 

Sig. hasil output SPSS adalah: 

a. Jika nilai Sig. < 0.05, maka H0 ditolak 

b. Jika nilai Sig. > 0.05, maka H0 diterima 

Uji signifikansi koefisien regresi variabel X1 

Pada kolom Sig. terlihat bahwa nilai Sig. = 0.000. 

karena nilai Sig. < 0.05 maka H0 ditolak, berarti 
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bahwa ada pengaruh yang positif dan signifikan 

Fasilitas Belajar (X1) terhadap Prestasi Siswa (Y). 

Uji signifikansi koefisien regresi variabel X2 

Pada kolom Sig. terlihat bahwa nilai Sig. = 0.370. 

karena nilai Sig. > 0.05 maka H0 diterima, berarti 

bahwa tidak ada pengaruh Motivasi Belajar (X2) 

terhadap Prestasi Siswa (Y). Dengan demikian, koefisien 

regresi variabel X2 tidak signifikan sehingga dapat 

diabaikan dari persamaan regresi. 

 

Oleh karena itu, persamaan regresi menjadi:  

Y = 49.908 + 3.871X1 

 

10. Melihat besarnya pengaruh variabel X terhadap Y 

Untuk mengetahui besarnya pengaruh Profesionalisme 

Guru (X) terhadap Prestasi Siswa (Y) dalam analisis 

regresi linear sederhana, kita dapat berpedoman pada 

nilai R-Square atau R2 yang terdapat pada output SPSS 

bagian Model Summary. 

 

 
Gambar 15.6 Tabel Model Summary. 
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Dari output di atas diketahui nilai R-Square sebesar 

0.956. Nilai ini mengandung arti bahwa pengaruh 

Fasilitas Belajar (X1) terhadap Prestasi Siswa (Y) adalah 

sebesar 95.6% sedangkan 4.4% Prestasi Siswa 

dipengaruhi oleh variabel yang lain yang tidak diteliti. 

 

Merujuk pada pembahasan di atas, maka dapat kita 

simpulkan bahwa Fasilitas Belajar (X1) berpengaruh 

positif dan signifikan terhadap prestasi siswa (Y) dengan 

total pengaruh sebesar 95.6%. 

 

11. Lakukan Pengujian Linearitas 

Untuk menguji apakah asumsi Linearitas terpenuhi, kita 

menggunakan plot residual vs fitted value di SPSS: 

- Klik menu Analyze → Regression → Linear 

- Masukkan variabel dependen dan variabel-

variabel bebas seperti pada langkah sebelumnya 

- Klik tombol Save. Beri tanda centang pada 

Unstandardized di kotak Predicted Values dan 

Unstandardized di kotak Residuals. 
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Gambar 15.7 Opsi Save. 
 

Klik tombol Continue. 
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- Klik tombol OK. Pada layar sekarang terdapat dua 

tambahan kolom, yaitu PRE_1 dan RES_1 yang 

menyimpan nilai estimasi dan residual terhadap 

nilai sesungguhnya. 

 

 
Gambar 15.8 Tambahan variabel PRE_1 dan RES_1. 
 

- Selanjutnya, klik menu Graphs → Legacy Dialogs 

→ Scatter/Dot. 

- Pada kotak dialog, klik pilihan Simple Scatter. 

- Klik tombol define. 

Klik variabel Unstandardized Residual lalu klik 

tombol ke kanan yang sejajar dengan baris Y 
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Axis. Dan klik variabel Unstandardized 

Predicted Value lalu klik tombol ke kanan yang 

sejajar dengan baris X. 

 

 
Gambar 15.9 Membuat plotting predicted dan residual. 
 

Klik tombol OK sehingga ditampilkan grafik 

sebagai berikut. 
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Gambar 15.10 Grafik Scatter Plot. 
 

Berdasarkan plot residual dengan fitted value 

tersebut, terlihat bahwa tebaran nilai-nilai pada 

plot membentuk suatu pola acak, sehingga 

asumsi linearitas terpenuhi. 

 

12. Lakukan Pengujian Asumsi Normalitas 

Untuk menguji asumsi normalitas, di sini kita 

menggunakan Kolmogorov-Smirnov untuk menguji 

normalitas residual regresi. Pastikan Anda telah 

memiliki variabel Unstandardized Residuals, yang 
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didapatkan dari hasil uji linearitas di atas. Lakukan uji 

Kolmogorov-Smirnov sebagai berikut: 

- Klik menu Analyze → Nonparametric Test → 

Legacy Dialogs → 1-Sample K-S 

- Pada kotak dialog yang ditampilkan, klik variabel 

Unstandardized Residuals lalu klik tombol ke 

kanan sehingga variabel ini berpindah ke kotak 

Test Variable List. 

 

 
Gambar 15.11 Menguji normalitas residual. 
 

Klik tombol OK. 
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Gambar 15.12 Tabel One-Sample Kolmogorov Smirnov. 
 

Kita perhatikan nilai Asymp. Sig. (2-tailed) 

yang merupakan p-value untuk uji KS ini. P-Value 

atau Asymp. Sig. (2-tailed) yang dihasilkan 

sebesar 0.988 yang lebih besar dari 0.05. Hal 

ini menunjukkan bahwa residual dari regresi telah 

memenuhi asumsi normalitas. 

 

13. Lakukan Pengujian Asumsi Heteroskedastisitas 

Berdasarkan plot antara unstandardized residual 

dengan unstandardized predicted value (fitted value) 

(lihat Gambar 15.10) dapat diperhatikan bahwa 

sebaran titik-titik pada plot tersebut membentuk pola 

acak. Hal ini mengindikasikan bahwa tidak terjadi 

heteroskedastisitas pada model regresi yang telah 
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dibuat. Selain dengan melihat scatter plot, asumsi 

heteroskedastisitas dapat dilihat dengan melakukan uji 

Park dan uji Rank Spearmen. Di sini kita akan 

menggunakan uji Park. Berikut langkahnya: 

- Transformasi logaritma natural terhadap variabel 

independen. Sedangkan untuk variabel dependen 

adalah logaritma natural dari kuadrat residual. 

Caranya, klik menu Transform  Compute 

Variable. Pada kolom Target Variable, tuliskan 

ln_X1. Pada kotak Function group, klik All. Pada 

kolom Functions and Special Variables klik 

ganda (double-click) Ln untuk menggunakan 

fungsi Logaritma Natural. Kemudian klik ganda 

(double-click) variabel Fasilitas Belajar [X1] 

sehingga pada kotak di Numeric Expression 

menjadi Ln(X1). Klik tombol OK. Lakukan hal yang 

sama untuk variabel X2. 
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Gambar 15.13 Transformasi variabel X1 ke logaritma natural.

 

Untuk variabel dependen, kita masih 

menggunakan cara yang sama hanya saja pada 

ekspresinya kita gunakan kuadrat. Akan tetapi, 

karena tidak ada operator kuadrat, kita 

menggunakan ekspresi RES_1*RES_1 sesuai 

dengan definisi dari kuadrat. Di mana RES_1 

adalah variabel residual yang kita perolah dari 

langkah uji normalitas. Beri nama Target 

Variabel ini dengan nama ln_ekuadrat. 

Perhatikan gambar berikut. 
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Gambar 15.14 Transformasi variabel Y ke logaritma natural. 
 

- Klik menu Analyze → Regression → Linear 

- Pada kotak dialog yang ditampilkan, klik variabel 

ln_ekuadrat lalu klik tombol ke kanan sehingga 

variabel ini berpindah ke kolom Dependent. Klik 

variabel ln_X1, tekan dan tahan tombol SHIFT, 

klik variabel ln_X2 lalu klik tombol ke kanan 

sehingga kedua variabel ini berpindah ke kolom 

Independent(s). Perhatikan gambar berikut. 
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Gambar 15.15 Pengaturan variabel untuk regresi. 
 

Ditampilkan output sebagai berikut. 

 

 
Gambar 15.16 Output tabel coefficient. 
 

Berdasarkan output di atas, dapat kita ketahui bahwa 

tidak ada variabel yang signifikan (semua nilai Sig. 

lebih besar dari 0.05, H0 diterima, tidak signifikan) 

sehingga dapat dikatakan bahwa tidak terdapat 

masalah heteroskedastisitas.  
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14. Lakukan Pengujian Asumsi Autokolerasi 

Untuk menguji asumsi Autokolerasi, dapat dilakukan 

dengan melihat statistik Durbin-Watson. 

- Klik menu Analyze → Regression → Linear. 

- Pada kotak dialog yang ditampilkan, klik variabel 

Prestasi Siswa (Y) lalu klik tombol ke kanan 

sehingga variabel ini berpindah ke kolom 

Dependent. Klik variabel Fasilitas Belajar (X1), 

tekan dan tahan tombol SHIFT, klik variabel 

Motivasi Belajar (X2) lalu klik tombol ke kanan 

sehingga berpindah ke kolom Independent(s). 

 

 
Gambar 15.17 Mengulangi uji regresi. 
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- Klik tombol Statistics.  

- Pada kotak dialog yang ditampilkan, beri tanda 

centang pada Durbin Watson di kolom Residuals. 

 

 
Gambar 15.18 Statistics Durbin Watson. 

  

Klik tombol Continue 

- Klik tombol OK sehingga ditampilkan output SPSS 

 

 
Gambar 15.19 Statistics Durbin Watson. 
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Berdasarkan output tersebut, diketahui nilai Durbin -

Watson yaitu DW = 2.021. 

Dari Tabel Durbin – Watson Test Bounds (John Neter, 

1989:642), untuk k = 2 dan n=14 (k adalah 

banyaknya variabel independen), maka diperoleh nilai 

(unduh tabel Durbin Watson di 

https://www.statmat.net/tabel_dw/): 

 

dL = 0.9054, dU =1.5507, 4−dU = 2.4493, 4−dL = 

3.0946 

 

Regresi secara klasik mensyaratkan bahwa variable 

tidak boleh tergejala autokorelasi. Kriteria dalam 

pengujian Durbin Watson yaitu (Sujarweni, 2016: 232): 

- Jika 00 < DW < dL, berarti ada autokorelasi positif 

- Jika 44 – dL < DW < 4, berarti ada aautokorelasi 

negatif 

- Jika 22 < DW < 4 – dU atau ddU < DW < 2, berarti 

tidak ada autokorelasi positif atau negatif 

- Jika ddL ≤ DW ≤ dU atau 44 – dU ≤ DW ≤ 4 – dL, 

pengujian tidak meyakinkan. Untuk itu dapat 

digunakan uji lain atau menambah data 

- Jika nilai ddU < DW < 4-dU maka tidak terjadi 

autokorelasi.  
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Gambar 15.20 Garis bilangan Durbin Watson. 
 

Perhatikan urutan garis bilangan di atas. Terlihat nilai 

DW berada di antara 2 dan 4 – dU (2 < DW < 4 – dU). 

Sesuai ketentuan, tidak terdapat autokorelasi antara 

variabel-variabel dalam regresi . 

 

15. Lakukan Pengujian Asumsi Multikolinearitas 

Uji multikolienaritas diperlukan untuk mengetahui ada 

tidaknya variabel independen yang memiliki kemiripan 

antar variabel independen dalam suatu model 

(Sujarweni, 2016: 230). Untuk mendeteksi ada atau 

tidaknya gejala multikolienaritas sebagai berikut: 

a) Nilai tolerance > 0.10 dan nilai variance 

inflanction factor (VIF) < 10 menunjukkan 

tidak adanya multikolinearitas antar variable 

independen 

b) Nilai tolerance < 0.10 dan nilai variance 

inflanction factor (VIF) > 10 menunjukkan 

adanya multikolinearitas antar variable 

independen (Widodo, 2017: 78). 

 

0 

dL 

0.9054 

dU 

1.5507 

4 – dU 

2.4493 

DW 

2.021 

4 - dL 

3.0946 
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Untuk menguji asumsi multikolinearitas, pertama kali 

kita ubah dulu Measure setiap variabel menjadi Scale. 

 

 
Gambar 15.21 Measure setiap variabel diubah menjadi

Scale. 
 

Setelah itu kita lakukan analisis regresi: 

- Klik Analyze → Regression → Linear 

- Pada kotak dialog yang ditampilkan, pilih variabel 

Prestasi Belajar [Y] lalu klik tombol ke kanan 

sehingga variabel ini berpindah ke kolom 

Dependent. Pilih Fasilitas Belajar [X1] dan 

Motivasi Belajar [X2] (klik, tahan tombol SHIFT, 

lalu klik lagi) lalu klik tanda panah ke kanan 

sehingga kedua variabel ini berpindah ke kotak 

Independent(s). 
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Gambar 15.22 Analisis regresi untuk uji multikolinearitas. 
 

- Klik tombol Statistics. Pada kotak dialog yang 

ditampilkan, beri tanda centang pada Covariance 

matrix dan Collinearity diagnostics 
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Gambar 15.23 Menampilkan kolinearitas. 

 

Klik tombol Continue. 

- Klik tombol OK sehingga ditampilkan output SPSS. 

 

 
Gambar 15.23 Tabel coefficient. 
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Berdasarkan tabel di atas dapat kita lihat bahwa nilai 

Tolerance untuk variabel Fasilitas Belajar (X1) dan 

Motivasi Belajar (X2) adalah 0.695. nilai ini lebih 

dari 0.10. Sementara nilai VIF untuk variabel Fasilitas 

Belajar (X1) dan Motivasi Belajar (X2) adalah 

1.439. Dari sini, nilai VIF < 10.00. Maka, berdasarkan 

dasar pengambilan keputusan dalam uji 

multikolinearitas dapat disimpulkan bahwa tidak terjadi 

gejala mulitkolinearitas dalam model regresi. 

 

Berdasarkan hasil pengujian di atas, maka dapat 

disimpulkan bahwa model regresi 

Y = 49.908 + 3.871X1 + 0.301X2 

dapat digunakan sebagai penduga variabel dependen 

dan menggambarkan adanya pengaruh yang positif 

signifikan antara Fasilitas Belajar (X1) terhadap Prestasi 

Siswa (Y). 

 

LLATIHAN -- 1 

Berikut ini data mengenai peringkat kimia, nilai ujian dan 

frekuensi membolos dari kuliah kimia oleh mahasiswa IKIP 

Madiun. 
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Mahasiswa 
Peringkat 

Kimia 

Nilai 

Ujian 

Frekuensi 

Membolos 

1 85 65 1 
2 74 50 7 
3 76 55 5 
4 90 70 2 
5 85 65 6 
6 87 70 3 
7 94 55 2 
8 98 70 5 
9 81 55 4 
10 91 70 3 
11 76 50 1 
12 74 55 4 

 

Tentukan persamaan garis regresinya dengan perhitungan 

matematis dan aplikasi SPSS! 

 

  



15 – Analisis Regresi Linear Berganda 

294 

 

 



295 

 

DDaftar 

PUSTAKA 
 

 

Azwar, Saifudin. 1986. Validitas dan Reliabilitas. Jakarta: 
Rineka Cipta 

Buthmann, A. (n.d.). Dealing with Non-Normal Data: 
Strategies and Tools. Isixsigma. Retrieved January 1, 
2023, from https://www.isixsigma.com/tools-
templates/normality/dealing-non-normal-data-
strategies-and-tools/ 

Daniel, W. (1991). Statistik Nonparametrik Terapan: 
Gramedia. Jakarta. 

Fauziah, F., & Karhab, R. S. (2019). Pelatihan Pengolahan 
Data Menggunakan Aplikasi SPSS Pada Mahasiswa. 
Jurnal Pesut: Pengabdian Untuk Kesejahteraan Umat, 
1(2), 129–136. 

Ghozali, Imam, 2009, Aplikasi Analisis Multivariate Dengan 
Program SPSS, Semarang: Badan Penerbit Universitas 
Diponegoro. 

Hasyim, M., & Listiawan, T. (2014). Penerapan Aplikasi IBM 
SPSS Untuk Analisis Data Bagi Pengajar Pondok 
Hidayatul Mubtadi’in Ngunut Tulungagung Demi 
Meningkatkan Kualitas Pembelajaran dan Kreativitas 
Karya Ilmiah Guru. J-ADIMAS (Jurnal Pengabdian 
Kepada Masyarakat), 2(1), 28–35. 

Havis, A. (2006). Statistik. Candra Pratama. 
Junaidi. (2010). Statistika Non-Parametrik. Fakultas Ekonomi 

Universitas Jambi. Jambi 



Daftar Pustaka 

296 

Kasiram, M. (2006). Metodologi Penelitian: Refleksi 
Pengembangan Pemahaman dan Penguasaan 
Metodologi Penelitian. UIN Maliki Press. 

Neter, J., Wasserman, W., & Kutner, M. H. (1989). Applied 
linear regression models. 

Nurhayati, N., & Novianti, N. (2020). Pengaruh SPSS 
terhadap Hasil Belajar pada Materi Statistika Deskriptif. 
AKSIOMA: Jurnal Program Studi Pendidikan Matematika, 
9(1), 101–107. 
https://doi.org/10.24127/ajpm.v9i1.2609 

Panjaitan, D. J., & Firmansyah, F. (2018). Pelatihan 
Pengolahan Data Statistik dengan Menggunakan SPSS. 
Prosiding Seminar Nasional Hasil Pengabdian 2018, 1, 
38–45. 

Siegel, Sidney. 1997. Statistika Nonparametrik untuk Ilmu-
ilmu Sosial. Jakarta: PT Gramedia Pustaka Utama 

Siegel, S., and N. J. Castellan. (1988). Nonparametric 
statistics for the behavioral sciences. New York: McGraw-
Hill, Inc. 

Sprent P. (1991). Metode Statistik Nonparametrik Terapan. 
Jakarta. UI-Press. 

Sufren, dan Natanael, Yonathan. 2013. Mahir Menggunakan 
SPSS Secara Otodidak. Jakarta: Kompas Gramedia. 

Sugiharto dan Sitinjak. (2006). LISREL. Yogyakarta: Graha 
Ilmu. 

Sugiyono. (2017). Statistika untuk Penelitian. CV Alfabeta. 
Sujarweni, W. (2016). SPSS Untuk Penelitian. Yogyakarta: 

Pustaka Baru Press. 
Walizer, Michael. 1987. Metode dan Analisis Penelitian. 

Jakarta: Erlangga. 
Widodo. 2017. Metodologi Penelitian Populer & Praktis. 

Jakarta: Rajawali Pers. 
Zein, S., Ghozi, R., Harahap, E., Badruzzaman, F., & 

Darmawan, D. (2019). Pengolahan dan Analisis Data 
Kuantitatif Menggunakan Aplikasi SPSS. JTEP-Jurnal 



Praktik Statistika Pendidikan menggunakan Microsoft Excel dan SPSS

297 

Teknologi Pendidikan Dan Pembelajaran, 4(1), 839–845. 
Zulganef. 2006. Pemodelan Persamaan Struktural & 

Aplikasinya Menggunakan Amos 5. Bandung: Pustaka. 
  



Daftar Pustaka 

298 

  



299 

 

UUnduh 

File Pendukung Praktik 
 

 

 

(Gunakan QR-Code Reader dari gawai Anda atau buka 
Google dengan Google Chrome, lalu pindai di kotak 

pencarian) 




